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3. Weather Information and Navigational Graphics System (WINGS)

3.1  XE "Flight Service Function" Flight Service Function

The Flight Service function provides flight planning and weather briefing capabilities.  The user can create, file, activate, amend, open, close, and cancel Domestic and ICAO flight plans.  Weather briefings can be retrieved for any area or route of flight.  The user can retrieve historical data about all flight plans that have been processed at the facility.  The site supervisor can control the availability of all functions in the WINGS application window by configuring each user’s functional assignment. XE "Functional Assignment" 
The WINGS login dialog box appears automatically upon Windows login.  If the application is subsequently closed, <Double–Click> on the WINGS icon, located on the desktop to restart the application.
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Figure 3‑1 WINGS Icon

3.1.1 WINGS Window

The WINGS window contains a menu bar, a toolbar, XE "Toolbar" \r "D2HBToolbar1"  the main work area, an alarm bar, and a status bar. The menu bar includes the following pull-down menus: File, Flight Plan, XE "Flight Plan:Menu"  Prestored Flight, XE "Prestored Flight"  Briefing, XE "Briefing" \r "D2HBBriefing1"  Transmit Data, XE "Transmit Data"  List, Reports, XE "Reports"  Status, View, Window and Help.  The toolbar contains buttons that allow the user quick access to certain WINGS functions. The main work area displays minimized or maximized windows and dialog boxes in which the specialist can enter or view information.  The alarm bar contains alarm indicators and buttons which allow quick access to the available lists.  The status bar contains information about the current user and login session, confirmation messages, and the date and time.

3.1.1.1 Toolbar

The Toolbar buttons provide quick access to many of the pull-down menu options on the Menu Bar.
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Figure 3‑2  Wings Menu Bar and Toolbar

To Perform an Action From the Toolbar:

1. <Click> the Toolbar button for the action you want to perform.

NOTE:
This does not apply when the toolbar button is disabled
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3.1.1.2 Alarm Bar

The alarm bar is located at the bottom of the WINGS window, immediately above the status bar.  The alarm bar consists of alarm indicators for each list that is designated to receive alarm indications.  Please refer to the individual list sections in order to see the alarm conditions for a particular list. The indicators function like buttons which provide a method of opening a list which has an alarming entry.  Each list that is designated to receive alarm indications will be represented by a button on the alarm bar.  The alarm bar will appear on the bottom of the WINGS window above the status bar.   In its initial default state, the alarm indicator buttons will be in a disabled state to indicate that there is no current capability for alarms.
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Figure 3‑3  Alarm Bar- Before Login (Disabled State)

Upon login and verification of the proper capability, the alarm indicators will change from a disabled state to a passive state indicating that the specialist has the capability to receive alarms.  Upon receiving an alarm indication for any of the alarming lists, the icon associated with the particular list will change to red and remain colored until the appropriate list alarm has been acknowledged.  If the specialist logs in with a functional position XE "Functional Position"  that doesn’t have the capability to receive alarms for a particular list, then the alarm indicator on the alarm bar for that list will stay in a disabled state.  However, the list may be accessed by the menu.  For example, in the picture below, the Weather Data list alarm indicator is currently in the disabled state to indicate to the specialist that no alarms will be displayed for that list.
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Figure 3‑4  Alarm Bar- After Login (Enabled by Capabilities)

The Inbound, Suspense, Facility Message, Weather Data, Auto Update, WMSCR, Law Enforcement, Alerts, SAR, Internal Message, and Interface Status lists all have alarm indicators on the alarm bar.  Each alarm indicator also acts as a button which will bring up the list for viewing.  When the alarm indicator appears in red, like the Suspense, Facility Message, Law Enforcement, and Alerts list indicators below, that means that an alarm condition has occurred for that list and that there is an alarming list entry on that list.

The alarm indicator will remain in red until one of the following conditions is met:

· The list entries on the lists that are alarming are acknowledged by the specialist

· The condition causing the alarm is no longer met

· The entry causing the alarm condition is deleted

· The specialist closes the list
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Figure 3‑5  Alarm Bar- Alarm Indicators On

To Open a List From the Alarm Bar:

1. <Click> the Alarm Indicator button of the list you want to open.

NOTE:
This does not apply when the alarm indicator is disabled.
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Figure 3‑6  Alarm Indicator Button
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Figure 3‑7  Suspense List XE "Suspense List"  Displayed via the Alarm Indicator Button 

To Acknowledge an Alarming Entry on a List:

1. <Click> the Alarm Indicator button of the list you want to open if the list is not already open.

2. <Click> the blue highlighted List Entry.

3.1.1.3  XE "Status Bar" Status Bar

The status bar is located at the bottom of the main WINGS window.  It contains a number of panes that provide information about the current user session.
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Figure 3‑8  Status Bar

Table 3‑1  Status Bar Description

	Label
	Component
	Purpose

	Confirmation Message 
	Pane
	Displays confirmation messages, which notify the user that an action was successful.  Confirmation messages are automatically removed after five seconds, or when the next confirmation message or message dialog box is displayed.

	Confirmation History (…) 
	Button
	Displays a list of the last ten confirmation messages shown in the Confirmation Message pane.

	Workstation ID 
	Pane
	Displays the identifier of the workstation.

	Responsible FSS 
	Pane
	Displays the Responsible FSS selected at login.

	Functional Position: User Name 
	Pane
	Displays the functional position and user ID selected at login. If the user is currently running in Training mode, this information will be followed by "(Training)".

	Date & Time 
	Pane
	Displays the current date and time.  If in Training mode, date and time of capture are displayed.


To Display the Confirmation Message History:

1. <Click> the … button on the status bar. 

2. To close the history, <Click> anywhere or press the Esc key.

After performing most actions in the WINGS application, a window containing the results of the action appears.  This confirms that the action was executed successfully.  A message is displayed in the Confirmation Message area of the status bar only when an action does not provide this form of feedback.

When an action is attempted that cannot be completed, a message dialog box will be displayed to alert the user.  After reading the contents of the message dialog box, <Click> the OK button to proceed.

[image: image45.png]/AN ThePit ot st sttt U U





Figure 3‑9  Message Dialog Box
3.2 File

The File menu provides options for printing and logging into and out of the OASIS system.  The File menu includes the following options: Print, Print Preview, Print Setup, Login, XE "Login"  Logoff, XE "Logoff"  Change Password XE "Password"  and Exit.
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Figure 3‑10  File Menu

To Display the File Menu:

1. <Click> the File menu.

3.2.1 Print (File Menu)

The Print menu option allows the user to print the contents of the current window.  This option is not available if the currently displayed window cannot be printed. The Print menu option opens the Print dialog box, which provides options to select a printer and the number of copies to print.

3.2.1.1 Printer

The Printer group of options available from the Print dialog box allows a user to select a printer from a drop-down list of installed printers and view the status, type and network location of the printer.  The comment field provides additional information about the printer.  A Properties button is also available to specify additional printer information.  This information is dependent on the type of printer selected.

3.2.1.2 Print Range

There are no modifiable options in the Print Range group.  When the contents of a window are printed, all pages are always printed.

3.2.1.3 Copies

The Copies group of options allows the user to select the number of copies to be printed.  The Collate check box specifies if the collate function is enabled.  The Collate check box may be grayed-out if the function is not supported for a specific printer.
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Figure 3‑11  Print Dialog Box

Table 3‑2  Print Dialog Box Description 

	Label
	Component
	Purpose

	Printer
	Group Label
	Allows user to select a printer.

	Name
	Drop-down List Box
	Displays a list of installed printers.

	Status
	Text Label
	Displays the status of the printer.

	Type
	Text Label
	Displays the type of printer.

	Where
	Text Label
	Displays the location of the printer.

	Comment
	Text Label
	Displays any additional comments.

	Properties
	Button
	Displays the properties dialog box for the selected printer.

	Print range
	Group Label
	Allows the user to specify range of pages to print.

	All
	Radio Button
	Selects all pages to be printed.

	Pages
	Radio Button
	Selects a specified range of pages to be printed.

	from
	Text Box
	Specifies a page number to start printing from.

	to
	Text Box
	Specifies a page number to stop printing.

	Selection
	Radio Button
	Selects only the information selected to be printed.

	Copies
	Group Label
	Allows the user to select number of copies to print and gives the option to collate multiple copies.

	Number of copies
	Increment Box
	Specifies the number of copies to be printed.

	Collate
	Check Box
	Selects the collate option.  Collate prints and sorts the specified number of copies in order.

	OK
	Button
	Applies any changes and sends to the printer.


To Print Currently Displayed Data:

1. <Click> the File menu or <Click> on the Print toolbar XE "Toolbar" \r "D2HBToolbar9"  button and skip to step number 3.

2. <Click> the Print menu option to display the Print dialog box.

3. <Select> the desired printer from the Name drop-down list box.

4. <Select> the desired number of copies from the Copies group.

5. <Click> the OK button to complete the function.

6. OR

7. <Click> the Cancel button to terminate this function without accepting any of the changes made to the dialog box.  The Print dialog box is closed.
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Figure 3‑12  Print Toolbar Button

NOTE:
Additional information associated with the type of printer selected can be set using the Properties button.

3.2.2 Print Preview (File Menu)

The Print Preview menu option displays the contents of the window on screen, as they will be printed on paper.  This function provides options to manipulate the display and provides access to the Print dialog box.
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Figure 3‑13  Print Preview Dialog Box

Table 3‑3  Print Preview Dialog Box Description 

	Label
	Component
	Purpose

	Print…
	Button
	Opens the Print dialog box.

	Next Page 
	Button
	Displays the next page.

	Prev Page
	Button
	Displays the previous page.

	Two Page/One Page
	Button
	Toggles between displaying two consecutive pages side by side, or one page at a time.

	Zoom In
	Button
	Magnifies the display one and two times normal display size.

	Zoom Out
	Button
	Reduces the display size from the Zoom In function, one and two times back to normal size.

	Close
	Button
	Closes the Print Preview window and returns to the active window.


To Preview a Displayed Window:

1. <Click> the File menu or <Click> on the Print Preview toolbar button and skip to step 3.
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Figure 3‑14  Print Preview Toolbar Button

2. <Select> the Print Preview menu option to display the product in a Print Preview window.

3. Use the Page and Zoom XE "Zoom"  options to view different parts of the printout.  

4. <Click> the Print button to exit Print Preview and display the Print dialog box.

OR

5. <Click> the Close button to exit Print Preview.

3.2.3 Print Setup (File Menu)

The Print Setup menu option provides options to select a printer, paper size, and page orientation.

3.2.3.1 Printer

The Printer group of options available from the Print setup dialog box allows a user to select a printer from a drop-down list of installed printers, and view the status, type and network location of the printer.  The comment field provides additional information about the printer, and Print to File sends information to a file instead of a printer.  A Properties button is also available to specify additional printer information. This information is dependent on the type of printer selected.

3.2.3.2 Paper

The Paper group of options available from the Print Setup dialog box allows a user to select paper size and source.

3.2.3.3 Orientation

The Orientation group of options available from the Print Setup dialog box allows a user to select either portrait or landscape mode.

[image: image51.png]Priter
Nae:
Status:
Tope:
Where:
Comment

Foper

Size:

Souce:

Ready
HP Laserlet 4100 PCLE
HPLasedleté1 005eries

Loter

[Auto Select

Network.

Orientation

Propetes.

© ot

€ Landscape

[

Cancel





Figure 3‑15  Print Setup Dialog Box

Table 3‑4  Print Setup Dialog Box Description 

	Label
	Component
	Purpose

	Printer
	Group Label
	Allows the user to select printer.

	Name
	Drop-down List Box
	Displays a list of installed printers.

	Status
	Text Label
	Displays the status of the printer.

	Type
	Text Label
	Displays the type of printer.

	Where
	Text Label
	Displays the location of the printer.

	Comment
	Text Label
	Displays any additional comments.

	Properties
	Button
	Displays the properties dialog box for the selected printer.

	Paper
	Group Label
	Allows the user to select the size and source of the paper used for printing.

	Size
	Drop-down List Box
	Displays a list of standard paper sizes.

	Source
	Drop-down List Box
	Displays a list of paper sources.

	Orientation
	Group Label
	Allows the user to select the direction the product will be printed on the paper.

	Portrait
	Radio Button
	Sets the paper orientation vertically.

	Landscape
	Radio Button
	Sets the paper orientation horizontally.

	Network
	Button
	Allows selection of other printers if any are available.

	OK
	Button
	Accepts and applies any changes and closes the dialog box.


To Setup a Printer:

1. <Click> the File menu.

2. <Select> the Print Setup menu option to display the Print Setup dialog box.

3. <Select> the desired printer from the Name drop-down list box.

4. <Select> the desired paper size from the Size drop-down list box.

5. <Select> the desired paper source from the Source drop-down list box.

6. <Select> the desired paper orientation from the Orientation radio buttons.

7. <Click> the OK button to complete the function

OR

8. <Click> the Cancel button to terminate this function without accepting any of the changes made to the dialog box.  The Print Setup dialog box is closed.

NOTE:
Additional information associated with the type of printer selected can be set using the Properties button.

3.2.4  XE "Login" \r "D2HBLogin12" Login (File Menu)

Removed for Security Purposes

3.2.4.1 Functional Assignment Selection (File Menu/Login)

Within the Functional Assignment XE "Functional Assignment" \r "D2HBFunctional_A13"  Selection dialog box, a user must select a functional position, XE "Functional Position" \r "D2HBFunctional_P13"  a responsible FSS, and a responsible FSS filter.  A user’s login determines whether the user has access to one or more functional positions including Specialist, Supervisor, Administrator, Maintenance, Training, Remote, Other, Preflight, Inflight, EFAS and any site-defined values.  The WINGS system capabilities (window and menu options) are activated and deactivated based on the functional assignment access granted to a user during login.  The user has access to only the system capabilities associated with that functional position for the duration of the login session.

Typically, the Supervisory user is responsible for determining the functional positions a user can access.  The flexibility exists in the WINGS software to allow supervisory personnel varying degrees of control over user access and functional assignments.  At any one time, a user may be granted access to one or more functional assignments.  After logging in, the Functional Assignment Selection dialog box is displayed to allow the user to choose one of the functional positions that have been assigned to that user.

The Functional Assignment Selection dialog box also allows the user to choose a Responsible FSS when logging in.  The Responsible FSS scroll list contains the available Responsible FSSs.  The local site is always listed first.  If the Functional Position that is highlighted has the capability to choose a different Responsible FSS, the Responsible FSS scroll list will also contain all the sites listed in the Facility Responsibility Table that are not in an Inactive state.  See the Facility Responsibility section of the System Operations Manual (SOM) for details on how to add, remove, and change the state of sites in this table.

Additionally, the user must set their Responsible FSS Filter when logging in.  This filter affects the data displayed on the Inbound, Proposed, Suspense, SAR, and Facility Message Lists.  This filter can be changed during the login session using the Facility Responsibility Table. 
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Figure 3‑18  Functional Assignment Selection Dialog Box

Table 3‑6  Functional Assignment Selection Dialog Box Description 

	Label
	Component
	Purpose

	Functional Position
	Scroll List
	Displays the list of Functional Positions available to a user.  

	Responsible FSS
	Scroll List
	Displays the list of Responsible FSSs available to the Functional Position that is highlighted.  The local site is always listed first.

	Responsible FSS Filter
	Group Label
	Select the option to be used as the Responsible FSS Filter for this login session.  The Responsible FSS Filter can be changed later by using the Facility Responsibility Table.  The Responsible FSS Filter affects the information displayed on the Inbound, Proposed, Suspense, SAR and Facility Message Lists.

	Display All Entries
	Radio Button
	Selecting this option will set the Responsible FSS Filter to ALL.  This is equivalent to selecting “Display All Entries” using the Facility Responsibility Table.

	<Local Site> only
	Radio Button
	Selecting this option will set the Responsible FSS Filter to the local site.   The name of the local site is displayed as part of the radio button’s label.

	Keep Previous Settings: <Previous User’s Settings>
	Radio Button
	Selecting this option will set the Responsible FSS Filter to the settings used by the previous user of the workstation.  The previous user's settings are displayed as part of the radio button’s label.

	OK
	Button
	Activates the selected position.


To Select a Functional Assignment:

Upon successful login, the Functional Assignment Selection dialog box is automatically displayed, permitting the user to select the functional assignment for the login session.

1.
<Select> a Functional Position from the Functional Position scroll list.

2.
<Select> a Responsible FSS from the Responsible FSS scroll list.

3.
<Select> a Responsible FSS Filter from the radio buttons

4.
<Click> the OK button.  The position’s capabilities and menus are configured accordingly.  The User ID, Functional Position and Responsible FSS are displayed within the Status Bar XE "Status Bar"  at the bottom of the window.  The Responsible FSS Filter is displayed at the top of the Inbound, Proposed, Suspense, SAR, and Facility Message Lists.

3.2.5  XE "Logoff" Logoff (File Menu)

Access to the WINGS application is controlled by the Login XE "Login"  and Logoff functions.  The Logoff option ends all activities for the current user.  When the Logoff option is selected, a message dialog box appears to confirm the logout.

NOTE:  The user should log off of WINGS, or exit WINGS, before logging off of the workstation.  If the user logs off of the workstation before logging off of WINGS, or exiting WINGS, a dialog box will be displayed notifying the user to logoff of WINGS.

To Logoff of the WINGS Application:

1. <Click> the File menu.

2. <Select> the Logoff menu option.  The Logoff dialog box is displayed, requesting confirmation to terminate the current user session.
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Figure 3‑19  Logoff Dialog Box

3. <Click> the OK button to confirm the action. 

OR

4. <Click> the Cancel button to terminate the Logoff function and remain an active WINGS user.

5. Upon successful Logoff, the operational capabilities are removed and the only available functions are Login and Exit.

3.2.6  XE "Password" \r "D2HBPassword16" Change Password (File Menu)

Removed for Security Purposes

3.2.7 Exit (File Menu)

The Exit menu option removes all WINGS capabilities and exits the application.

If the Logoff XE "Logoff"  option has not been run prior to selecting Exit, the Logoff process listed in the Logoff (File Menu) section is run first.  If Logoff has been previously run, the Exit menu option immediately exits the application.

To Exit the WINGS Application:

1. <Click> the File menu.

2. <Select> the Exit menu option.  The Logoff sequence is run, as outlined in steps 2 – 5 of “To Logoff of the WINGS Application” in the Logoff (File Menu) section.  The WINGS application closes.

NOTE:
Activating the Close button in the upper right corner of the WINGS window is the same as selecting the Exit menu option from the File menu.

3.3  XE "Flight Plan:Menu" Flight Plan

The Flight Plan menu provides the capability to create a Domestic or an ICAO flight plan and to retrieve various types of information including Current Plan, Facility Flight Activity, XE "Facility Flight Activity"  Facility Log Data, XE "Facility Log Data"  User Flight Activity XE "User Flight Activity"  and Partial Flight Plans. The Flight Plan menu also provides the capability to select a preferred route and to access a Flight Workspace. XE "Flight Workspace" 
[image: image54.png]Creste »
Retieve »

Prefered Route... Cl+F5

Flight Warkspace »





Figure 3‑22  Flight Plan Menu

To Display the Flight Plan Menu:

1. <Click> the Flight Plan menu.

3.3.1 Create (Flight Plan Menu)

The Create menu option XE "Create Flight Plan"  provides the capability to create a Domestic or an ICAO flight plan for any user with the capability to create that type of flight plan.  Selecting the Create menu option displays the Create submenu.  Selecting either the Domestic or ICAO option displays the respective Flight Plan dialog box.  Up to five Flight Plan dialog boxes may be open concurrently.  The title bar of each flight plan dialog box displays the Aircraft ID of the flight plan.  
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Figure 3‑23  Create Submenu

To Display the Create Sub-menu

1. <Click> the Flight Plan menu.

2. <Select> the Create menu option to display the Create sub-menu.

Table 3‑9  Domestic and ICAO Flight Plan XE "Flight Plan:Dialog Box"  Dialog Boxes

	Label
	Component
	Purpose

	Validate All
	Button
	Attempts to validate both the route and the Flight Plan information.  Upon successful validation, output routing, closure points and ETA are returned.  This option allows a user to add closure points or override automatic addressing before filing the flight plan.

	File
	Button
	Attempts to file a flight plan.  The flight plan will be validated and filed and placed on the proposed list until activation (transmit time) or cancellation.

	Activate
	Button
	Transmits the flight plan to the proper facility and moves the flight plan entry from the proposed list to the suspense list to await acknowledgment from the receiving facility.  Any changes made to the ETD or Remarks are saved.  To save changes to any other fields, amend the flight plan before activating it.

	Amend
	Button
	Attempts to validate the amended flight plan information.  Upon successful validation, the amended flight plan is returned with output routing, closure points and ETA included. Inbound flight plans are not validated, and changes to the ETD and Time Enroute are textual only.  Changing the ETD, ETA, or Time Enroute fields on an inbound flight plan will not cause either of the other two fields to be recalculated.

	Prestore
	Button
	Attempts to validate and store the current open flight plan for retrieval and processing later.  Upon successful validation, the flight plan is returned within the Prestored Flight XE "Prestored Flight"  Plan window with output routing, closure points and ETA included as requested.

	Close Flight Plan
	Button
	Attempts to close a flight plan from the current flight plan file and returns a completion message stating the status of the closure.

	Cancel Flight Plan
	Button
	Attempts to cancel a flight plan and returns the flight plan data with a completion message if successful.  Otherwise, a message is returned stating the status of the attempted cancellation.

	Briefing Log
	Button
	Provides the user the capability to log all contact activity (Preflight, Inflight, Flight Watch or Contact) with an active ICAO or Domestic flight plan.

	Save Partial
	Button
	Saves a partial or incomplete flight plan for retrieval processing later during the duration of the user’s logon session.

	Clear Fields
	Button
	Clears the fields within the current Flight Plan window.

	Change Type
	Button
	Changes a flight plan from ICAO to Domestic or changes a flight plan from Domestic to ICAO on either current or prestored flight plans.

	Area Briefing (Departure)
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box.  If a field is invalid, then an error is displayed.  If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Area Briefing
(Destination)
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box.  If a field is invalid, then an error is displayed.  If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Validate
	Button
	Attempts to validate the Flight Plan route.

	Preferred
	Button
	Requests a Preferred Route without displaying the Preferred Route dialog box.  If a field is invalid, then an error is displayed.  If a field is missing, the Preferred Route form is displayed with the cursor placed in the missing field.  Preferred Routes are not allowed for ICAO Flight Plans.

	Route Briefing
	Button
	Requests a Route Briefing without displaying the Route Briefing dialog box.  If a field is invalid, then an error is displayed.  If a field is missing, the Route Briefing form is displayed with the cursor placed in the missing field. 

	Flight Profile (Bi-Plane Graphic)
	Button
	(Currently disabled)  Provides a cross sectional view of the route of flight from the departure point to the destination.  This cross sectional view is displayed in the Weather Graphics Window.  Also includes alphanumeric briefing data for the route, corresponding to a Standard Route Briefing.

	Route Overlay  (World Graphic)
	Button
	Becomes active (colored and rotating) when either a route or a flight plan is validated  Route coordinates can then be overlaid onto a product in the Weather Graphics window.  Click on the active world graphic to overlay route information graphically onto a Weather Graphics product.


 NOTE:   The Preferred Routes capability is disabled for ICAO Flight Plans.

3.3.1.1  XE "Flight Plan:Dialog Box" Domestic Flight Plan Dialog Box – Flight Information

The Domestic Flight Plan dialog box is used when creating a Domestic Flight Plan.  It provides the capability to Validate All, File, Activate, Amend, Prestore, Close Flight Plan, Cancel Flight Plan, Briefing XE "Briefing"  Log, Save Partial, Clear Fields, and Change Type.   The available route functions include Route Override, Validate, Preferred, and Route Briefing XE "Route Briefing"  on the Flight Information tabbed page. Departure and Destination Area Briefings are also available on the Flight Information tabbed page.   A Domestic Flight Plan may be changed to an ICAO Flight Plan and vice versa via the Change Type function.   A user must validate or amend the flight plan after conversion to save the changes.  After the flight plan is validated, the Route Overlay XE "Overlay:Route"  button becomes active. 
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Figure 3‑24  Domestic Flight Plan Dialog Box  - Flight Information Tabbed Page

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

The following table provides a detailed explanation of the Flight Plan dialog box main functions.

Table 3‑10  Domestic Flight Plan XE "Flight Plan:Dialog Box"  Dialog Box – Flight Information Tabbed Page Description 

	Label
	Component
	Purpose

	Flight Rules
	Drop-down List Box
	Choose the type of flight rules (VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER).  

	Aircraft ID
	Text Box
	Enter the Aircraft Identification; 2-7 alphanumeric characters.  The first character must be a letter.

	Aircraft Type
	Text Box
	Enter the Aircraft Type, 2-9 alphanumeric characters with an optional prefix and/or suffix separated by “/”.

	Airspeed
	Text Box
	Enter the estimated airspeed; 2-4 numerics (knots/hr), M + 3 numerics (mach speed), or SC (speed classified).

	Departure
	Text Box
	Enter the departure location; 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.

	ETD
	Text Box
	Enter the Estimated Time of Departure; [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Enroute Altitude
	Text Box
	Enter the planned Altitude, 2-7 alphanumeric characters.

	Route
	Text Box
	Enter the planned route, 0-558 Character Routes.  A Preferred Route listing can be dragged from the Preferred Route dialog box to this field.

	Destination
	Text Box
	Enter the destination location; 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	Remarks
	Text Box
	Enter any additional remarks relative to the Flight Plan; (0-325 characters) NONE, NA, or N/A means no remarks.  May contain special characters *, $, #, and % for selective processing.  See the section on Remarks Special Use Processing Codes.

	Fuel Capacity
	Text Box
	Enter the fuel capacity;  hhmm : hh = 00-99, mm = 00-59.

	Alternate Airport
	Text Box
	Enter the LOCID of an alternate (destination) airport, 3-4 alphanumeric characters.

	Pilot Data
	Text Box
	Enter  information about the pilot, such as name, phone, address, home base, and destination contact, 0-201 characters.

	Number on Board
	Text Box
	Enter the number of people to be on board, 1-3 numerics. 

	Aircraft Color
	Text Box
	Enter the color or color scheme of the aircraft, 0-15 characters.

	VFR Output Routing
	Text Box
	Enter 3, 4, or 8 character address for the tie-in Flight Service Station.  This field is automatically filled out after validation.

	IFR Output Routing
	Text Box
	Enter 3, 4, or 8 character address for the tie-in ARTCC.  This field is automatically filled out after validation.  This field is grayed-out when VFR, MIL VFR, or MIL VFR Stopover Flight Rules are selected.

	Closure Points
	Text Box
	Enter the closure points, 3 - 8 character address of up to 16 tie-in stations (multiple addresses must be separated by a space).  

	ETA 
	Text Box
	Estimated Time of Arrival; [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.  Supplied after validation.

	Route Override
	Check Box
	Overrides the Route, Departure, and Destination fields.  See the Invalid Route Elements Section for more details.  Route Override capability is disabled for Stopover flight rules.


The Domestic Aircraft Type will be validated before the first ‘/’ character as follows:

-
1 or 2 Numerics (1-99)

-
H, B, or T

-
1 Numeric (1-9) followed by H, B, or T

To Create a Domestic Flight Plan: XE "Flight Plan:Dialog Box" 

 XE "Flight Plan:Create" 
1. <Click> the Flight Plan menu.

2. <Select> the Create menu option XE "Create Flight Plan"  to display the Create sub-menu.

3. <Select> the Domestic menu option. 

4. Enter the flight plan data in the appropriate text boxes.

5. <Click> the desired action button located at the bottom of the dialog box to create the flight plan (File, Amend, Prestore, etc.).

3.3.1.2 ICAO Flight Plan Dialog Box – Flight Information

The ICAO Flight Plan dialog box is used when creating an ICAO Flight Plan.  It provides the capability to Validate All, File, Activate, Amend, Prestore, Close Flight Plan, Cancel Flight Plan, Briefing XE "Briefing"  Log, Save Partial, Clear Fields, Change Type, and Validate All.   The available route functions include Route Override, Validate,  and Route Briefing XE "Route Briefing"  on the Flight Information tabbed page. Departure and Destination Area Briefings are also available on the Flight Information tabbed page.   An ICAO Flight Plan may be changed to a Domestic Flight Plan and vice versa via the Change Type function.   A user must validate or amend the flight plan after conversion to save the changes.  After the flight plan is validated, the Route Overlay XE "Overlay:Route"  button becomes active.  The Flight Profile button accesses a cross-sectional view of the route of flight.
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Figure 3‑25  ICAO Flight Plan Dialog Box - Flight Information Tabbed Page

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

NOTE:  The Preferred Routes capability is disabled for ICAO Flight Plans.

Table 3‑11  ICAO Flight Plan XE "Flight Plan:Dialog Box"  Dialog Box – Flight Information Tabbed Page Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be a letter.

	Flight Rules
	Drop-down List Box
	Choose the type of flight rules (VFR, IFR, VFR/IFR, IFR/VFR).  

	Type of Flight 
	Drop-down List Box
	Choose or type the one-character flight type.

S - Scheduled Air Transport

N - Non-Scheduled Air Transport

G - General Aviation

M - Military

X - Any other type of flight

	Number of Aircraft 
	Text Box
	Enter the number of aircraft associated with the flight plan (1-2 digits).

	Aircraft Type 
	Text Box
	Enter the Aircraft Type, 2-4 alphanumeric characters.  

	Wake Turbulence
	Drop-down List Box
	Choose the wake turbulence of the aircraft (Heavy, Medium or Light).

	Comm/Nav Equipment
	Text Box
	Select the Comm/Nav Equipment button (labeled “…”).  Choose from the Comm/Nav options listed in the Equipment Options list or enter the one character identifier(s) manually.   If S is present, it must be first.   Choosing S from the Equipment Options list will automatically place it first in the Comm/Nav Equipment text box.  If N is chosen from the Equipment Options list, any other options must be manually deleted.

Enter - N for none or any combination of 1-16 alphabetic characters.

	Transponder
	Text Box
	Select the Transponder button (labeled “…”).  Choose from the Transponder options listed in the Equipment Options list or enter the one character identifier(s) manually.   If N is selected from the Equipment Options list, the other entry in the text box must be removed manually.

Enter - N for none or any combination of 1-2 alphabetic characters.

	Departure
	Text Box
	Enter the departure location, 4 character LOCID.  

	ETD
	Text Box
	Enter the Estimated Time of Departure; [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Airspeed
	Text Box 
	Enter the estimated airspeed; M + 3 numerics (mach speed), N + 4 numerics (knots/hr), or K + 4 numerics (kilometers/hr).

	Enroute Altitude
	Text Box
	Enter the planned Altitude, F/A + 3 numerics or S/M + 4 numerics.  

	Route
	Text Box
	Enter the planned route.

	Destination
	Text Box
	Enter the destination location, 4 character LOCID. 

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	Alternate Airport
	Text Box
	Enter the LOCID of an alternate (destination) airport, 4 characters

	2nd Alternate Airport 
	Text Box
	Enter the LOCID of a second alternate (destination) airport, 4 characters.

	Remarks
	Text Box
	Enter any additional remarks relative to the Flight Plan; (1-325 characters)  NONE, NA or N/A means no remarks. May contain special characters *, $, #, and % for selective processing.  See the section on Remarks Special Use Processing Codes.

	Endurance
	Text Box
	Enter the Endurance (fuel capacity) of the Aircraft; hhmm: hh = 00-99, mm = 00-59.

	Number On Board
	Text Box
	Enter the number of people on board; 1-3 numerics

	Emergency Radio
	Text Box
	After selecting the Emergency Radio button, (labeled “…”) choose from the Equipment Options list on the right or enter the one character identifier(s) manually.  If N is selected from the Equipment Options list, any other entries in the text box must be removed manually.  Enter - N for none, or any 1-3 characters from the Equipment Options list box.

	Survival Equipment
	Text Box
	After selecting the Survival Equipment button, (labeled “…”) choose from the Equipment Options list on the right or enter the one character identifier(s) manually.  If N is selected from the Equipment Options list, any other entries in the text box must be removed manually.  Enter - N for none, or any 1-4 characters from the Equipment Options list box.

	Life Jackets
	Text Box
	After selecting the Life Jackets button, (labeled “…”) choose from the Equipment Options list on the right or enter the one character identifier(s) manually.  If N is selected from the Equipment Options list, any other entries in the text box must be removed manually.  Enter - N for none, or any 1-4 characters from the Equipment Options list box.

	Number of Dinghies
	Text Box
	Enter the number of Dinghies onboard (1-2 numerics).

	Dinghy Capacity
	Text Box
	Enter the number of passengers each dinghy will hold (1-3 numerics).

	Dinghy Cover
	Text Box
	Enter Y for Yes or N for No.

	Dinghy Color
	Text Box
	Enter the color or color scheme of the dinghy(s), 0 to 24 alphabetic characters.

	Aircraft Color
	Text Box
	Enter the color or color scheme of the Aircraft, 0 to 24 characters.

	Equipment Remarks
	Text Box
	Enter any additional remarks relative to the onboard equipment, 0-80 characters.

	Pilot Data
	Text Box
	Enter information about the pilot, such as name, phone, address, home base, and destination contact, 0-201 characters.

	VFR Output Routing
	Text Box
	Enter 3, 4, or 8 character address for the tie-in Flight Service Station.  This field is automatically filled out after validation. 

	IFR Output Routing
	Text Box
	Enter 3, 4, or 8 character address for the tie-in ARTCC.  This field is automatically filled out after validation.  This field is grayed-out when VFR Flight Rules are selected.

	Closure Points
	Text Box
	Enter the closure points, 3 - 8 character address of up to 16 tie-in stations (multiple addresses must be separated by a space). 

	ETA
	Text Box
	Estimated Time of Arrival, a non-editable field;  ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.  Supplied after validation.

	Route Override
	Check Box
	Overrides the Route, Departure, and Destination fields.  See the Invalid Route Elements Section for more details. 


To Create an ICAO Flight Plan: XE "Flight Plan:Create" 
1. <Click> the Flight Plan menu.

2. <Select> the Create menu option XE "Create Flight Plan"  to display the Create sub-menu.

3. <Select> the ICAO menu option.  

4. Enter the flight plan data in the appropriate text boxes. 

5. <Click> the desired action button located at the bottom of the dialog box to create the flight plan (File, Amend, Prestore, etc.).

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help when the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

3.3.1.3  XE "IFR/VFR" ICAO VFR/IFR & IFR/VFR Flight Rules

The Route field has special consideration when the Flight Rules field is VFR/IFR or IFR/VFR.  In the Route field, the fix point immediately prior to the rule change is considered the “transition point”.   IFR or VFR appears in the route to indicate the transition point.   Each portion of the Flight Rules is treated as a separate route; however, it remains as a single flight plan. XE "Flight Plan:Filing" 
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Figure 3‑26  ICAO Flight Plan Dialog Box –VFR/IFR Flight Rules

3.3.1.4  XE "Invalid Route Elements" Invalid Route Elements

When an attempt is made to validate a Flight Plan, and one or more route elements are invalid, the invalid elements will be highlighted in red and underlined.  In addition, if two elements of the route are correct, but the system is unable to “connect” them, both elements will be highlighted.  Highlighted elements may be in the Departure, Destination, or Route fields.  If the flight plan needs to be filed with the invalid elements, then the Route Override check box may be selected in order to override the validation of these route elements.  The items will still be highlighted, even when the Route Override check box is checked.  

The system will attempt to format the route with the invalid elements.  However, if the system cannot determine the proper formatting, an error message will be displayed when the flight plan is validated or filed, even when the Route Override checkbox is selected.  In this case, the user will be required to manually format the entire route for transmission, by inserting any necessary periods between route elements.  Once the user has formatted the route and selected the Route Override checkbox, the route will be accepted without validation, and no items will be highlighted.  

The user will be unable to get a Flight Profile for the flight plan XE "Flight Plan:Dialog Box"  until any highlighted elements have been changed or removed.  If the Route Briefing XE "Route Briefing" 

 XE "Briefing"  button is pressed, the highlighted items will be transferred to the Route Briefing window.  Any changes made to correct the highlighted items in the Route Briefing form (in order to get a Route Briefing) will not be reflected in the Flight Plan window.
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Figure 3‑27  Domestic Flight Plan Mask with Invalid Route Element

3.3.1.5 Remarks Special Use Processing Codes

The Remarks field of a Domestic or ICAO flight plan may contain the special characters *, $, #, and % to allow for selective processing of the Remarks.  This provides the capability to transmit all of the information in the Remarks field, to transmit selected parts of the Remarks field, or to inhibit the transmission of Remarks altogether.  Refer to the following table to determine the criteria for processing each special character in the Remarks field.   For ICAO flight plans, the special characters have higher precedence than “other info” XXX/ codes such as RMK/.

Table 3‑12  Remarks Special Use Processing Codes 

	Message Type
	Do Not Transmit & Stop Processing Any Remarks After
	Transmit Remarks After
	Do Not Transmit Remarks After
	Special Character Transmitted
	Remarks Transmitted To

	Proposed IFR Flight Plan

Proposed VFR Flight Plan
	%
	$, $*, 

and $#
	*, #
	“$” added at beginning of transmitted remarks data 
	FSS/Base Ops

	Civil Domestic Flight Notification (IFR & VFR)

Military Flight Notification (IFR & VFR)

Mexican Flight Notification (IFR & VFR)

Canadian Flight Notification (IFR & VFR)

ICAO Flight Plan(IFR & VFR)

Proposed ICAO Flight Plan (IFR & VFR)

ICAO IFR/VFR Flight Plan (VFR Portion)

ICAO VFR/IFR Flight Plan (VFR Portion)
	%
	$, $* 

and $#
	*, #
	No special character transmitted
	FSS/Base Ops/Add’l

Notification Addresses

	IFR Flight Plan

DVFR Flight Plan

ICAO IFR Flight Plan

Stereo Flight Plan

ICAO IFR/VFR Flight Plan (IFR Portion)

ICAO VFR/IFR Flight Plan (IFR Portion)
	%
	*, #, $*, $#, *$ 

and #$
	$
	Domestic Flight Plans only:

“*” converted to “:”

“#” converted to “?”

“:” converted at beginning of transmitted data stream if no special code found

ICAO IFR Flight Plans:

No special character transmitted
	Host
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Figure 3‑28  IFR Flight Plan XE "Flight Plan:Filing" 

 XE "Flight Plan:Dialog Box"  Using Special Processing Codes in Remarks

3.3.1.6 Military Stopover Flight Plans

Stopover Flight Plans are available from the Domestic Flight Plan dialog Box.  To enter a Stopover Flight Plan, choose one of the Stopover Flight Rules, then enter the information for the first leg into the Flight Plan dialog box.  The Remarks field is used to hold common remarks for all of the legs.  Information for the other legs (and individual Remarks) should be entered into the Route field using the following format:

Table 3‑13  Military Stopover Flight Plan Format 

	Field
	Definition / Format

	/FR AD TE TS TM AE RT RM  
	where:

	FR 
	Flight Rules (optional).  If not entered, the flight rules from the flight plan mask will be used. 

	AD 
	Enter the Destination location (required) ; 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.

	TE 
	Enter the Time Enroute (required); 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	TS 
	True Airspeed (required).  2-4 numerics (knots/hr), M + 3 numerics (mach speed), or SC (speed classified).

	TM 
	ETD (6 digit ETD required); ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59

	AE 
	Enroute altitude (required).  2-7 alphanumeric characters.

	RT 
	Route (required).  0-558 characters.

	RM 
	Remarks (optional).  0-325 characters.


To determine where the route ends and the remarks begin in a leg, the user must enter the appropriate special character(s) *, $, #, or % immediately before the remarks.  
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Figure 3‑29  Stopover Flight Plan XE "Flight Plan:Filing" 

 XE "Flight Plan:Dialog Box" 
Once Validated or Filed, each leg of the stopover is treated as a separate flight plan.  The first Flight Plan will have the original departure point.  Subsequent Flight Plans will use the destination of the previous leg as the departure point for the current leg.

The remarks field on all flight plan records will contain the individual leg’s remarks (from the route leg information), then the common remarks from the remarks field.

On a Validate All action, the OASIS will create one Flight Plan for each leg of the route and auto-address each leg. If the information in the Route field cannot be validated, the Stopover Flight Plan will be redisplayed with a message box stating which leg is invalid.  If the Route field can be validated, the Flight Plan dialog box is closed, and the Stopover Flight Plans dialog box appears.  This dialog box lists each of the Flight Plans, and their status after the initial validation.  This information will not be updated as more action is taken.  From this list, each Flight Plan can be expanded and filed individually. After each leg is filed, the Stopover Flight Plans dialog box will place a check mark beside the Flight Plan to indicate it has been filed.  WINGS will display a warning message if the user attempts to close the dialog box before each of the Flight Plans have been filed. 

On a File action, the Stopover flight plan XE "Flight Plan:Filing"  will go through validation first.  If there is an error during the validation, none of the legs will be filed and WINGS will display either a list of legs in a separate dialog box or the original Flight Plan depending on which part of the Stopover was invalid. In the event that the Stopover Flight Plans dialog box is returned and one or more legs are invalid, the user will then have to file each leg separately.  If the Stopover is returned in the Flight Plan dialog box, then the user can correct the error and attempt to File the Flight Plan again.

The Route Overlay, XE "Overlay:Route" \r "D2HBOverlay31"  Flight Profile, Change Type, Prestore, Route Briefing, XE "Route Briefing" 

 XE "Briefing"  Preferred Route, XE "Preferred Route"  Route Override, and Validate Route functions from the flight plan mask will not be enabled for the original flight plan with the legs included in the Route field.  After the flight plan is validated and the legs are separated into flight plans, the user will be able to perform these functions.

[image: image62.png]|5 stopover Flight Plans

| [Fiee___T el Fight Satus [ AicratID__| Fight Rules | Aicrat Type | Depattute___| Destinaion__| ETD__| ETA

" LDATED

| NO  WALIDATED Ra321 My UH1A PAE MwH 032215 100015
N VALIDATED R4z M Uk MwH Ska 100200 100245

|
|

‘ |

Retieve Fight Flan Close Help

|





Figure 3‑30  Stopover Flight Plans Dialog Box

NOTE:
Stopover Flight Plan list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text.

Table 3‑14  Stopover Flight Plans Dialog Box Description 

	Label
	Component
	Purpose

	Stopover Flight Plans
	Scroll List
	Displays the legs of the Stopover Flight Plan.

	Filed
	Column
	Filing status of the flight plan leg.

	Initial Flight Status 
	Column
	Initial status of the flight plan leg.

	Aircraft ID 
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules 
	Column
	Flight rules of the flight plan.

V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR.

	Aircraft Type 
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure 
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination 
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD 
	Column
	Estimated Time of Departure; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	ETA 
	Column
	Estimated Time of Arrival; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Origin 
	Column
	Address of the facility responsible for the flight plan.

	Remarks 
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Flight Plan Type 
	Column
	Domestic.  

	Retrieve Flight Plan
	Button
	Opens the selected leg of the Stopover Flight Plan.


Table 3‑15  Flight Status Values Associated with Stopover Flight Plans

	Flight Status 
	Description

	VALIDATED 
	Stopover leg validated successfully.

	NOT VALIDATED 
	Stopover leg not validated successfully.

	ERROR
	An internal error occurred while transmitting the stopover leg.  If such an error occurs, a message will be generated to the Alerts List notifying the specialist of the problem.

	PENDING
	Stopover leg is on the Proposed List, XE "Proposed List"  pending transmission to the ARTCC or out of area AFSS.

	PROPOSAL
	Stopover leg is on the Proposed List, waiting to be activated.  The leg will be automatically dropped when it is late by the value of the Proposed Flight Plan Drop Interval (PFPDI).

	TEMPPENDING
	At least one message has been sent for the stopover leg (e.g. IFR Flight Plan message to the ARTCC, Proposed Flight Plan message to the out of area AFSS) and is waiting to be acknowledged.


3.3.1.7 Route Overlay

The Route Overlay feature becomes active (colored and rotating) when a flight plan is Validated (using the Validate All function or the Validate function) with the appropriate information.  Up to ten routes may be displayed on a weather graphic product.  See the section on the Weather Graphics Window for additional information. 

3.3.1.8 Flight Profile

(currently disabled)  The Flight Profile option is used to request a cross sectional view of the route of flight, as well as alphanumeric briefing information, for a Flight Plan.  The cross sectional view includes temperature, wind speed, wind direction, ground distance, and ETA information along the route.  See the Cross Sectional XE "Cross Sectional"  Flight Plan Section in the Weather Information Network Display (WIND) chapter for more information on the graphical display.  The alphanumeric data is displayed in the Weather and Aeronautical briefing dialog box and contains the same information as a Standard Route Briefing. XE "Route Briefing" 

 XE "Briefing"   From the Weather and Aeronautical briefing dialog box, the user can then record a Briefing Log or graphically overlay the route.

To Display the Flight Profile:

1. <Click> the Flight Profile animated bi-plane graphic. The Weather and Aeronautical briefing dialog box will be displayed, containing alphanumeric briefing data for a Standard Route Briefing.  In the Weather Graphics Window, a cross sectional view of the flight plan will be displayed.  See the Cross Sectional Flight Plan section in Chapter 4.

3.3.2 Retrieve (Flight Plan Menu)

The Retrieve Menu option provides the capability to retrieve various types of flight plan information, including Current Plan, Facility Flight Activity, XE "Facility Flight Activity"  Facility Log Data, XE "Facility Log Data"  User Flight Activity XE "User Flight Activity"  and Partial Flight Plans.
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Figure 3‑31  Retrieve Submenu

To Display the Retrieve Sub-menu:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3.3.2.1 Current Plan (Flight Plan Menu/Retrieve)

The Current Plan menu XE "Current Plan" \r "D2HBCurrent_Plan33"  option displays the Current Flight Plan Request dialog box and allows the user to retrieve a current active flight plan or plans from the FDS XE "Flight Data Server" \r "D2HBFDS33"  that matches the entered Aircraft ID number or partial Aircraft ID number containing wildcard characters.
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Figure 3‑32  Current Flight Plan XE "FlightPlan:Retrieve"  Request Dialog Box

Table 3‑16  Current Flight Plan Request Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The wildcard characters ‘*’ and ‘?’ may also be used.  The ‘*’ character must be used with at least 1 more character not including the ‘?’ character.

	OK
	Button
	Attempts to retrieve all flight plans with a matching Aircraft ID from the FDS.

If a single current flight plan is retrieved, the flight plan is displayed within the appropriate (ICAO or Domestic) Flight Plan window.  If multiple flight plans are found, they are returned within the Current Flight Plans dialog box and the desired flight plan must be selected from the current flight plan list.  Up to 200 entries may be retrieved in a request.


To Retrieve a Current Flight Plan:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Current Plan menu option to display the Current Flight Plan Request dialog box.

4. Enter the Aircraft ID into the appropriate field.

5. <Click> the OK button.  If a single current flight plan is retrieved, the flight plan is displayed within the appropriate (ICAO or Domestic) Flight Plan window.  If multiple flight plans are found, they are returned within the Current Flight Plans dialog box.

6. If multiple flight plans were returned, <select> the desired entry (flight plan).

7. <Click> the Retrieve Flight Plan button.  The single flight plan is returned within the appropriate Domestic or ICAO Flight Plan dialog box.

NOTE:
An “*” or a “?” can be used as a wildcard character to search the database for a flight list of similar IDs.  An “*” represents 0 to many characters that should be matched; a “?” represents a single character that should be matched.  For example, “N*” will generate a list of flight plans with N as the first character and any number of characters to follow.

NOTE:  If a flight plan XE "FlightPlan:Retrieve"  was not found, and no wildcard characters were used in the Aircraft ID request text box, a new flight plan will be created with that Aircraft ID.

The Current Flight Plans dialog box displays all of the flight plans that match the Aircraft ID or wildcard characters entered.  By default, the Current Flight Plans dialog box is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑33  Current Flight Plans Dialog Box

NOTE:
Current Flight Plan list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text.

Table 3‑17  Current Flight Plans Dialog Box Description 

	Label
	Component
	Purpose

	Current Flight Plans
	Scroll List
	Displays a summary entry for each flight plan.

	Flight Status 
	Column
	Current status of the flight plan.

	Aircraft ID 
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules 
	Column
	Flight rules of the flight plan.

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Aircraft Type 
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure 
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination 
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD 
	Column
	Estimated Time of Departure; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	ETA 
	Column
	Estimated Time of Arrival; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Origin 
	Column
	Address of the facility responsible for the flight plan.

	Remarks 
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Flight Plan Type 
	Column
	Domestic or ICAO.  

	Retrieve Flight Plan
	Button
	Opens the selected current flight plan.


Table 3‑18  Flight Status Values Associated with Current Flight Plans

	Flight Status 
	Description

	ACTIVATED 
	Flight plan has been activated and is waiting to be acknowledged.

	DROPPED 
	Flight plan was automatically dropped because it was not activated and became late by the value of the Proposed Flight Plan Drop Interval (PFPDI).

	ERROR 
	An internal error occurred while transmitting the flight plan.  If such an error occurs, a message will be generated to the Alerts List notifying the specialist of the problem.

	INACTIVE 
	Flight plan has reached its ETA.

	INBOUND 
	Flight plan is on the Inbound List, waiting to be closed.

	PENDING 
	Flight plan is on the Proposed List, pending transmission to the ARTCC or out of area AFSS.

	PROPOSAL 
	Flight plan is on the Proposed List, waiting to be activated.  The flight plan will be automatically dropped when it is late by the value of the Proposed Flight Plan Drop Interval (PFPDI).

	PROPOSEDINBD 
	Flight plan is on the Proposed List, waiting to be activated via an ICAO Departure message.  The flight plan will be automatically dropped when it is late by the value of the Proposed Flight Plan Drop Interval (PFPDI).

	TEMPPENDING 
	At least one message has been sent for the flight plan (e.g. IFR Flight Plan message to the ARTCC, Proposed Flight Plan message to the out of area AFSS, or ICAO Flight Plan message to the inbound AFSS) and is waiting to be acknowledged.

	TRANSFERRED 
	Transferred to another facility.


To Overlay XE "Overlay:Route" \r "D2HBOverlay36"  a Flight Plan onto the Weather Graphic Window:

This procedure assumes that there is a product open in the Weather Graphic Window with capabilities to display a route overlay.

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Current Plan menu XE "Current Plan"  option to display the Current Flight Plan Request dialog box.

4. Enter the Aircraft ID into the appropriate field.

5. <Click> the OK button.  The flight plan XE "Flight Plan:Menu" 

 XE "Flight Plan:Display" 

 XE "FlightPlan:Retrieve"  is displayed within the appropriate (ICAO or Domestic) Flight Plan window.

6. <Click> on the World icon in the Flight Plan mask.  The Flight Plan route will be displayed on any weather graphic product open with capabilities to display a route overlay.

3.3.2.2  XE "Facility Flight Activity" \r "D2HBFacility_Fli37" Facility Flight Activity (Flight Plan Menu/Retrieve)

The Facility Flight Activity menu option displays the Facility Flight Activity Request dialog box and provides the capability to retrieve all historical facility flight activity for a specific Aircraft ID and/or specified times.  Facility Flight activity refers to any flight plan activity in the local facility.  There usually will be several entries associated with an Aircraft ID.
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Figure 3‑34  Facility Flight Activity Request Dialog Box

Table 3‑19  Facility Flight Activity Request Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be a letter.  May also use the “*” or “?” wildcard characters.

	Start Time
	Text Box
	Enter the start time for the time span of data to be retrieved (mm/dd/yyyy hhmm).  No more than 15 days of data may be retrieved..

	Stop Time 
	Text Box
	Enter the stop time for the time span of data to be retrieved (mm/dd/yyyy hhmm).

	OK
	Button
	Accepts current data input and opens the Facility Flight Activity- Flight Data dialog box.


The Facility Flight Activity – Flight Data dialog box displays all of the flight plan activity that matches the Aircraft ID and/or time range entered.  No more than 15 days of data may be retrieved.  By default, the Facility Flight Activity – Flight Data dialog box is sorted by Time Stamp, from oldest to most recent.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑35  Facility Flight Activity - Flight Data Dialog Box

NOTE:
The Search criteria displays the Start Time and Stop Time from the Facility Flight Activity Request dialog box.

Table 3‑20  Facility Flight Activity - Flight Data Dialog Box Description 

	Label
	Component
	Purpose

	Flight Data
	Scroll list
	Displays a summary list entry for each flight plan transmitted.

	Xmit History 
	Column
	The action taken or state of the flight plan.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules
	Column
	Flight rules of the flight plan.

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD 
	Column
	Estimated Time of Departure; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	ETA 
	Column
	Estimated Time of Arrival; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.  

	Origin
	Column
	Address of the facility responsible for the flight plan.

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Flight Plan Type
	Column
	Domestic or ICAO.  

	Time Stamp
	Column
	Displays the time of action MM/DD/YY(HHMMSS).

	Create Flight Plan
	Button
	Provides the option to create a flight plan from information contained in a historical flight plan entry in the Flight Data dialog box.


NOTE:
Facility Flight Activity list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text.

To Retrieve Facility Flight Activity:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Facility Flight Activity menu option to display the Facility Flight Activity Request dialog box.

4. Enter the requested information in the appropriate text boxes.  Press the Tab key to maneuver to the next text box.

5. <Click> the OK button.  The Facility Flight Activity - Flight Data dialog box is displayed providing the requested information.  The search criteria entered in the Facility Flight Activity Request dialog box will be displayed at the top of the Facility Flight Activity - Flight Data dialog box.

Table 3‑21  Transmit History Associated with Facility Flight Activity - Flight Data

	Transmit History
	Description

	ACK-ALL FSS 
	Received ACKs from all FSSs.

	ACK-ARTCC 
	Received acknowledgment (ACK) from ARTCC.

	ACTIVATED 
	Flight plan was activated.

	ADDED TO DB 
	New flight plan filed.

	AMENDED 
	Flight plan was amended.

	CANCELED 
	Flight plan was canceled.

	CLOSED 
	Flight plan was closed.

	DATAFILE 
	Data file was stored.

	DROPPED 
	Flight plan was dropped.

	ERR-ARTCC 
	Received error from ARTCC. 

	INACTIVE 
	Flight plan moved to inactive. 

	INBOUND OVERDUE 
	Flight plan became late by the full value of the Inbound Overdue Timer (INBOVERT).

	INBOUND WARNING 
	Flight plan became late by half the value of the Inbound Overdue Timer (INBOVERT).

	INBOUND-AMEND 
	Flight plan was amended on Inbound List.

	MANUAL-ACK 
	Flight plan was manually acknowledged.

	PRESCHEDULED-TIMED-OFF 
	Added prestored flight plan to schedule.

	PRESTORED 
	Flight plan was prestored.

	PRESTORED-DEL 
	Prestored flight plan was deleted.

	PROPOSED OVERDUE 
	Flight plan became late by the full value of the Proposed Flight Plan Drop Interval (PFPDI).  The flight plan is automatically dropped when it reaches this state.

	PROPOSED WARNING 
	Flight plan became late by half the value of the Proposed Flight Plan Drop Interval (PFPDI).

	REJ-ARTCC 
	Received reject from ARTCC.

	SENT-ACTIVATE 
	Sent activation message.

	SENT-ARTCC 
	IFR flight plan message sent to ARTCC.

	SENT-CANCEL 
	Sent VFR flight plan cancel message.

	SENT-CLOSED 
	Sent VFR flight plan closure message.

	SENT-ICAO 
	Sent ICAO flight plan message.

	SENT-PROPOSAL 
	Sent proposed flight plan message.

	STAY ON PLIST 
	Stay on Proposed List.

	STOPOVER INVALID 
	Stopover flight plan invalid.

	STOPOVER VALID 
	Stopover flight plan valid.

	SUSPENSE OVERDUE 
	Acknowledgment is late the full value of the relevant site definable parameter.  The specific parameter used depends upon the type of message being transmitted.

	SUSPENSE WARNING 
	Acknowledgment is late by half the value of the relevant site definable parameter.  The specific parameter used depends upon the type of message being transmitted.

	TRANSFERRED 
	Flight plan was transferred to another facility.

	UNSENT-ARTCC 
	Sent to ARTCC failed.

	UNSENT-FSS 
	Sent to FSS failed.


To Create a Flight Plan from a Historical Flight Plan Entry:

1. <Select> an historical flight plan entry from the list.

2. <Click> the Create Flight Plan button.  The appropriate Flight Plan window is displayed.

3. Enter the flight plan data in the appropriate text boxes within the tabbed pages.

4. <Click> the desired action button located at the bottom of the dialog box to create the flight plan.

3.3.2.3  XE "Facility Log Data" Facility Log Data (Flight Plan Menu/Retrieve)

The Facility Log Data menu option displays the Log Data Request dialog box and provides the capability to retrieve historical Preflight, Inflight, Flight Watch and Contact log data files for specified aircraft and/or periods of time. 
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Figure 3‑36  Log Data Request Dialog Box

Table 3‑22  Log Data Request Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the 2 - 7 characters, A/N Aircraft Identification.  The first character must be a letter.

	Start Time
	Text Box
	Enter the start time for the time span of data to be retrieved (mm/dd/yyyy hhmm).  Not to precede 15 days from present date.

	Stop Time 
	Text Box
	Enter the stop time for the time span of data to be retrieved (mm/dd/yyyy hhmm).

	Log Type
	Group Label
	Allows selection of Radio Buttons for Contact, Preflight, Inflight, Flight Watch or All types of log files.

	OK
	Button
	Accepts current data input and opens the Facility Log Data dialog box.


The Facility Log Data dialog box displays all of the briefing log activity that matches the Aircraft ID and/or time range entered.  By default, the Facility Log Data dialog box is sorted by Time Stamp, from oldest to most recent.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑37  Facility Log Data XE "Facility Log Data" \r "D2HBFacility_Log42"  Window

NOTE:
Facility Log Data list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear. 

NOTE:
The Search criteria displays the Log Type, Start Time, and Stop Time from the Log Data Request dialog box.

Table 3‑23  Facility Log Data Window Description 

	Label
	Component
	Purpose

	Facility Log Data
	Scroll list
	Displays a summary list entry for each briefing log  performed.

	Log Type
	Column
	Log type:  Contact, Preflight, Inflight, Flight Watch. 

	Time Stamp
	Column
	Time of action MM/DD/YY(HHMMSS).

	User ID
	Column
	Name of the user who logged the briefing. 

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules
	Column
	Flight Rules of the flight plan.  

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Flight Plan Type
	Column
	Domestic or ICAO.  

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	Type of Service
	Column
	The combinations of type of service logged:  Single Item, PWB, Multi Leg, Airport Advisory, Radio Contact, Aircraft Contact.

	Multi Legs
	Column
	The number of Multi Legs: 0 through 10.

	Type of Flight
	Column
	General Aviation, Military, Air Carrier or Air Taxi.

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Frequency 
	Column
	Radio frequency (0 to 7 alphanumerics, slashes, and/or periods).


To Retrieve Facility Log Data:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Facility Log Data menu option to display the Log Data Request dialog box.

4. Enter the requested information in the appropriate text boxes.  Press the Tab key to maneuver to the next text box.

5. <Select> Contact, Preflight, Inflight, Flight Watch or All radio buttons for selected data log types.

6. <Click> the OK button.  The Facility Log Data dialog box is displayed providing the requested information.  The search criteria entered in the Log Data Request dialog box will be displayed at the top of the Facility Log Data dialog box.   

3.3.2.4  XE "User Flight Activity" \r "D2HBUser_Flight_43" User Flight Activity (Flight Plan Menu/Retrieve)

The User Flight Activity menu option displays the User Flight Activity dialog box and provides the capability to retrieve all of the user’s flight activity for the current login session.  The User Flight Activity dialog box contains the Flight Data and Log Data tabbed pages which will display an entry for every action attempted on a flight plan(s) or an entry for every Preflight, Inflight, Flight Watch and Contact briefing successfully logged by the user, respectively.  There will usually be several entries associated with an Aircraft ID.

By default, both the Flight Data and Log Data tabbed pages of the User Flight Activity dialog box are sorted by Time Stamp, from oldest to most recent.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑38  User Flight Activity Window – Flight Data Tabbed Page

NOTE:
User Flight Activity Flight Data list and Log Data list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.

Table 3‑24  User Flight Activity Window – Flight Data Tabbed Page Description 

	Label
	Component
	Purpose

	Flight Data
	Tabbed Page
	Displays the user’s flight data activity for the current login session.

	User Action
	Column
	Action taken.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules
	Column
	Flight Rules of the flight plan.  

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD
	Column
	Estimated time of departure; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	ETA
	Column
	Estimated Time of Arrival; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59. 

	Origin
	Column
	Address of the facility responsible for the flight plan.

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Flight Plan Type
	Column
	Domestic or ICAO.  

	Time Stamp
	Column
	The time of action MM/DD/YY(HHMMSS).
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Figure 3‑39  User Flight Activity Window - Log Data Tabbed Page

Table 3‑25  User Flight Activity Window - Log Data Tabbed Page Description

	Label
	Component
	Purpose

	Log Data
	Tabbed Page
	The user’s contact/briefing log activity for the current login session.

	Log Type
	Column
	The log type:  Contact, Preflight, Inflight, Flight Watch, All.

	Time Stamp
	Column
	The time of action MM/DD/YY(HHMMSS).

	User ID
	Column
	User ID.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules
	Column
	Flight Rules of the flight plan. 

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Flight Plan Type
	Column
	Domestic or ICAO.  

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	Type of Service
	Column
	The combinations of type of service logged: Single Item, PWB, Multi Leg, Airport Advisory, Radio Contact, Aircraft Contact.

	Multi Legs
	Column
	The number of Multi Legs: 0 through 10

	Type of Flight
	Column
	General Aviation, Military, Air Carrier or Air Taxi

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Frequency
	Column
	Radio frequency (0 to 7 alphanumerics, slashes, and/or periods).


To Retrieve User Flight Activity Data:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the User Flight Activity menu option.  The User Flight Activity dialog box is displayed containing the Flight Data and the Log Data tabbed pages.

Table 3‑26  User Action Associated with Flight Data  Aircraft ID

	User Action
	Description

	Activate
	Flight plan activated. 

	Add Inbound
	Flight plan manually added to Inbound List

	Amend
	Flight plan amended.

	Cancel
	Flight plan cancelled.

	Change Type
	Flight plan type changed from Domestic to ICAO or ICAO to Domestic.

	Close
	Flight plan closed.

	Delete
	Prestored flight plan deleted.

	File
	Flight plan Filed.

	Prestore
	Flight plan prestored.

	Transfer Inbound
	Flight plan transferred from Inbound List to another facility.

	Transfer Proposed
	Flight plan transferred from Proposed List to another facility.

	Transfer Suspense
	Flight plan message transferred from Suspense List to another facility.

	Validate All
	All flight plan fields validated.

	Validate Route
	Flight plan route validated.


3.3.2.5 Partial Flight Plans (Flight Plan Menu/Retrieve)

The Partial Flight Plans  XE "FlightPlan:Retrieve" option displays the Partial Flight Plans dialog box which provides the capability to create partial or complete flight plans from data that has been saved by the user during the current logon session.  By default, the Partial Flight Plans dialog box is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑40  Partial Flight Plans Dialog Box

Table 3‑27  Partial Flight Plans Dialog Box Description 

	Label
	Component
	Purpose

	Partial Flight Plan
	Scroll List
	Displays a summary list entry for each partial flight plan that has been saved by the user during the current logon session.

	Delete Flight Plan
	Button
	Deletes the selected partial flight plan.

	Create Flight Plan
	Button
	Creates a flight plan from the selected entry and displays it within the appropriate ICAO or Domestic Flight Plan dialog box.


To Create a Flight Plan from a Partial Flight Plan XE "Flight Plan:Create" 

 XE "FlightPlan:Retrieve" :

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Partial Flight Plans menu option.  The Partial Flight Plan dialog box is displayed containing a (summary) list entry for each partial flight plan.

4. <Select> the desired partial flight plan list entry.

5. <Click> the Create Flight Plan button.  The information from the selected partial flight plan is displayed within the appropriate ICAO or Domestic Flight Plan window.

To Delete a Partial Flight Plan:

1. <Click> the Flight Plan menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Partial Flight Plan menu option.  The Partial Flight Plan dialog box is displayed containing a (summary) list entry for each partial flight plan.

4. <Select> the desired partial flight plan list entry.

5. <Click> the Delete Flight Plan button.  The selected partial flight plan is deleted.

3.3.3  XE "Preferred Route" \r "D2HBPreferred_Ro48" Preferred Route (Flight Plan Menu)

The Preferred Route menu option provides the capability to request a list of preferred routes for an IFR flight plan based on a departure and destination point.  Supplemental data may also be entered but is not required.  Upon successful completion, the preferred routes are retrieved and displayed within the Preferred Route dialog box and may be dragged into the Route text box of a Flight Plan window.  Preferred routes include FAA IFR low and high altitude routes, tower enroute control (TEC) routes, and southern California (SOCAL) routes.  The list of preferred routes may include routes that will not validate if used in a flight plan and will require correction by the specialist.  An attempt to manually enter a Preferred Route with an ICAO flight plan will result in a message box being displayed stating that Preferred Routes are not allowed for ICAO flight plans.

If a Flight Plan is currently open, certain fields (Aircraft ID,  Departure, Destination, Aircraft Type, Airspeed, ETD, and Enroute Altitude) within the Preferred Route dialog box will automatically be populated with the corresponding information from the current Flight Plan. 
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Figure 3‑41  Preferred Route Dialog Box

Table 3‑28  Preferred Route Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be a letter.

	Departure
	Text Box
	Enter the departure location.  LOCIDs are 2-5 characters.  

	Destination
	Text Box
	Enter the destination location.  LOCIDs are 2-5 characters.

	Supplemental Data
	Group Label
	Provides additional data regarding the aircraft and flight plan.

	Aircraft Type
	Text Box
	Enter the aircraft type: 2-9 alphanumeric characters with an optional prefix and/or suffix separated by “/”.

	Airspeed
	Text Box
	Enter the estimated airspeed.  2-4 numerics (knots/hr) or M + 3 numerics (mach speed) or SC (speed classified).

	ETD
	Text Box
	Enter the Estimated Time of Departure. [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Enroute Altitude
	Text Box
	Enter the Enroute Altitude.  2-7 alphanumeric characters.

	Preferred Routes
	Scroll list
	Displays a list of preferred routes.

	Use Route
	Button
	The selected route from the preferred list may be used in the associated Flight Plan window to be filed, activated, etc.

Preferred Routes are not allowed for ICAO Flight Plans.

	Retrieve Routes
	Button
	Displays routes in the Preferred Routes  scroll list that match with the entered Departure and Destination.


To Retrieve a List of Preferred Routes:

1.
<Click> the Flight Plan XE "Flight Plan:Preferred" 

 XE "FlightPlan:Retrieve"  menu.

2.
<Select> the Preferred Route menu option to display the Preferred Route dialog box.

3.
Enter the requested information in the appropriate text boxes.

4.
<Click> the Retrieve Routes button to retrieve a list of preferred routes that match the departure and destination entered.  The preferred routes are displayed within the Preferred Routes scroll list. 

5.
The route may be dragged into the Route text box of any Domestic Flight Plan window. 


OR 

6.
<Click> the Use Route button to place the highlighted route(s) into the Route text box of the associated Domestic Flight Plan window. 

NOTE:   The Preferred Routes capability is disabled for ICAO Flight Plans.

3.3.4 Preferred Route – Drag-And-Drop Route

The Preferred Route Drag-And-Drop feature enables the selected route to be utilized by the opened Domestic Flight Plan.  To use this feature, position the mouse over the route to be utilized in the Preferred Route window.  Press and hold down the left mouse button, and move the mouse towards the Domestic Flight Plan.  The mouse cursor will change to a circle with a slash (Invalid Drag Symbol).  This indicates that the mouse is in an invalid position for the route to be dragged to.  Once the pointer appears with the plus sign, release the left mouse button.  The selected route will be displayed in the Domestic Flight Plan’s Route text box.  To cancel a drag-and-drop operation once it is started, place the mouse cursor over the Preferred Route window and release the mouse button, or position the cursor over an invalid location and release the mouse button.
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Figure 3‑42  The Mouse Cursor Changed to the Invalid Drag Symbol
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Figure 3‑43  The Mouse Cursor Changed to a Pointer with the Plus Sign

3.3.5  XE "Flight Workspace" \r "D2HBFlight_Works51" 

 XE "Flight Plan:Menu" Flight Workspace (Flight Plan Menu)

The Flight Workspace menu option provides the ability to manage multiple flight plan activities.  Multiple workspaces allow the user to work on various tasks simultaneously.  A Flight Plan, General Facility Message XE "Facility Message:General"  or Inbound Flight can be created from the current data on the Flight Workspace. A new workspace can be created by dragging and dropping an Inbound, Contact, or Proposed List XE "Proposed List"  item onto a flight workspace.  The following operations are available:  perform a route briefing, perform an area briefing based on the departure or destination, log the briefing, view the Contact List,  view a flight profile for a route, or retrieve a flight plan based on the Aircraft ID. The OASIS provides for the displaying of five (5) workspaces, with up to 10 tabbed pages on each workspace.  The flight workspace contents are automatically stored locally on  the workstation and will be re-populated  the next time the workstation is logged onto.  In addition, any flight workspaces that are open at WINGS exit/logoff will be re-opened the next time any user with the capability to access the flight workspaces logs in to WINGS.
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Figure 3‑44  Flight Workspace Dialog Box

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

Table 3‑29  Flight Workspace Dialog Box Description 

	Label
	Component
	Purpose

	Workspace Type
	Text Box
	Enter user defined workspace name.  0-15 alphanumeric characters

	Free Text
	Text Box
	Enter additional comments.

	Aircraft ID
	Text Box
	Enter the 2 - 7 characters, A/N Aircraft Identification.  The first character must be a letter.

	Flight Information
	Group Label
	Enter information regarding the aircraft and flight plan.

	Aircraft Type
	Text Box
	Enter the aircraft type. Domestic: 2-9 alphanumeric characters with an optional prefix and/or suffix separated by “/”.  ICAO: 2-4 alphanumeric characters.

	Departure/ Location
	Text Box
	Enter the departure location.  Domestic: 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.  ICAO: 4 character LOCID.

	Area Briefing (Departure )
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box. If a field is invalid, then an error is displayed.  If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Destination
	Text Box
	Enter the destination location. Domestic: 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.  ICAO: 4 character LOCID.

	Area Briefing (Destination)
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box. If a field is invalid, then an error is displayed.  If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Route
	Text Box
	Enter planned route, 0-558 characters.

	Enroute Altitude
	Text Box
	Enter  the planned altitude.  Domestic:  2-7 alphanumeric characters.  ICAO:  F/A + 3 numerics or S/M + 4 numerics.

	ETD
	Text Box
	Enter the Estimated Time of Departure;  [dd]hhmm : dd = 01-31, hh = 00 - 23,  mm = 00 –59

	ETA
	Text Box
	Enter the Estimated Time of Arrival;  [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00 -59

	Remarks
	Text Box
	Enter any desired remarks.  Domestic: 0-325 characters.   ICAO:  1-325 characters.

	Flight Plan Type
	Drop-down List Box
	Choose which type of Flight Plan [Domestic or ICAO]. 

	Flight Rules
	Drop-down List Box
	Choose the type of Flight Rules.  

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, DVFR STOPOVER.  ICAO:  VFR, IFR, VFR/IFR, IFR/VFR.

	Airspeed
	Text Box
	Enter the estimated airspeed.  Domestic:  2-4 numerics (knots/hr) or M + 3 numerics (mach speed) or SC (speed classified).  ICAO: M + 3 numerics (mach speed), or N + 4 numerics (knots/hr), or K + 4 numerics (km/hr).

	Frequency
	Text Box
	Enter the Radio frequency (0-7 alphanumerics, slashes, and/or periods).

	Default values from the Flight Information Area
	Check Box
	When checked, the default values for a Route Briefing, Flight Plan, General Facility message and Briefing Log will be taken from the Flight Information section of the Flight Workspace dialog box.  When unchecked, the default values, when available, will be taken from the Free Text area of the Flight Workspace dialog box.  Example:  AI:  N1234C.  N1234C would become the default value in the Aircraft ID field.

	Free Text
	Text Window
	Enter notes or a free format flight plan using a series of two-character identifiers to represent each flight plan field.  Each two-character identifier is followed by a colon, followed by a value for the flight plan field.   Example:  AI: N1234C.  Refer to the Appendix of Flight Plan Field Identifiers for a list of the available two-character identifiers.

	Briefing Log
	Button
	Opens the Briefing Log dialog box.  Defaulted with values from Flight Workspace. 

	Create Flight Plan
	Button
	Opens the selected Flight Plan dialog box, Domestic or ICAO.  Defaulted with values from Flight Workspace.

	Retrieve Flight Plan
	Button
	Displays the Flight Plan dialog box for the current Aircraft ID.   

	Route Briefing
	Button
	Requests a Route Briefing without displaying the Route Briefing dialog box. If a field is invalid, then an error is displayed. If a field is missing, the Route Briefing form is displayed with the cursor placed in the missing field.

	Contact List
	Button
	Displays the Contact List dialog box.

	General Facility Msg
	Button
	Displays the Transmit General Facility message dialog box.  Defaulted with values from Flight Workspace.

	Add Inbound Entry
	Button
	Adds the flight plan to the Inbound List if the Flight Plan Type, Flight Rules, Aircraft ID, Destination, and ETA have been entered.  Otherwise, displays the Add Inbound Entry dialog box,  defaulted with values from the Flight Workspace.  See the Inbound (List Menu) section for more information on the Add Inbound Entry dialog box.

	New Workspace
	Button
	Creates a new Aircraft ID tabbed page

	Remove Workspace
	Button
	Deletes the active workspace tabbed page (one page will always remain open)

	Clear Fields
	Button
	Clears text from all edit fields in the current workspace tabbed page.

	Flight Profile 

(Bi-Plane Graphic)
	Button
	Provides a cross sectional view of the route of flight from the departure point to the destination.  This cross sectional view is displayed in the Weather Graphics Window.  Also includes alphanumeric briefing data for the route, corresponding to a Standard Route Briefing.


To Access A Flight Workspace Window:

1. <Click> the Flight Plan menu.

2. <Select> the Flight Workspace menu option to display the Flight Workspace window list.

3. <Select> the desired Flight Workspace window option to display the Flight Workspace dialog box.
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Figure 3‑45  Flight Workspace Submenu

To Add an Additional Workspace Tabbed Page:

1. <Click> the New Workspace Button.

To Remove a Workspace Tabbed Page:

This procedure assumes that additional workspace tabbed pages have already been created.

1. <Click> the Remove Workspace button.  The current workspace tabbed page is removed.

To Close a Flight Workspace Window:

1. <Select> the workspace window to be closed.

2. <Click>  the Close button on the active workspace.  The selected workspace window will be closed and the data will be stored locally on the workstation.

3.3.6 Flight Workspace Drag and Drop Feature

A Flight Workspace with less than ten pages can have an Inbound, Contact, or Proposed List XE "Proposed List"  item dragged and dropped anywhere on the workspace to have a new page added and filled with the information from the list item’s flight plan.  To use this feature, position the mouse over the list item to be dragged.  Press and hold down the left mouse button, and move the mouse towards the workspace.  The mouse cursor will change to a pointer with a plus icon under it indicating the copying of a list item to a new location. If a circle with a slash appears while dragging the list item (Invalid Drag Symbol),  the mouse is in an invalid position for the list item to be dragged to.  Once over the desired flight workspace, release the left mouse button.  A new page will be added to the workspace.   If a list item is dropped onto a workspace that already has ten pages, the operation will fail and an error message is displayed.  To cancel a drag operation once it is started, place the mouse cursor over the original location and release the mouse button, or position the cursor over an invalid location and release the mouse button.

3.3.7 Flight Workspace Drag-A-Tab Feature

The Flight Workspace Drag-A-Tab feature enables the Flight Workspace property pages to be organized in any order.  To use this feature, position the mouse over the tab to be moved.  Press and hold down the left mouse button, and move the mouse towards the desired position.  The mouse cursor will change to a pointer with a tab page icon under it indicating the moving of a page to a new location.  A red bar will appear as the mouse is moved to indicate where the page will be inserted.  If a red circle with a slash appears under the mouse cursor (Invalid Drag Symbol),  the mouse is in an invalid position for the page to be dragged to.  Once the red bar appears where the page should be moved to, release the left mouse button.  The page will be moved to the new location and brought to focus.   If a page is dragged from the bottom row to the top row, the rows will be swapped when the page is brought into focus.  To cancel a drag operation once it is started, place the mouse cursor over the original location and release the mouse button, or position the cursor over an invalid location and release the mouse button.
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Figure 3‑46  The Mouse Cursor Changed to a Pointer with a Tab Page Icon
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Figure 3‑47  The Mouse Cursor Changed to a Pointer with a Tab Page Icon Overlaid with the Invalid Drag Symbol

To Move a Flight Workspace Tab Page:

1. <Select> the workspace tabbed page to be moved.

2. <Click> and <Hold> the mouse button down over the workspace tabbed page and move the mouse cursor to the new desired location.  The mouse cursor will change to a pointer with a tabbed page under it indicating the user is dragging a page to a new location.

3. <Release> the mouse button at the new location where the red bar appears.  The workspace tabbed page will be moved to the new location and brought into focus.

THIS PAGE INTENTIONALLY LEFT BLANK
3.4  XE "Prestored Flight" Prestored Flight

The Prestored Flight menu provides the capability to create and retrieve a Domestic or an ICAO prestored flight plan. XE "Flight Plan:Dialog Box" 

 XE "Flight Plan:Create"  A prestored flight plan may be scheduled or unscheduled.  An unscheduled prestored flight plan may be retrieved and filed on user demand.  A scheduled prestored flight plan will be automatically filed by the system a number of minutes prior to the ETD.
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Figure 3‑48  Prestored Flight Menu

To Display the Prestored Flight Menu:

1. <Click> the Prestored Flight menu.

3.4.1 Create (Prestored Flight Menu)

The Create menu option XE "Create Flight Plan"  provides the capability to create a Domestic or an ICAO prestored flight plan for any user with "create prestored" flight plan capabilities.  Selecting either the Domestic or ICAO option displays the respective Flight Plan dialog box.  Up to five Flight Plan dialog boxes may be open concurrently.  The title bar of each Flight Plan dialog box displays the Aircraft ID of the flight plan.  
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Figure 3‑49  Create (Prestored) Submenu

To Display the Create Sub-menu:

1. <Click> the Prestored Flight menu.

2. <Select> the Create menu option to display the Create sub-menu.

3.4.1.1 Prestored Domestic Flight Plan Dialog Box – Flight Information

The Prestored Domestic Flight Plan dialog box is used when creating a Prestored Domestic Flight Plan.  It provides the capability to File, Amend, Store, Delete, Save Partial, Clear Fields, Change Type, and Validate All.   The available route functions include Route Override, Validate, Preferred, and Route Briefing XE "Route Briefing" 

 XE "Briefing"  on the Flight Information tabbed page. Departure and Destination Area Briefings are also available on the Flight Information tabbed page.   A Prestored Domestic Flight Plan may be changed to a Prestored ICAO Flight Plan and vice versa via the Change Type function.   A user must validate or amend the flight plan after conversion to save the changes.  After the flight plan is validated, the Route Overlay XE "Overlay:Route"  button becomes active.  The Flight Profile button accesses a cross-sectional view of the route of flight.
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Figure 3‑50  Prestored Domestic Flight Plan XE "Flight Plan:Dialog Box"  Dialog Box  - Flight Information Tabbed Page

Table 3‑30  Prestored Domestic and Prestored ICAO Flight Plan Dialog Boxes 

	Label
	Component
	Purpose

	Validate All
	Button
	Attempts to validate both the route and the Flight Plan information.  Upon successful validation, output routing, closure points and ETA are returned.  Use of this option allows a user to add additional closure points or override automatic addressing before filing the flight plan.

	File
	Button
	Attempts to file a flight plan.  The flight plan will be validated and filed and placed on the proposed list until activation (transmit time) or cancellation.  The Prestored Domestic or ICAO Flight Plan dialog box is closed and the flight plan is returned in the standard Domestic or ICAO Flight Plan dialog box.

	Amend
	Button
	Attempts to validate the amended flight plan information.  Upon successful validation, the amended flight plan is returned with output routing, closure points and ETA included.

	Store
	Button
	Attempts to validate and store the current open flight plan.  Upon successful validation, the flight plan is returned with output routing, closure points and ETA included as requested.

	Delete
	Button
	Removes the prestored flight plan from the system (and returns a confirmation message if successful).  Otherwise, an appropriate response message is returned stating the status of the attempted deletion.

	Save Partial
	Button
	Saves a partial or incomplete flight plan for retrieval processing at a later time during the duration of the user’s logon session.

	Clear Fields
	Button
	Clears the fields within the current Flight Plan window.

	Change Type
	Button
	Changes a flight plan from ICAO to Domestic or changes a flight plan from Domestic to ICAO, on either current or prestored flight plans. 

	Area Briefing (Departure)
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box. If a field is invalid, then an error is displayed. If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Area Briefing
(Destination)
	Button
	Requests an Area Briefing without displaying the Area Briefing dialog box. If a field is invalid, then an error is displayed. If a field is missing, the Area Briefing form is displayed with the cursor placed in the missing field.

	Validate
	Button
	Attempts to validate the Flight Plan route.

	Preferred
	Button
	Requests a Preferred Route without displaying the Preferred Route dialog box. If a field is invalid, then an error is displayed. If a field is missing, the Preferred Route form is displayed with the cursor placed in the missing field.  Preferred Routes are not allowed for ICAO Flight Plans.

	Route Briefing
	
	Requests a Route Briefing without displaying the Route Briefing dialog box. If a field is invalid, then an error is displayed. If a field is missing, the Route Briefing form is displayed with the cursor placed in the missing field. 

	Flight Profile (Bi-Plane Graphic)
	Button
	Provides a cross sectional view of the route of flight from the departure point to the destination.  This cross sectional view is displayed in the Weather Graphics Window.  Also includes alphanumeric briefing data for the route, corresponding to a Standard Route Briefing.

	Route Overlay  (World Graphic)
	Button
	Becomes active (colored and orbiting) when a flight plan is Validated with the appropriate plan information.  Route coordinates can then be overlaid onto a product in the Weather Graphics window.  Click on the active world graphic to overlay route information graphically onto a Weather Graphics product.


The Route Overlay feature becomes active (colored and orbiting) when a flight plan is Validated with the appropriate information.  Flight Profile offers a cross-sectional view of the route of flight from the departure point to the destination.

NOTE:
Refer to the Domestic Flight Plan dialog box – Flight Information Tabbed Page Description for a description of the fields contained on the Prestored Domestic Flight Plan Flight Information tabbed page.

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

To Create a Prestored Domestic Flight Plan:

1. <Click> the Prestored Flight XE "Prestored Flight"  menu.

2. <Select> the Create menu option XE "Create Flight Plan"  to display the Create sub-menu.

3. <Select> the Domestic menu option.  

4. Enter the requested information into the appropriate fields and text boxes within the tabbed pages. 

5. <Click> the desired action button located at the bottom of the dialog box to create the flight plan (File, Amend, Store, etc.).

3.4.1.2 Prestored ICAO Flight Plan Dialog Box – Flight Information

The Prestored ICAO Flight Plan dialog box is used when creating a Prestored ICAO Flight Plan.  It provides the capability to File,  Amend, Store, Delete, Save Partial, Clear Fields, Change Type, and Validate All.   The available route functions include Route Override, Validate, and Route Briefing XE "Route Briefing" 

 XE "Briefing"  on the Flight Information tabbed page. Departure and Destination Area Briefings are also available on the Flight Information tabbed page.   A Prestored ICAO Flight Plan may be changed to a Prestored Domestic Flight Plan and vice versa via the Change Type function.   A user must validate or amend the flight plan after conversion to save the changes.  After the flight plan is validated, the Route Overlay XE "Overlay:Route"  button becomes active.  The Flight Profile button accesses a cross-sectional view of the route of flight.
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Figure 3‑51  Prestored ICAO Flight Plan Dialog Box - Flight Information Tabbed Page

NOTE:
Refer to the ICAO Flight Plan dialog box – Flight Information Tabbed Page Description for a description of the fields contained on the Prestored ICAO Flight Plan Flight Information tabbed page.

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through he fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

NOTE:  The Preferred Routes capability is disabled for ICAO Flight Plans.

To Create a Prestored ICAO Flight Plan: XE "Flight Plan:Create" 
1. <Click>  the Prestored Flight XE "Prestored Flight" \r "D2HBPrestored_Fl62"  menu.

2. <Select> the Create menu option XE "Create Flight Plan"  to display the Create sub-menu.

3. <Select> the ICAO menu option.  

4. Enter  the requested information into the appropriate fields and text boxes within the tabbed pages. 

5. <Click>  the desired action button located at the bottom of the dialog box to create the flight plan (File, Amend, Store, etc.).

3.4.1.3 Schedule Information

The Schedule Information tabbed page is used when creating a Prestored Domestic or Prestored ICAO flight plan.  This screen allows the user to schedule recurring flight plans on a weekly or monthly basis.  The flight plan will be scheduled to depart at the hour and minute specified in the ETD field on the Flight Information page, and the day of the week or month specified in the Schedule Information page.

A scheduled prestored flight plan is scheduled for the time entered in the Schedule Time fields.  After the Valid To time has been exceeded, the scheduled prestored flight plan becomes unscheduled automatically.
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Figure 3‑52  Prestored Flight Plan Dialog Box –  Domestic and ICAO Schedule Information Tabbed Page

NOTE:
Use the Tab or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

Table 3‑31  Prestored Flight Plan XE "Flight Plan:Dialog Box" 

 XE "FlightPlan:Retrieve"  Dialog Box – Domestic and ICAO Schedule Information Tabbed Page Description 

	Label
	Component Type
	Purpose

	Schedule Time
	Group Label
	Enter Valid From and Valid To times.

	Valid From
	Text Box
	Enter the starting date for the period of scheduling, mm/dd/yyyy.

mm = 01-12

dd = 01-31

yyyy = 1970-2037

	Valid To
	Text Box
	Enter the ending date for the period of scheduling, mm/dd/yyyy.

mm = 01-12

dd = 01-31

yyyy = 1970-2037

	Schedule Type
	Group Label
	Select the check box to choose the schedule type, Weekly or Monthly.

	Days of Week
	Group Label
	Select the check box to choose the day(s) of the week the schedule is in effect.  

	Days of Month
	Group Label
	Select the check box to choose the day(s) of the month the schedule is in effect.  


3.4.2 Retrieve (Prestored Flight Menu)

The Retrieve menu option provides the capability to retrieve a single or multiple prestored flight plan(s) from the FDS. XE "Flight Data Server" \r "D2HBFDS63" 
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Figure 3‑53  Retrieve (Prestored) Submenu 

To Display the Retrieve Sub-menu:

1. <Click> the Prestored Flight menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3.4.2.1 Prestored Plan (Prestored Flight Menu/Retrieve)

The Prestored Plan option allows the user to retrieve prestored flight plan(s) from the FDS that match the Aircraft ID.  The Prestored Plan menu option displays the Prestored Flight Plan dialog box.
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Figure 3‑54  Prestored Flight Plan XE "Flight Plan:Dialog Box" 

 XE "FlightPlan:Retrieve"  Dialog Box

NOTE:
An “*” or a “?” can be used as a wildcard character to search the database for a flight list of similar IDs.  An “*” represents 0 to many characters that should be matched; a “?” represents a single character that should be matched.  For example, “N*” will generate a list of flight plans with N as the first character and any number of characters to follow.

Table 3‑32  Prestored Flight Plan Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification number, 2-7 alphanumeric characters.  The wildcard characters ‘*’ and ‘?’ may also be used.  The ‘*’ character must be used with at least 1 more characters not including the ‘?’ character.

	OK
	Button
	The FDS will attempt to retrieve all prestored flight plans with a matching Aircraft ID.  If a single flight plan is found it is returned within the appropriate Prestored Domestic or ICAO Flight Plan window.  If multiple flight plans are found they are returned within the Prestored Flight Data dialog box.


The Prestored Flight Data dialog box displays all of the prestored flight plans that match the Aircraft ID or wildcard characters entered.  By default, the Prestored Flight Data dialog box is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑55  Prestored Flight Data Dialog Box (Multiple Listing of Same Aircraft ID)

To Retrieve a Prestored Flight Plan: XE "Flight Plan:Dialog Box" 

 XE "FlightPlan:Retrieve" 
1. <Click>  the Prestored Flight menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Prestored Plan menu option to display the Prestored Flight Plan Request dialog box.

4. Enter  the Aircraft ID into the appropriate field.

5. <Click>  the OK button.  The FDS will attempt to retrieve all prestored flight plans with a matching Aircraft ID.  If a single flight plan is found, it is returned within the appropriate Prestored Domestic or Prestored ICAO Flight Plan window.  If multiple flight plans are found, they are returned within the Prestored Flight Data dialog box.

6. When multiple flight plans are returned, <Select> the desired prestored entry from the Prestored Flight Data dialog box and <Click> the Retrieve Flight Plan button.  The flight plan is returned within the appropriate Prestored Domestic or Prestored ICAO Flight Plan window.

3.4.2.2 Prestored Data (Prestored Flight Menu/Retrieve)

The Prestored Data option allows the user to retrieve all of the prestored flight plans from the FDS.  The Prestored Data menu option displays the Prestored Flight Data dialog box.  The Flight Status field will indicate if the prestored flight plan is scheduled or unscheduled.  By default, the Prestored Flight Data dialog box is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.

NOTE:
The Prestored Flight Data list will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text.
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Figure 3‑56  Prestored Flight Data Dialog Box 

Table 3‑33  Prestored Flight Data Dialog Box Description 

	Label
	Component
	Purpose

	Prestored Flight Data
	Scroll list
	Displays a summary list entry for each prestored flight plan retrieved.

	Aircraft ID 
	Column
	Aircraft Identification.  2-7 A/N characters.

	Flight Rules 
	Column
	Flight rules of the flight plan.

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR.

	Aircraft Type 
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure 
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination 
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD 
	Column
	Estimated Time of Departure ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	ETA 
	Column
	Estimated Time of Arrival ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Origin 
	Column
	Address of the facility responsible for the flight plan.

	Remarks 
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Flight Plan Type 
	Column
	Domestic or ICAO.  

	Flight Status 
	Column
	Status of the flight plan.

	Retrieve Flight Plan
	Button
	Opens the selected (highlighted) prestored flight plan and displays it within the appropriate Prestored ICAO or Domestic Flight Plan window.


Table 3‑34  Flight Status Values Associated with Prestored Flight Data

	Flight Status 
	Description

	SCHEDULED_PRESTORED 
	Prestored with a schedule.

	UNSCHEDULED_PRESTORED 
	Prestored without a schedule.


To Retrieve a List of All Prestored Flight Plans XE "FlightPlan:Retrieve" :

1. <Click>  the Prestored Flight menu.

2. <Select> the Retrieve menu option to display the Retrieve sub-menu.

3. <Select> the Prestored Data menu option.  The Prestored Flight Data dialog box is displayed containing a (summary) list entry for all prestored flight plans.

4. <Select> the desired prestored flight plan list entry.

5. <Click>  the Retrieve Flight Plan button.  The selected prestored flight plan is displayed within the appropriate Prestored ICAO or Prestored Domestic Flight Plan window.

3.5  XE "Briefing" \r "D2HBBriefing67" Briefing

The Briefing menu provides the ability to perform area, region, route, and selected location weather briefings.  The Briefing menu also provides the capability to view sequence definitions, log a briefing, set up options for auto updates, and view the auto update list.
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Figure 3‑57  Briefing Menu

To Display the Briefing Menu:

1. <Click> the Briefing menu.

3.5.1 Types of Weather Briefings

From the Briefing menu, alphanumeric weather data and aeronautical reports XE "Reports" \r "D2HBReports67"  for a specified route, area, region, or selected location can be displayed.  Different weather and aeronautical reports are displayed based on the type of weather briefing requested.  Types of Area, Region XE "Region" \r "D2HBRegion68"  and Route weather briefings include Standard, Outlook, Trend, and Selected (user defined).

Standard Weather Briefing

The types of weather and aeronautical reports displayed in a Standard Briefing are: AC, WW, WH, WS, WST, CWA, WA, METAR, UA, SD, FA, TAF, FD, TFR, NO, FDC, Gen. FDC, ATCSCC, and SUA.  The latest METARs, TAFs, and NOTAMs XE "NOTAM"  are provided for the selected briefing area (area, region, or route).  When current weather is unavailable for the departure, destination, or alternate destination, the system will output the current hourly METAR and subsequent SPECIs for the nearest location.  The system will also output the terminal forecast for the nearest location if it is within 5 miles of the requested location.

General NOTAMs and FDC location NOTAMS will be retrieved based on affected location inside the briefing area.  FDC ARTCC NOTAMs will be retrieved based on ARTCC boundaries which penetrate the briefing area.  FDC NOTAMs that contain Temporary Flight Restrictions (TFRs) will be displayed separately, before all other FDC NOTAMs.

PIREPs within the route, area, or region for the last 95 minutes will be provided.

FDs, SDs, ATC delays, and adverse weather pertinent to the area, region, or route will be provided.

FAs affecting the route or area will be provided.

The OASIS interpolates flight level winds between forecast altitudes for FD reporting stations along the route corridor. 

The forecast winds aloft displayed includes all reported low level winds from 3000 feet to 39,000 feet and the interpolated winds for the selected altitude if the selected altitude is not one of the forecasted levels.  Additionally, when the requested altitude is FL180 or greater, the high level winds from 45,000 feet to 54,000 feet are also displayed.  If no altitude is entered, no interpolation is performed and all relevant FDs are displayed.  The following are special altitude cases:

· Blocked altitudes [dddBddd]:  Will not be interpolated.  The high altitude winds will be given if either of the altitudes is FL180 or greater.  

· CVF/ddd, VFR/ddd, ABV/ddd, OTP/ddd:  The high altitude winds will be given  if the ddd is FL 180 or greater.

· VFR, OTP:  Will not be interpolated.    

· ICAO Altitudes [Fddd Addd    Sdddd  Mdddd]:  Will interpolate if the altitude, or converted altitude for Sdddd/Mdddd,  is not a standard altitude.  The high altitude winds will be given if the effective altitude is FL 180 or greater.

Outlook Weather Briefing

The types of weather and aeronautical reports displayed in an Area, Route, or Region Outlook Briefing are forecast, outlook, and adverse weather products, including: AC, CWA, FA, FD, TAF, WA, WH, WW, WS, and WST.  

Trend Weather Briefing

The types of weather and aeronautical reports displayed in a Trend Briefing are the last three hours of METARs, the specials for the time period defined by the SPECI parameter, the last hour of UA, and the current TAF.  The most current reports, including specials, will appear before the older reports.

Selected Weather Briefing

The types of weather and aeronautical reports displayed for a Selected Briefing varies upon user selection.   When Selected is chosen as the Briefing Type for an Area, Region, or Route briefing, the Report Types dialog box is automatically displayed.  The Report Types dialog box allows the user to select the types of alphanumeric weather and aeronautical reports displayed for a Selected Weather Briefing.  By choosing Selected as the Briefing Type, users may essentially define their own briefing type.
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Figure 3‑58  Report Types Dialog Box

Table 3‑35  Report Types Dialog Box Description 

	Label
	Component
	Purpose

	Format
	Group Label
	Defines the types of report formats.

	
	Regular
	Displays Abbreviated report format.

	
	Expanded
	Displays Expanded report format.

	
	Both
	Displays Abbreviated and Expanded report format.

	Current Reports
	Group Label
	Defines current weather products.

	
	METAR
	Selects Aviation Routine Weather Reports.

	
	TW
	Selects Trend Weather Report (last three hours of METARs).

	
	SD
	Selects Radar Weather Reports.

	
	UA
	Selects Pilot Reports.

	
	NO
	Selects NOTAMs.

	
	FDC
	Selects FDC NOTAMs (including General FDC NOTAMs and TFR FDC NOTAMs).

	Warnings
	Group Label
	Defines weather-warning products.

	
	WA
	Selects AIRMET Reports.

	
	WH
	Selects Hurricane Advisories.

	
	WS 
	Selects SIGMET Reports. 

	
	WST
	Selects Convective SIGMET Reports.

	
	WW 
	Selects Severe Weather Watch Bulletins (WWs) and Alert Messages (AWWs).

	Forecasts
	Group Label
	Defines weather forecast products.

	
	FA
	Selects Area Forecast Reports.

	
	FD
	Selects Winds and Temperatures Aloft Reports.

	
	TAF
	Selects Terminal Aviation Forecast Reports.

	Aeronautical
	Group Label
	Defines aeronautical products.

	
	ATCSCC
	Selects Air Traffic Control System Command Center Messages.

	
	SUA 
	Selects Special Use Airspace Conflicts.

	Active SUA
	Group Label
	Defines non-published Special Use Airspace messages.

	
	IR
	Selects IFR Military Trai XE "Military Training Route" ning Routes.

	
	VR
	Selects VFR Military Training Routes.

	
	MOA
	Selects Military Operations Area Messages.

	Other
	Group Label
	Defines other weather products.

	
	AC
	Selects Convective Outlook Reports.

	
	CWA
	Selects Center Weather Advisory Reports.

	
	SYNS
	Selects TWEB Synopsis Products. (Not currently available for Area, region or Route Briefings).

	
	TWEB
	Selects Transcribed Weather Broadcasts. (Not currently available for Area, Region XE "Region"  or Route Briefings).

	International Weather 
	ICAOWX Check Box
	Selects International Weather Reports. (Not currently available for Area, Region, or Route Briefings).

	Select All
	Button
	Selects all of the currently available listed reports to be included in a Selected Weather Briefing.

	OK
	Button
	Activates the selected options.


To Define a Selected Weather Briefing:

1. <Click> the Briefing menu.

2. <Select> the Area, Region, or Route menu option to display the appropriate Briefing Request dialog box.

3. <Click> on the Selected option from the Briefing Type drop-down list box to display the Report Types dialog box.

4. <Click> either the Regular, Expanded, or Both radio button to select the desired report type format.  The radio button is filled.

5. <Click> the desired check boxes or <Click> the Select All button to specify which weather and aeronautical reports are to be received in the briefing.  A check mark appears within the check box for each report requested.

6. <Click> the OK button.  This defines the alphanumeric weather and aeronautical products to be retrieved for the Selected Briefing and returns to the originating Briefing Request dialog box (Area, Region, or Route).

3.5.2 Area (Briefing Menu)

The Area menu option displays the Area Briefing dialog box, which provides for the display of weather data and aeronautical reports for a specified area.

The Area Briefing dialog box can also be accessed from the Flight Plan dialog box or the Flight Workspace XE "Flight Workspace" \r "D2HBFlight_Works71"  dialog box using the Area Briefing button corresponding to the Departure or Destination fields.  The selection of the Area menu option will cause the Area Briefing dialog box to be displayed.  The selection of the Area Briefing button from the Flight Plan or Flight Workspace will automatically request an Area Briefing if all fields are valid and present. If a field is invalid, then an error message is displayed. If a field is missing, the form is displayed with the cursor placed in the missing field.  If a Flight Plan or Flight Workspace is currently open, certain fields (Aircraft ID, ETD, Time Enroute, Flight Plan Type, and Flight Rules ) within the Area Briefing XE "Briefing" \r "D2HBBriefing71"  dialog box will automatically be populated with the corresponding information from the current Flight Plan or Flight Workspace.  The user can change all default values to request a briefing on any area desired.  The Area Radius, SUA Radius, and SPECI Time Interval fields use the default values found on the User Parameters XE "User Parameters"  dialog box located under the Status Menu.  The Winds Aloft Radius field uses half the default value of the Winds Aloft Corridor found on the User Parameters dialog box.

Selecting the SUA Conflicts check box will cause the system to automatically compare active and published SUA data for area and time overlap and display the conflicts in the SUA tabbed page of the Weather and Aeronautical Briefing window.  The conflict data consists of the active SUA data followed by an abbreviated version of the published data relevant to the area.  A Facility Parameter called SUA Extra is used to calculate the block of time to be used for the time period of the flight.  The value of the SUA Extra parameter in minutes is subtracted from the ETD and added to ETA to create an extra buffer of time on either side of the time enroute of the flight in order to determine the time overlap.

TFRs, NOTAMs XE "NOTAM"  and FDC NOTAMs are retrieved by Affected Facility and are displayed in the following order: 

· Affected Facility that matches the LOCID requested

· Affected Facility that is within the area requested, from the center outward

· Affected Facility that is an ARTCC which intersects the area requested

· Other pertinent NOTAMs, such as LRN or GPS NOTAMs (not applicable for FDC NOTAMs)

NOTE:
Within the categories listed, entries are sorted alphabetically by Affected Facility, then by NOTAM number.

Once the briefing request is submitted, the results are displayed in the Weather and Aeronautical Briefing Window.
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Figure 3‑59  Area Briefing Dialog Box

Table 3‑36  Area Briefing Dialog Box Description 

	Label
	Component
	Purpose

	Briefing Type
	Drop-down List Box
	Displays the selected type of weather briefing from the list of available types including: Standard, Outlook, Trend, and Selected.  When the user chooses “Selected”, the Report Types button is enabled and the Report Types dialog box is displayed.

	Aircraft ID
	Text Box
	Enter 2 - 7 alphanumeric characters for the Aircraft Identification.  The first character must be a letter.

	ETD
	Text Box
	Enter the 4 – 6 digit Estimated Time of Departure [dd] hhmm: dd = 01-31, hh = 00-23, mm = 00-59.

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	Area
	Text Box
	Enter the location.  Domestic: 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.  ICAO: 4 character LOCID.

	Area Radius
	Text Box
	Enter the radius of briefing area in NM, (10 - 300 NM in 5 NM increments).  The default value may be set on the User Parameter dialog box found under the Status Menu.

	Winds Aloft Radius
	Text Box
	Enter the Winds Aloft Radius in NM (50 - 300 NM in 25 NM increments). The default value may be set from the User Parameter dialog box under the Status Menu.

	SUA Radius
	Text Box
	Enter desired SUA Radius in nautical miles (5 – 50NM in 5 NM increments). The default value may be set on the User Parameter dialog box found under the Status Menu.

	SPECI Time Interval
	Text Box
	Enter SPECI Time Interval (number of minutes past the observation time, 60 – 180 minutes in 5-minute increments). The default value may be set on the User Parameter dialog box found under the Status Menu.

	Report Types
	Button
	Displays the Report Types dialog box when the Selected briefing type is selected.

	SUA Conflicts
	Check Box
	If selected, checks for Special Use Airspace conflicts.  Defaults to checked.

	Supplemental Data
	Group Label
	Enter additional data regarding the flight plan.

	Flight Plan Type
	Drop-down List box
	Choose which type of Flight Plan  [Domestic or ICAO ].

	Flight Rules
	Drop-down List box
	Choose the type of Flight Rules.

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	OK
	Button
	Activates the selected options.


To Request an Area Briefing:

1. <Click> the Briefing menu.

2. <Select> the Area menu option to display the Area Briefing dialog box

3. <Select> the desired Briefing Type from the drop-down list box.  The user selected Briefing Type is displayed.

4. Enter specific designations in the appropriate text boxes for options other than the default settings.

5. <Click> the OK button to validate all completed fields and submit the Area Briefing request for processing. The results will be displayed in the Weather and Aeronautical Briefing Window.

6. <Click> on the World Graphic (button) to overlay XE "Overlay:Route"  briefing area information graphically onto a Weather Graphics window.  The Area may be graphically depicted onto any Weather Graphics window that is setup for flight overlays.
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Figure 3‑60  Weather and Aeronautical Briefing Window

NOTE: 
When a Weather and Aeronautical Briefing window is printed, ALL tabbed pages will be printed!

All alphanumeric weather-briefing requests are returned to the specialist in the Weather and Aeronautical Briefing window.   A separate tabbed page is displayed for each weather product, providing an organized and readable format.    The original briefing request information, such as Aircraft ID, ETD, Time Enroute, and Area, is displayed at the bottom of the form for reference purposes.  When the Briefing Log (button) is selected, the applicable briefing request information is automatically populated into a Briefing Log dialog box.  The Weather and Aeronautical Briefing window closes once the Briefing Log window appears.  The World Graphic button on the Weather and Aeronautical Briefing window becomes active (colored) when Lat/Long information defining the area, region, route, or selected location briefing is available.  This information can be overlaid onto a Weather Graphics window by clicking on this graphic (button).

Text in any tabbed page of the Weather and Aeronautical Briefing window can be decoded as a LOCID, abbreviation, or SUA.  After selecting a piece of text, right click to display a pop-up menu with options to decode the currently selected text as a LOCID, abbreviation, or SUA.  See the Decode LOCIDs (Help Menu), Decode Abbreviations (Help Menu), and Decode SUAs (Help Menu) sections for more information on the data returned for any of these options.
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Figure 3‑61  Weather and Aeronautical Briefing Window Pop-up Menu
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Figure 3‑62  Weather and Aeronautical Briefing Window / FD Property Page

The FD page is available from the Weather and Aeronautical Briefing window. The header information for the currently displayed data is concurrently displayed in the top header window and is updated upon scrolling of data.

3.5.3  XE "Region" \r "D2HBRegion75" Region (Briefing Menu)

The Region menu option displays the Region Briefing dialog box, which provides for the display of weather data and aeronautical reports XE "Reports"  for a specified state.

If a Flight Plan XE "Flight Plan:Dialog Box"  or Flight Workspace XE "Flight Workspace"  is currently open, certain fields (Aircraft ID, ETD, Time Enroute, Flight Plan Type, and Flight Rules) within the Region Briefing dialog box will automatically be populated with the corresponding information from the current Flight Plan or Flight Workspace.  The user can change all default values to request a briefing on any region desired.   The SPECI Time Interval field uses the default value found on the User Parameters XE "User Parameters"  dialog box located under the Status Menu.  Once the briefing request is submitted the results are displayed in the Weather and Aeronautical Briefing Window.

TFRs, NOTAMs XE "NOTAM"  and FDC NOTAMs are retrieved by Affected Facility and are displayed in the following order:  

· Affected Facility that is within the region requested

· Affected Facility that is an ARTCC which intersects the region requested

· Other pertinent NOTAMs, such as LRN or GPS NOTAMs (not applicable for FDC NOTAMs)

NOTE:
Within the categories listed, entries are sorted alphabetically by Affected Facility, then by NOTAM number.
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Figure 3‑63  Region Briefing Dialog Box

Table 3‑37  Region Briefing Dialog Box Description 

	Label
	Component
	Purpose

	Briefing Type
	Drop-down List Box
	Displays the selected type of weather briefing from the list of available types including:  standard, outlook, trend, and selected.  When the user chooses “Selected”, the Report Types button is enabled and the Report Type dialog box is displayed.

	Aircraft ID
	Text Box
	Enter 2 - 7 alphanumeric characters for the Aircraft Identification.  The first character must be a letter.

	ETD
	Text Box
	Enter the 4 – 6 digit Estimated Time of Departure [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	State
	Text Box
	Enter the 2 character designated region or state for the requested briefing 

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	SPECI Time Interval
	Text Box
	Edit SPECI Time Interval (number of minutes past the observation time, 60 – 180 minutes in 5-minute increments). The default value may be set on the User Parameter dialog box found under the Status Menu.

	Report Types
	Button
	Displays the Report Types dialog box when the Selected briefing type is selected.

	Supplemental Data
	Group Label
	Enter additional data regarding the flight plan.

	Flight Plan Type
	Drop-down List box
	Choose which type of Flight Plan  [Domestic or ICAO].

	Flight Rules
	Drop-down List box
	Choose the type of Flight Rules.

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	OK
	Button
	Activates the selected options.


To Request a Region XE "Region"  Briefing:

1. <Click> the Briefing menu.

2. <Select> the Region menu option to display the Region Briefing dialog box.

3. <Select> the desired Briefing Type from the drop-down list box.  The user selected Briefing Type is displayed.

4. Enter the information in the appropriate text boxes to select options other than the default settings.

5. Enter the desired SPECI Time Interval if necessary, to modify the default value.

6. <Click> the OK button to validate all completed fields and submit the Region Briefing request for processing.  The results will be displayed in the Weather and Aeronautical Briefing Window.  

7. <Click> on the World Graphic (button) to overlay XE "Overlay:Route"  briefing region information graphically onto a Weather Graphics window.  The Region may be graphically depicted onto any Weather Graphics window that is setup for flight overlays.

3.5.4 Route (Briefing Menu)

The Route menu option displays the Route Briefing XE "Route Briefing" \r "D2HBRoute_Briefi76"  dialog box, which provides for the retrieval of weather data and aeronautical reports XE "Reports"  from the FDS XE "Flight Data Server"  for a specified route corridor.

METAR, TAF,  SD, and PIREP XE "PIREP"  products in a route briefing will be displayed in the following order: Departure Weather, Destination Weather, Alternate Destination, and Route Weather.

The Route Briefing dialog box can also be accessed from the Flight Plan XE "Flight Plan:Dialog Box"  dialog box or Flight Workspace XE "Flight Workspace"  dialog box using the Route Briefing button.  The selection of the Route menu option will cause the Route Briefing dialog box to be displayed.  The selection of the Route Briefing button from the Flight Plan or Flight Workspace will automatically request a Route Briefing if all fields are valid and present. If a field is invalid, then an error message is displayed. If a field is missing, the form is displayed with the cursor placed in the missing field.  If a Flight Plan or Flight Workspace is currently open, certain fields (Aircraft ID, ETD, Time Enroute, Departure, Destination, Enroute Altitude, First Alternate Airport, Second Alternate Airport, Route of flight, Flight Plan Type, and Flight Rules) within the Route Briefing dialog box will automatically be populated with the corresponding information from the current Flight Plan or Flight Workspace.  The user can change all the default values to request a briefing on any route desired.  The Route Corridor Width, SUA Radius, Winds Aloft Corridor Width, and SPECI Time Interval fields use the default values found on the User Parameter dialog box located under the Status Menu. 

Selecting the SUA Conflicts check box will cause the system to automatically compare active and published SUA data for route and time overlap and display the conflicts in the SUA tabbed page of the Weather and Aeronautical Briefing window.  The conflict data consists of the active SUA data followed by an abbreviated version of the published data relevant to the route.  A Facility Parameter called SUA Extra is used to calculate the block of time to be used for the time period of the flight.  The value of the SUA Extra parameter in minutes is subtracted from the ETD and added to ETA to create an extra buffer of time on either side of the time enroute of the flight in order to determine the time overlap.

TFRs, NOTAMs, XE "NOTAM" \r "D2HBNOTAM76"  and FDC NOTAMs are retrieved by Affected Facility and are displayed in the following order:  

· Affected Facility that matches the Departure

· Affected Facility that matches the Destination

· Affected Facility that matches the Alternate Airport

· Affected Facility that matches the Second Alternate Airport

· Affected Facility that is within five nautical miles of the Departure, from the Departure outward

· Affected Facility that is within the route corridor, from the Departure to the Destination

· Affected Facility that is within five nautical miles of the Destination, inward toward the Destination

· Affected Facility that is an ARTCC which intersects the route corridor

· Other pertinent NOTAMs, such as LRN or GPS NOTAMs (not applicable for FDC NOTAMs)

NOTE:
Within the categories listed, entries are sorted alphabetically by Affected Facility, then by NOTAM number.

Once the briefing request is submitted, the results are displayed in the Weather and Aeronautical Briefing Window.
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Figure 3‑64  Route Briefing Dialog Box

Table 3‑38  Route Briefing Dialog Box Description 

	Label
	Component
	Purpose

	Briefing Type
	Drop-down List Box
	Displays the selected type of weather briefing from the list of available types including: Standard, Outlook, Trend, and Selected. When the user chooses “Selected”, the Report Types button is enabled, and the Report Type dialog box is displayed.

	Aircraft ID
	Text Box
	Enter the 2 - 7 alphanumeric characters for the Aircraft Identification.  The first character must be a letter.

	ETD
	Text Box
	Enter the 4 – 6 digit Estimated Time of Departure [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	Departure
	Text Box
	Enter the departure location.  Domestic: 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.  ICAO: 4 character LOCID.

	Destination
	Text Box
	Enter the destination location.  Domestic: 2-5 character LOCID, 8-11 character Fix/Radial/Distance, or 9-12 character Lat/Long point.  ICAO: 4 character LOCID.

	Enroute Altitude
	Text Box
	Enter the 2 – 7 alphanumeric character projected altitude between the departure point and the destination.

	Route Corridor Width
	Text Box
	Enter the width of the route corridor in nautical miles NM (10 - 100 NM in 5 NM increments).  The default value may be set on the User Parameter dialog box found under the Status menu.

	Winds Aloft Corridor Width
	Text Box
	Enter the width of the winds aloft corridor in nautical miles NM (100 - 600 NM in 50 NM increments).  The default value may be set on the User Parameter dialog box found under the Status menu.

	SUA Radius
	Text Box
	Enter desired SUA radius in nautical miles (5 - 50 NM in 5 NM increments).  The default value may be set on the User Parameter dialog box found under the Status menu.

	SPECI Time Interval
	Text Box
	Edit SPECI Time Interval (number of minutes past the observation time, 60 – 180 minutes in 5-minute increments). The default value may be set on the User Parameter dialog box found under the Status menu.

	First Alternate Airport
	Text Box
	Enter the 3-4 alphanumeric character description of the first alternate airport.

	Second Alternate Airport
	Text Box
	Enter the 3-4 alphanumeric character description of the second alternate airport.

	Route
	Text Box
	Enter the 0-558 character route.

	Report Types
	Button
	Displays the Report Types dialog box when the "Selected" briefing type is selected.

	SUA Conflicts
	Check Box
	If selected, checks for Special Use Airspace conflicts.  Defaults to checked.

	Supplemental Data 
	Group Label
	Enter additional data regarding the flight plan.

	Flight Plan Type
	Drop-down List box
	Choose which type of Flight Plan [Domestic or ICAO].

	Flight Rules
	Drop-down List box
	Choose the type of Flight Rules. 

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	OK
	Button
	Activates the selected options.


To Request a Route Briefing: XE "Briefing" \r "D2HBBriefing79" 
1. <Click> the Briefing menu.

2. <Select> the Route menu option to display the Route Briefing dialog box.

3. <Select> the desired Briefing Type from the drop-down list box.  The user selected Briefing Type is displayed.

4. Enter the required information in the appropriate text boxes to select options other than the default settings.

5. <Click> the OK button to validate all completed fields and submit the Route Briefing request for processing.  The results will be displayed in the Weather and Aeronautical Briefing Window. 

6. <Click> on the World Graphic (button) to overlay XE "Overlay:Route"  briefing route information graphically onto a Weather Graphics window.  The Route may be graphically depicted onto any Weather Graphics window that is setup for flight overlays.

When the user attempts a Route Briefing with invalid elements in the route, the system will return an error and highlight the elements that are invalid.  Highlighted elements may appear in the Departure, Destination, or Route fields.  These elements must be removed or corrected before a Route Briefing can be successfully completed.
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Figure 3‑65  Route Briefing with Invalid Route Element

3.5.5 Selected Location (Briefing Menu)

The Selected Location menu option displays the Selected Location Briefing XE "Selected Location Briefing"  dialog box.  This function allows the specialist to retrieve Current Reports, XE "Reports"  Forecasts, Warnings, SUA, Aeronautical, Trend Reports and International Weather Reports for the locations or information selected.  Up to 20 locations, separated by spaces, may be specified for most weather products.  Domestic weather products are considered location-oriented or area-oriented. A location-oriented product is a product that is reported by a specific site and is applicable for that site.  An area-oriented product is a product that is reported by a specific site and is applicable for an area.  Location-oriented reports include METARs, UAs, TWs, TAFs, and SYNS and will be retrieved for the LOCIDs XE "LOCID"  entered. Area-oriented reports include WAs, WHs, WSs, WSTs, WWs, ACs, CWAs, FAs, FDs, SDs, and FDC, and will be retrieved if the selected locations are located within the affective areas of the messages.  ATCSCC messages are retrieved when the affected facility of the ATCSCC message matches the LOCID entered.  NOTAMs XE "NOTAM"  and FDC NOTAMs are retrieved when the Affected Facility of the NOTAM matches the LOCID entered.

Selected Location Briefings are provided for items such as IR and VR products, TWEB products, ICAO products and MOA products. IR and VR products are retrieved based on the route number. TWEB products are retrieved based on TWEB IDs.  ICAO weather products are retrieved based on WMO headers. MOA products are retrieved based on MOA name.

If a Flight Plan XE "Flight Plan:Dialog Box"  or Flight Workspace XE "Flight Workspace"   is currently open, certain fields (Aircraft ID, ETD, Time Enroute, Enroute Altitude, Flight Plan Type, and Flight Rules) within the Selected Location Briefing dialog box will automatically be populated with the corresponding information from the current Flight Plan or Flight Workspace.  The user can change all default values.  The specialist then inputs the LOCIDs or information for the specific products they wish to receive.  Clicking on the adjacent checkbox activates each product edit box.  Once the briefing request is submitted, the results are displayed in the Weather and Aeronautical Briefing Window.
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Figure 3‑66  Selected Location Briefing  Dialog Box

Table 3‑39  Selected Location Briefing Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter 2 - 7 alphanumeric characters for the Aircraft Identification.  The first character must be a letter.

	ETD
	Text Box
	Enter the 4 – 6 numeric Estimated Time of Departure [dd] hhmm: dd = 01-31, hh = 00-23, mm = 00-59.

	Time Enroute
	Text Box
	Enter the 4 digit Enroute time in hours and minutes; hhmm: hh = 00-99, mm = 00-59.

	Enroute Altitude
	Text Box
	Enter 2 - 7 alphanumeric characters for Altitude.

	Briefing Language
	Group Label
	Defines the types of report formats.

	
	Regular
	Displays Abbreviated report format.

	
	Expanded
	Displays Expanded report format.

	
	Both
	Displays Abbreviated and Expanded report format.

	Current Reports
	Group Label
	Defines the Type of Reports.

	
	METAR
	Selects Aviation Routine Weather Reports.  Enter one or more LOCIDs, separated by spaces.

	
	NO
	Selects NOTAMs.  Enter LRN, GPS, and/or one or more LOCIDs, separated by spaces.  NOTAM retrieval is based on affected facility.

	
	FDC
	Selects FDC NOTAMs (including TFR FDC NOTAMs).  Enter one or more LOCIDs, separated by spaces.

	
	UA
	Selects Pilot Reports.  Enter one or more LOCIDs, separated by spaces.

	
	SD
	Selects Radar Weather Reports.  Enter one or more LOCIDs, separated by spaces.

	
	GFDC
	Selects General FDC NOTAMs (including TFR General FDC NOTAMs).  Textbox displays “FDC”.

	Forecasts
	Group Label
	Defines the Type of Forecast.

	
	FA
	Selects Area Forecasts.  Enter one or more LOCIDs, separated by spaces.

	
	FD
	Selects Winds and Temperatures Aloft Forecasts.  Enter one or more LOCIDs, separated by spaces.

	
	TAF
	Selects Terminal Aviation Forecast Reports.  Enter one or more LOCIDs, separated by spaces.

	Warnings
	Group Label
	Defines the Type of Warning.

	
	WA
	Selects AIRMET Reports.  Enter one or more LOCIDs, separated by spaces.

	
	WH
	Selects Hurricane Advisories.  Enter one or more LOCIDs, separated by spaces.

	
	WS
	Selects SIGMET Reports.  Enter one or more LOCIDs, separated by spaces.

	
	WST
	Selects Convective SIGMET Reports.  Enter one or more LOCIDs, separated by spaces.

	
	WW
	Severe Weather Watch Bulletins (WWs) and Alert Messages (AWWs).  Enter "ALL" to receive all reports.

	SUA
	Group Label
	Defines the type of Special Use Area.

	
	IR
	Selects IFR Military Training Routes. XE "Military Training Route"   Enter one or more routes, separated by spaces.  Or  enter “ALL” to retrieve all activation messages.

	
	VR
	Selects VFR Military Training Routes.  Enter one or more routes, separated by spaces.  Or enter “ALL” to retrieve all activation messages.

	
	MOA
	Selects Military Operations Area Messages.  Enter one or more MOA names, separated by the word “MOA”.  Or enter “ALL” to retrieve all activation messages.

	Aeronautical
	Group Label
	Defines Aeronautical Reports.

	
	ATCSCC
	Selects Air Traffic Control System Command Center Messages.  Enter one or more LOCIDs, separated by spaces.

	
	SUA
	Selects Special Use Airspace Conflicts. (Currently not available).

	Other
	Group Label
	Defines Other Reports Types.

	
	AC
	Selects Convective Outlook Reports.  Enter one or more LOCIDs, separated by spaces.

	
	CWA
	Selects Center Weather Advisory Reports.  Enter one or more LOCIDs, separated by spaces.

	
	SYNS
	Selects TWEB Synopsis Products.  Enter one or more LOCIDs, separated by spaces.

	
	TWEB
	Selects Transcribed Weather Broadcast.  Enter one or more numeric identifiers, separated by spaces.

	Trend Reports
	Group Label
	Defines Trend Reports.

	
	TW
	Selects Trend Weather Reports (last three hours of METARs).  Enter one or more LOCIDs, separated by spaces.

	
	SPECI Time Interval
	Edit SPECI Time Interval (number of minutes past the observation time, between 60 and 180, in five-minute increments).

	International Weather
	ICAOWX
	Selects ICAO International Weather Reports.  Enter “LIST” to retrieve all of the currently stored ICAO WMO headers found in the weather database.   Or enter one or more WMO headers, separated by spaces.  The format of each WMO header is TTAAii CCCC where:

TT is the product type,

AA is the geographic identifier,

ii is the 0 - 2 digit subproduct code,

CCCC is the four-character LOCID. XE "LOCID" 
Example: FDCN40<space> CYYZ

	Flight Plan Type
	Drop-down List box
	Choose which type of Flight Plan  [Domestic or ICAO].

	Flight Rules
	Drop-down List box
	Choose the type of Flight Rules. 

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	OK 
	Button
	Send the selected location briefing request to the Flight Data Server. XE "Flight Data Server"  


To Request a Selected Location Briefing: XE "Briefing" 
1. <Click> the Briefing menu.

2. <Select> the Selected Location menu option to display the Selected Location Briefing dialog box.

3. Enter the Aircraft ID, ETD, and Time Enroute in the appropriate text boxes to select options other than the default settings.  <Click> desired briefing language radio buttons and reports.

4. <Click> the OK button to validate all completed fields and submit the Selected Location Briefing request for processing.  The results will be displayed in the Weather and Aeronautical Briefing Window.

5. <Click> on the World Graphic (button) to overlay XE "Overlay:Route"  selected location briefing information graphically onto a Weather Graphics window.  The Locations may be graphically depicted onto any Weather Graphics window that is setup for flight overlays.

NOTE:
Certain types of selected location briefing information may not be overlaid onto Weather Graphics.

3.5.6  XE "Sequence:Define" Sequence Definitions (Briefing Menu)

The Sequence Definitions menu option displays the Sequence Definitions dialog box, which lists all of the Sequence Definition files currently saved.  From the Sequence Definitions dialog box, the user may Execute, Expand, Create, and Transfer XE "Transfer"  Sequence Definition files as well as Refresh the file listing.

A Sequence Definition file may consist of any number of three possible types of lines.  A line preceded by a ‘#’ character is a comment line and is only visible while actually editing the Sequence Definition file.  A line preceded by a ‘*’ character is a static text line and will appear in the View Sequence just as it does in the Sequence Definition file.  A line beginning with a command such as “METAR” or “TAF” is a command line.  Such command lines allow the quick retrieval of textual weather data based upon the location identifier(s) supplied after the command.  Refer to the Appendix of Valid Sequence XE "Sequence:Define"  Definition Commands for a complete list of the commands.

A Sequence Definition file is executed from the main Sequence Definitions window. When the Sequence Definition file is executed, the view sequence data is returned and displayed in a View Sequence window.  Up to five View Sequence windows can be displayed concurrently.  The title bar of each view sequence displays the name of the sequence definition.  A view sequence can be updated by selecting the Refresh button on the View Sequence dialog box.
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Figure 3‑67  Sequence Definitions Dialog Box

Table 3‑40  Sequence Definitions Dialog Box Description 

	Label
	Component
	Purpose

	Refresh
	Button
	Updates the file listing.

	Expand Entry
	Button
	Retrieves and displays the file data in the Editing dialog box for the selected Sequence Definition.  Only one file may be edited at a time.

	Create Entry
	Button
	Displays a blank Editing dialog box from which the user may create a new Sequence Definition file.  Only one file may be edited at a time.

	Execute Entry
	Button
	Executes the selected Sequence Definition file and displays the results in the View Sequence dialog box.

	Transfer Entry
	Button
	Transfers the selected Sequence Definition file(s) to another facility.  If the file cannot be saved at the receiving facility due to size and/or naming constraints, it will be sent to the Facility Message XE "Facility Message:General"  list.


To Display the Sequence XE "Sequence:Define"  Definition File Listing:

1. <Click> the Briefing XE "Briefing" \r "D2HBBriefing85"  menu.

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

To Transfer XE "Transfer"  a Sequence Definition File:

1. <Click> the Briefing menu. 

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

3. <Select> the desired entry or entries.

4. <Click> the Transfer Entry button to bring up the Transfer Sequence Definition(s) dialog box.

5. Enter the name of tie-in station in the Transfer Sequence Definition(s) dialog box.

6. <Click> the OK button.

NOTE:
Sequence Definition files can be selected by simply typing in the first characters of the name of the file while the list is in focus.  For example, typing ‘r’ will select the first file that begins with ‘r’, then typing ‘o’ will select the first file that begins with “ro” and so on.  
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Figure 3‑68  Transfer Sequence Definition(s) Dialog Box

To Create a Sequence Definition File:

1. <Click> the Briefing menu.

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

3. <Click> the Create Entry button to bring up a blank Edit Sequence Definition dialog box.

4. Enter the desired name for this Sequence Definition file.

5. Enter the command, static text, and/or comment line(s) for this file

6. <Click> the Save Entry button to save the file on the FDS. XE "Flight Data Server" \r "D2HBFDS87" 
NOTE:
When a file is created on or deleted from the FDS, Sequence Definition File listings that are currently being displayed will not reflect a change in the list until the Refresh button is clicked.  Only the list from which the create or delete action was actually performed will refresh automatically.

NOTE:
After saving the Sequence XE "Sequence:Save"  Definition File, the user will need to <Click> Cancel from the Edit Sequence Definition dialog box to return to the Sequence Definition dialog box.  This allows for additional entries/updates.

To Expand an Entry (Edit Sequence Definition):

1. <Click> the Briefing menu.

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

3. <Select> the desired entry.

4. <Click> the Expand Entry button to retrieve the file data and display the Edit Sequence Definition dialog box.

NOTE:
When a user expands a Sequence Definition file, that file is locked on the FDS. No other user may view or edit the file data until the user who originally locked the file unlocks it by exiting the dialog.
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Figure 3‑69  Edit Sequence Definition Dialog Box

Table 3‑41  Edit Sequence Definition Dialog Box Description 

	Label
	Component
	Purpose

	Sequence Name
	Text Box
	Enter a unique name for the Sequence Definition file.

	Sequence Definition
	Text Box
	Enter the text of the Sequence Definition.  Utilize the commands listed in the Appendix of Valid Sequence Definition Commands.  Place a ‘#’ character at the beginning of a line to make it a comment line.  Place a ‘*’ character at the beginning of a line to make it a static text line.

	Save Entry
	Button
	Saves the Sequence Definition file. 

	Delete Entry
	Button
	Deletes the Sequence Definition.

	Print Entry
	Button
	Prints the Sequence Definition file data.


To Edit & Save a Sequence XE "Sequence:Save"  Definition File:

1. <Click> the Briefing menu. 

2. <Select> the Sequences Definition menu option to display the Sequence Definitions dialog box.

3. <Select> the desired entry.

4. <Click> the Expand Entry button to bring up the Edit Sequence Definition dialog box.

5. <Edit> the text of the Sequence Definition file.

6. <Click> the Save Entry button to save the file on the FDS

NOTE:
The user also has the capability of changing the Sequence Name from the Edit Sequence Definition dialog box.  This functionality may be used to save an exact or modified copy of an existing file under a different name providing that a file with the newly assigned name does not already exist.

NOTE:
After saving the Sequence Definition File, the user will need to <Click> Cancel from the Edit Sequence Definition dialog box to return to the Sequence Definitions dialog box.  This allows for additional entries/updates.

To Delete a Sequence Definition File:

1. <Click> the Briefing menu.

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

3. <Select> the desired entry.

4. <Click> the Expand Entry button to retrieve the file data and display the Edit Sequence Definition dialog box.

5. <Click> the Delete Entry button.  A dialog box will appear to confirm that the sequence definition should be deleted.

6. <Click> the Yes button to delete the sequence definition.

OR

7. <Click> the No button to cancel the delete operation.
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Figure 3‑70  View Sequence XE "Sequence:Define"  Dialog Box

Table 3‑42  View Sequence Dialog Box Description

	Label
	Component
	Purpose 

	View Sequence Text
	Text Box
	The view sequence data.

	Refresh
	Button
	Executes the sequence definition file and refreshes the data.


To Display a View Sequence (Execute Entry):

1. <Click> the Briefing menu.

2. <Select> the Sequence Definitions menu option to display the Sequence Definitions dialog box.

3. <Select> the desired entry.

4. <Click> the Execute Entry button to display the View Sequence dialog box.

NOTE:
An entry can also be executed by simply double clicking on it in the Sequence Definitions dialog box.

To Refresh a View Sequence (Execute Entry):

1. <Click> the Refresh button to display updated data in the View Sequence dialog box.

3.5.7 Briefing Log (Briefing Menu)

The Briefing Log menu option displays the Briefing Log dialog box, which provides options for logging Inflight briefings, Preflight briefings, Flight Watch briefings and Contact briefings.

If a Flight Plan XE "Flight Plan:Dialog Box"  or Flight Workspace XE "Flight Workspace"  is currently open, certain fields (Aircraft ID, Aircraft Type, Flight Plan Type, Frequency, Departure, Destination, Flight Rules, and Remarks) within the Briefing Log dialog box will automatically be populated with the corresponding information from the current Flight Plan or Flight Workspace. The user can change all default values.  
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Figure 3‑71  Briefing Log Dialog Box

Table 3‑43  Briefing Log Dialog Box Description 

	Label
	Component
	Purpose

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be alphabetic.

	Aircraft Type
	Text Box
	Enter the aircraft type.  2-9 alphanumeric or slash characters; ICAO: 2-4 alphanumeric characters.

	Flight Plan Type
	Drop-down List Box
	Choose which flight plan type [Domestic or ICAO].

	Frequency
	Text Box
	Radio frequency (0 to 7 alphanumerics, slashes, and/or periods).

	Departure/
Location
	Text Box
	Enter the departure point or present position.  Domestic: LOCID, Fix/Radial/Distance, or Lat/Long point.  ICAO: 4 character LOCID.

	Destination
	Text Box
	Enter the destination.  Domestic: LOCID, Fix/Radial/Distance, or Lat/Long point.  ICAO: 4 character LOCID.

	Flight Rules
	Drop-down List Box
	Choose the type of flight rules. 

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, and DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	Remarks
	Text Box
	Enter any desired remarks, 0-80 characters.


	Inflight - Type Of Service
	Group Label
	Select the desired type of service to log with the appropriate combination:

Single Item, PWB,  Multi Leg, Airport Advisory, Radio Contact, Aircraft Contact. 

	Multi Leg
	Drop-down List Box
	Choose the number of Multi Legs: 0 through 10

	Inflight - Type of Aircraft Operation
	Group Label
	Select the desired aircraft operation: 

General Aviation, Military, Air Carrier, Air Taxi.

	Preflight
	Group Label
	Select the desired type of service to log with the appropriate combination:

 Single Item, PWB, Multi Leg.

	Flight Watch - Type Of Service
	Group Label
	Select the desired type of service to log with the appropriate combination:

Single Item,  PWB, Multi Leg, Radio Contact, Aircraft Contact. 

	Flight Watch - Type of Aircraft Operation
	Group Label
	Select the desired aircraft operation: 

General Aviation, Military, Air Carrier, Air Taxi.

	Contact
	Group Label
	Designate a non-briefing contact.

	Non-Briefing Contact
	Check Box
	Check mark for Non-Briefing contact.

	Clear Fields
	Button
	Clears all previously entered and checked entries in the dialog box.

	Log
	Button
	Logs the briefing.


To Log a Preflight Briefing: 

1. <Click> the Briefing menu.

2. <Select> the Briefing Log menu option to display the Briefing Log dialog box.

3. Enter the appropriate information into the text boxes.  Aircraft ID and Flight Rules are required. 

4. <Select> the appropriate check boxes for Type of Service for a Preflight  briefing. 

5. <Click> the Log button.

To Log an Inflight or Flight Watch Briefing: 

1. <Click> the Briefing menu.

2. <Select> the Briefing Log menu option to display the Briefing Log dialog box.

3. Enter the appropriate information into the text boxes.  

Aircraft ID and Flight Rules are required.

4. <Select> the appropriate check boxes for a valid combination of Type of Service.  Include the desired number of Multi Legs from the drop-down list box.

5. <Select> the appropriate radio button for Type of Aircraft Operation for an Inflight or Flight Watch briefing.

6. <Click> the Log button.

To Log a Contact Briefing: XE "Briefing" 
1. <Click> the Briefing menu.

2. <Select> the Briefing Log menu option to display the Briefing Log dialog box.

3. Enter the appropriate information into the text boxes.

Aircraft ID, Flight Rules, and Remarks are required.

4. <Select> the Non-Briefing Contact check box for a Contact briefing.

5. <Click> the Log button.

3.5.8 Auto Update Selection (Briefing Menu)

The Auto Update Selection menu option allows each user to choose the types of information that they receive on the Auto Update List.  For each report type, the user can specify whether or not to receive Auto Updates.  Depending on the report type, the user may be able to choose to receive all reports, XE "Reports"  or reports for a specific set of LOCIDs XE "LOCID"  or states.

Auto Update Selections may be set up for a site or a specific user.  When a selection is made for a site, every user set up to receive product updates will automatically receive any products received into the system matching the data in the Auto Update Selection dialog box.  The products will be displayed in the Auto Update List.  When a selection is made for a specific user, the user will automatically receive the user defined products as well as the site defined products.
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Figure 3‑72  Auto Update Selection Dialog Box

NOTE:
User ID: displays User ID or “site” if accessed by a Supervisor.

Table 3‑44  Auto Update Selection Dialog Box Description 

	Label
	Component
	Purpose

	Current Reports
	Group Label
	Defines the desired current aviation reports. 

	
	METAR
	Selects Aviation Routine Weather Reports.  Enter a list of LOCIDs and/or state abbreviations.

	
	UA/UUA
	Selects Routine and Urgent Pilot Reports.  Enter a list of LOCIDs and/or state abbreviations.

	
	UUA
	Selects Urgent Pilot Reports.  Enter a list of LOCIDs and/or state abbreviations.

	
	SD
	Selects Radar Weather Reports.  Enter a list of LOCIDs and/or state abbreviations.

	
	NO
	Selects NOTAMs based on affected facility.  Enter a list of LOCIDs.

	
	FDC
	Selects FDC NOTAMs (excluding TFR NOTAMs).  Enter a list of LOCIDs.  Or, enter "ALL" to receive all reports.

	
	GFDC
	Selects General FDC NOTAMs (excluding TFR NOTAMs).  Enter "ALL" to receive all reports.

	
	TFR
	Selects Temporary Flight Restriction FDC NOTAMs.  Enter a list of LOCIDs.  Or, enter "ALL" to receive all reports.

	Forecasts
	Group Label
	Defines the desired area forecast reports.  

	
	FA
	Selects Area Forecasts.  Enter a list of LOCIDs.   Or enter "ALL" to receive all reports.

	
	FD
	Selects Winds and Temperatures Aloft Forecasts.  Enter a list of LOCIDs and/or state abbreviations.

	
	TAF
	Selects Terminal Aviation Forecasts.  Enter a list of LOCIDs and/or state abbreviations.

	Warnings
	Group Label
	Defines the desired weather warning reports.  

	
	WA
	Selects AIRMETs. XE "AIRMETs"  Enter a list of LOCIDs.  Or enter "ALL" to receive all reports.

	
	WH
	Selects Hurricane Advisories. Enter "MIA".  Or enter "ALL" to receive all reports.

	
	WS
	Selects SIGMETs. XE "SIGMETs"  Enter a list of LOCIDs.  Or enter "ALL" to receive all reports.

	
	WST
	Selects Convective SIGMETs. Enter a list of LOCIDs. Or enter "ALL" to receive all reports.

	
	WW
	Selects Severe Weather Watch Bulletins (WWs) and Alert Messages (AWWs).  Enter "ALL" to receive all reports.

	Active SUA
	Group Label
	Defines the desired military training routes and messages.  

	
	IR
	Selects IFR Military Training Routes. XE "Military Training Route"   Enter "ALL" to receive all reports.

	
	VR
	Selects VFR Military Training Routes.  Enter "ALL" to receive all reports.

	
	MOA
	Selects Military Operations Area Messages.  Enter "ALL" to receive all reports.

	Aeronautical
	Group Label
	Defines the desired aeronautical messages. 

	
	ATCSCC
	Selects Air Traffic Control System Command Center Messages.  Enter "ALL" to receive all reports. 

	Other
	Group Label
	Defines other report types.  

	
	AC
	Selects Convective Outlooks.  Enter  "ALL" to receive all reports.

	
	CWA
	Selects Center Weather Advisories.  Enter a list of LOCIDs.  Or enter "ALL" to receive all reports.

	
	SYNS
	Selects TWEB Synopsis Products. Enter a list of LOCIDs and/or state abbreviations.

	
	TWEB
	Selects Transcribed Weather Broadcast Alerts.  Enter "ALL" to receive all reports.


NOTE: Up to 49 characters may be entered in each text field.  LOCIDs XE "LOCID"  must be 3 - 5 characters.  State abbreviations must be 2 characters.

To Modify the Auto Update Settings:

1. <Click> the Briefing XE "Briefing" \r "D2HBBriefing93"  menu.

2. <Select> the Auto Update Selection menu option to display the Auto Update Desired User dialog box.

NOTE:
If the user does not have the functional capability to view other users' auto update profiles, the Auto Update Desired User dialog box will not be displayed.  Instead, the Auto Update Selection dialog box will automatically be displayed with the user's own profile.  In this case, proceed to step 5.

3. Enter the User ID in the User ID text box.  Enter "site" to modify the settings for the entire facility.

4. <Click> the OK button.  The Auto Update Selection dialog box is displayed.

5. To receive auto updates, <Click> the desired check box and Enter the required information in the appropriate text boxes.

6. <Click> the OK button.
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Figure 3‑73  Auto Update Desired User Dialog Box

3.5.9 Auto Update List (Briefing Menu)

The Auto Update List allows the user to view the products selected in the Auto Update Selection dialog box automatically upon receipt into the system.  

Very long products may be added to the list in parts.  If part of a product is not available on the list, the phrase “[...Message Data Incomplete...]” will be displayed in place of that part.  When that part is received, it will be combined with the rest of the product and the “[...Message Data Incomplete...]” indicator will be removed.  If a portion of a product does not become available on the list in a timely manner, the full product should be viewed in a weather briefing.

An alarm will be generated whenever a new message is added to the Auto Update List.  See the Main Window/Alarm Bar section for more information on list alarms.  

By default, the Auto Update List is sorted by Time Stamp.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑74  Auto Update List Dialog Box

NOTE:
The Auto Update List will display only the first 260 characters of the Message Data.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text. 

NOTE:
The  “=” denotes a record separator in a message on the list and in the expanded data text box.  The carriage return linefeed sequences are denoted by a “¶” on the list.

Table 3‑45  Auto Update List Dialog Box Description 

	Label
	Component
	Purpose

	Auto Update List 
	Scroll List
	Displays a summary list entry for each product received that matches the user’s or site’s Auto Update settings.

	Report Type
	Column
	Type of the product.

	Loc Id
	Column
	Affected location of the product.  Blank if not applicable for the product.

	State
	Column
	State identifier corresponding to the Loc Id.  Blank if not applicable for the product.

	Time Stamp
	Column
	Time the product was received.

	Message Data
	Column
	Text of the product.

	Expanded Data
	Text Box
	Displays the full text of the selected product.

	Delete Entry
	Button
	Deletes the selected entry from the user’s list. 

	Delete All
	Button
	Deletes all entries from the user’s list.


To Display the Auto Update List:

1. <Click> the Briefing menu.

2. <Select> the Auto Update List menu option.  The Auto Update List dialog box is displayed.

3.6  XE "Transmit Data" Transmit Data

The Transmit Data function provides the ability to record and/or disseminate  aviation and meteorological reports XE "Reports"  including: Weather Observations, XE "Weather Observations"  PIREPs, WMSCR XE "WMSCR"  Request/Reply, and NOTAMs. XE "NOTAM" 
Other types of information transmitted by the Transmit Data function are General Facility messages and Search and Rescue XE "Search and Rescue"  messages, which are communicated to other facilities.  These types of messages may be addressed to one or several facilities.  The Internal Facility Message, XE "Facility Message:General"  which is also transmitted by the Transmit Data function, is communicated within a facility.  This type of message may be  addressed to one or several users or functional positions, XE "Functional Position"  or to all users and all functional positions.
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Figure 3‑75  Transmit Data Menu

To Display the Transmit Data Menu:

1. <Click> the Transmit Data menu.

3.6.1 Weather Observations (Transmit Data Menu)

The Weather Observations menu option provides the capability to record METARs and SPECIs.

The Weather Observations menu option displays the Transmit Weather Observation dialog box, which can be displayed in an expanded or condensed (folded) view.  The information within all the fields of the expanded dialog box can be viewed in a condensed form by selecting the Fold option.

NOTE:
Some formatting rules must be understood to utilize the free format style of the folded view; otherwise use the expanded view dialog box to enter data one field at a time.
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Figure 3‑76  Transmit Weather Observation Dialog Box (Expanded View)

Table 3‑46  Transmit Weather Observation Dialog Box Description (Expanded View) 

	Label
	Component
	Purpose

	Report Type
	Drop-down List Box
	Displays the selected Report Type (METAR or SPECI).  Defaults to METAR.

	Hold
	Check Box
	Holds transmission until the top of the hour.  The number of minutes before the top of the hour at which a held METAR will be transmitted is  controlled by the "Metar Transmit Time" Facility Parameter.

	Override Validation
	Check Box
	Overrides validation prior to transmission.

	Station ID
	Text Box
	Enter the four character LOCID of the location or origin responsible for issuing the weather information.

	Observation Time
	Text Box
	Enter the observation time.  Use 6 digit time: ddhhmm.  Defaults to current time.

	Wind
	Text Box
	Enter the Wind direction in tens of degrees and speed in knots.

	Visibility
	Text Box
	Enter the Visibility distance in miles.

	RVR
	Text Box
	Enter the Runway Visual Range (RVR) in feet.

	Weather 
	Text Box
	Enter the general weather conditions.

	Sky Conditions
	Text Box
	Enter information on cloud cover, cloud base and cloud tops.

	Temp/ Dewpoint
	Text Box
	Enter the outside air temperature and dewpoint in Celsius.

	Altimeter
	Text Box
	Enter the Altimeter reading in inches of mercury.

	Remarks
	Text Box
	Enter any additional observation remarks.

	>>Fold<<
	Button
	Changes the dialog box display to the folded view.

	Transmit
	Button
	Transmits the Weather Observation to WMSCR.


NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.
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Figure 3‑77  Transmit Weather Observation Dialog Box (Folded View)

Table 3‑47  Transmit Weather Observation Dialog Box Description (Folded View) 

	Label
	Component
	Purpose

	Station ID
	Text Box
	Enter the four character LOCID of the location or origin responsible for issuing the weather information.

	Report Type
	Group Label
	Radio buttons set the Report Type to METAR or SPECI.

	Hold
	Check Box
	Holds transmission until the top of the hour.  The number of minutes before the top of the hour at which a held METAR will be transmitted is  controlled by the "Metar Transmit Time" Facility Parameter.

	Override Validation
	Check Box
	Overrides validation prior to transmission.

	Aviation Routine Weather Report
	Text Box
	Abbreviated means to enter pertinent observation information otherwise entered from the expanded view.

	Transmit
	Button
	Transmits the Weather Observation to WMSCR.


To Transmit a Weather Observation:

1. <Click> the Transmit Data XE "Transmit Data" \r "D2HBTransmit_Dat101"  menu.

2. <Select> the Weather Observations XE "Weather Observations"  menu option to display the Transmit Weather Observation dialog box.

3. <Select> METAR or SPECI from the Report Type drop-down list box.

NOTE:
The filled radio button indicates the selected Report Type when in folded view.

4. Enter the required information in the appropriate text boxes.  The Observation Time must be within one hour before or one hour after the current time.  If Override Validation is selected, only the Station ID and Observation Time are required.  The Station ID is checked for length and appropriate characters only, and the Observation Time is validated for both form and content.  No validation is performed on the rest of the data before it is transmitted.  If Override Validation is not selected, at least one weather condition must be entered.  All data is validated before being transmitted.

NOTE:
The equal sign character (=) is used as a separator between reports XE "Reports"  and therefore may not be entered in any field on the expanded or folded view.

5. <Click> the Transmit button.  The Weather Observation Report information is sent to WMSCR. XE "WMSCR" 
NOTE:
The message data will be formatted before being transmitted to WMSCR.  This formatting includes removing any extra space characters in the text, inserting line breaks as required, and indenting each line after the first line by five spaces.

3.6.2  XE "PIREP" PIREP (Transmit Data Menu)

The PIREP menu option provides the capability to record Pilot Weather Reports.  It  displays the Transmit Pilot Weather Report dialog box, which can be displayed in an expanded or a condensed (folded) view.  The information within all the fields of the expanded dialog box can also be viewed in a condensed form by selecting the Fold option. 
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Figure 3‑78  Transmit Pilot Weather Report Dialog Box (Expanded View)

Table 3‑48  Transmit Pilot Weather Report Dialog Box Description (Expanded View) 

	Label
	Component
	Purpose

	Accountable Facility
	Text Box
	Enter the 3 or 4 character LOCID of the reporting facility.

	Pilot Report Type
	Drop-down List Box
	Displays the selected report type (UA - Routine or UUA - Urgent). Defaults to UA.

	Phenomena Location
	Text Box
	Enter the location of the observation.

	Override Validation
	Check Box
	Overrides validation prior to transmission.

	Phenomena Time
	Text Box
	Enter the time of observation.  Use 4 digit time: hhmm.

	Flight Level
	Text Box
	Enter the altitude of the observation.  Enter UNKN for unknown.

	Aircraft Type
	Text Box
	Enter the type of aircraft.

	Sky Condition
	Text Box
	Enter information on cloud cover, cloud bases and cloud tops.

	Flight Visibility
	Text Box
	Enter distance in miles of observations or restrictions.

	Temperature
	Text Box
	Enter the current outside air temperature in Celsius.

	Wind Velocity
	Text Box
	Enter the wind direction in tens of degrees and speed in knots.

	Turbulence
	Text Box
	Enter the intensity and altitude of turbulence.

	Icing
	Text Box
	Enter the intensity, type and altitude of icing.

	Pilot Remarks
	Text Box
	Enter any other experienced phenomena significant to the safety and efficiency of flight.  (e.g. location of thunderstorms or tornado activity, conditions within mountain passes)

	>>Fold<<
	Button
	Changes the dialog box display to the folded view.

	Transmit
	Button
	Transmits the PIREP to WMSCR.


NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.
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Figure 3‑79  Transmit Pilot Weather Report – Short Form Dialog Box (Folded View)

Table 3‑49  Transmit Pilot Weather Report – Short Form Description (Folded View)

	Label
	Component
	Purpose

	Accountable Facility
	Text Box
	Enter the 3 or 4 character LOCID of the reporting facility. 

	Override Validation
	Check Box
	Overrides validation prior to transmission.

	Message Text
	Text Box
	Abbreviated means to enter pertinent observation information otherwise entered from the expanded view.

	<<Expand>>
	Button
	Changes the dialog box display to the expanded view. 

	Transmit
	Button
	Transmits the PIREP to WMSCR.


NOTE: 
Some formatting rules must be understood to utilize the free format style of the folded view; otherwise use the expanded view dialog box to enter data one field at a time.  The condensed (folded) view will  arrange the fields of the PIREP XE "PIREP"  in the correct order when the transmit button is clicked. 

To Transmit a Pilot Report:

1. <Click> the Transmit Data XE "Transmit Data"  menu.

2. <Select> the PIREP menu option to display the Transmit PIREP dialog box.

3. Enter the required information within the appropriate text boxes.  The Phenomena Time must be within one hour before the current time.  If Override Validation is selected, only the Accountable Facility and Phenomena Time are required.  The Accountable Facility is checked for appropriate  characters only, and the Observation Time is validated for both form and content.  No validation is performed on the rest of the data before it is transmitted.  If Override Validation is not selected, the Phenomena Location, Flight Level, Aircraft Type, and at least one weather condition must be entered.  All data is validated before being transmitted.

NOTE:
The equal sign character (=) is used as a separator between reports XE "Reports"  and therefore may not be entered in any field on the expanded or folded view.

4. <Click> the Transmit button.  The PIREP information is sent to WMSCR.

NOTE:
The message data will be formatted before being transmitted to WMSCR.  This formatting includes removing any extra space characters in the text and inserting line breaks as required.

3.6.3 WMSCR Request/Reply (Transmit Data Menu)

The WMSCR Request/Reply menu option provides the capability to transmit, store and display a WMSCR request.  The WMSCR menu option displays the WMSCR Transmit Request dialog box.
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Figure 3‑80  WMSCR XE "WMSCR" \r "D2HBWMSCR101"  Transmit Request Dialog Box

NOTE:
All weather that cannot be retrieved from a briefing menu must be requested from WMSCR.

Table 3‑50  WMSCR Transmit Request Dialog Box Description 

	Label
	Component
	Purpose

	User ID
	Text Box
	Enter User ID or “site.”  If the User ID is “site”, the report is broadcast to all of the users at the facility.  Defaults to “site” or a user’s logon ID.

	Transmit Time
	Text Box
	Enter the transmit time.  Use either 4 or 6 digit time:  [dd]hhmm.  Defaults to current time.

	RR Type
	Drop-down List Box
	Select type of request.

REPORT = Individual reports by type.

WMO = Product by its WMO identification.

LIST = NOT SUPPORTED BY WMSCR
NOTAM CLEANUP = This is used to remove old NOTAMs  from the NOTAM database.  Refer to the NOTAM Cleanup Appendix for a detailed description of NOTAM CLEANUP.

	Store
	Check Box
	Store the report when received by WMSCR.

	Display
	Check Box
	Displays the report to the specified User ID in the WMSCR Request/Reply Updates list.

	RR Text
	Text Box
	Enter WMSCR RR Text

	Transmit 
	Button
	Transmits the request to WMSCR.


NOTE:
Either Store, Display, or both must be selected in order to transmit the WMSCR Request.

To Transmit a WMSCR Request for REPORT:

1. <Click> the Transmit Data XE "Transmit Data" \r "D2HBTransmit_Dat106"  menu.

2. <Select> the WMSCR Request/Reply menu option to display the WMSCR Transmit Request dialog box.

3. <Select> REPORT from the RR Type drop-down list box.

4. Enter the required information within the appropriate text boxes.

5. In the RR Text box, after the “RE”, enter report type (see list below) followed by the reporting station LOCID. XE "LOCID"   Each LOCID must be separated by a comma, (e.g. SA SEA,PDX,BFI or SA KSEA,KPDX,KBFI).  Do not include a space before or after a comma between two LOCIDs.

6. <Click> the Transmit button.  All completed fields are validated and the information is sent to WMSCR.

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

The following table lists the report types that may be requested.  Report types listed in the table as not stored, as well as report types not listed may be requested as long as the Store option is not selected.  In that case, the reply from WMSCR may be viewed on the WMSCR Request/Reply Updates List, but will not be stored for later retrieval.

Table 3‑51  WMSCR Transmit Request Report Type – “RE” Description

	REQUESTED REPORT TYPE
	REPORT TYPE RETURNED BY WMSCR
	STORED AS REPORT TYPE

	AC
	AC
	AC

	AWW
	AWW
	WW

	CS1
	CS1
	[Not Stored]

	CWA
	CWA, UCWA
	CWA

	FA
	FA
	FA

	FD1
	FD1
	FD

	FD2
	FD2
	FD

	FD3
	FD3
	FD

	FD8
	FD8
	FD

	FD9
	FD9
	FD

	FD10
	FD10
	FD

	FO14
	FO14
	[Not Stored]

	FT
	TAF
	FT

	MIS
	MIS
	[Not Stored]

	NOTAM
	NOTAM
	NOTAM

	SA
	METAR, SPECI, NOTAM, UA, UUA
	METAR/NOTAM/UA

	SD
	SD
	SD

	SI
	SI
	[Not Stored]

	SM
	SM
	[Not Stored]

	SP
	METAR, SPECI
	METAR

	SYNS
	SYNS
	SYNS

	TA
	TESTS, TESTM
	[Not Stored]

	TWEB
	TWEBs
	TWEB

	UA
	UA, UUA
	UA

	US1
	US1
	[Not Stored]

	UJ1
	UJ1
	[Not Stored]

	UJ2
	UJ2
	[Not Stored]

	WA
	WA
	WA

	WS
	WS, UWS
	WS

	WST
	WST
	WST

	WW
	WW, WW-A
	WW


To Transmit a WMSCR Request for WMO Products:

1. <Click> the Transmit Data menu.

2. <Select> the WMSCR Request/Reply menu option to display the WMSCR Transmit Request dialog box.

3. <Select> WMO from the RR Type drop-down list box.

4. Enter the required information within the appropriate text boxes.

5. In the RR Text text box, after the “W”, enter the WMO header of the product requested, (e.g. FPUS3 KSEA).

6. <Click> the Transmit button.  All completed fields are validated and the information is sent to WMSCR.

To Transmit a WMSCR Request for NOTAM XE "NOTAM" \r "D2HBNOTAM103"  CLEANUP:

1. <Click> the Transmit Data menu.

2. <Select> the WMSCR Request/Reply menu option to display the WMSCR Transmit Request dialog box.

3. <Select> NOTAM CLEANUP from the RR Type drop-down list box.

4. <Click> the Transmit button.  The information is sent to WMSCR.

NOTE:
This request should only be used to check the NOTAM database.  This will request all the NOTAMs that were not received in the last NOTAM summary from WMSCR.   Refer to the NOTAM Cleanup Appendix for a detailed description of  NOTAM CLEANUP.

3.6.4  XE "NOTAM" \r "D2HBNOTAM104" NOTAM (Transmit Data Menu)

The NOTAM menu option provides the capability to record NOTAMs for hourly dissemination throughout the domestic aviation weather system.  The NOTAM menu option displays the Transmit NOTAM dialog box.
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Figure 3‑81  Transmit NOTAM Dialog Box

Table 3‑52  Transmit NOTAM Dialog Box Description 

	Label
	Component
	Purpose

	NOTAM FILE
	Text Box
	Enter the address of the accountable facility.  

	Transmit Time
	Text Box
	Enter the transmit time.  Use either 4 or 6 digit time: [dd]hhmm.  Defaults to current time.

	Affected Facility
	Text Box
	Enter the address of the affected facility.

	Override Validation
	Check Box
	Overrides validation prior to transmission.

	NOTAM Report
	Text Box
	Enter the NOTAM information.

	Transmit
	Button
	Transmits the NOTAM to CNS.


To Transmit a NOTAM:

1. <Click> the Transmit Data menu.

2. <Select> the NOTAM menu option to display the Transmit NOTAM dialog box.

3. Enter the required information in the appropriate text boxes.  To transmit more than one NOTAM you must press the Enter key after the first NOTAM and completely format subsequent NOTAMs.  See the following figure.

4. <Click> the Transmit button.  If Override Validation is selected, all fields are required but only the Transmit Time is validated.  The remaining fields are checked for appropriate characters only before the unprocessed NOTAM is sent to CNS.  If Override Validation is not selected, all fields are validated and the unprocessed NOTAM information is sent to CNS.
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Figure 3‑82  Transmit NOTAM Dialog Box – e.g. with more than one NOTAM

3.6.5  XE "Facility Message:General" \r "D2HBFacility_Mes106" General Facility Message (Transmit Data Menu)

A General Facility Message is an informational or advisory message that can be sent out to one or more facilities.  The General Facility Message menu option displays the Transmit General Facility Message dialog box.  The Transmit General Facility Message dialog box can also be opened from a Flight Workspace XE "Flight Workspace" \r "D2HBFlight_Works108"  window, the Suspense List, XE "Suspense List"  the Facility Message List (Edit Facility Message), and the Internal Facility Message List (Expand Internal Facility Message).  When opened from the Flight Workspace window, the relevant data from the workspace is used to populate the Transmit General Facility Message dialog box.  Up to five Transmit General Facility Message dialog boxes may be open concurrently.
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Figure 3‑83  Transmit General Facility Message Dialog Box

Table 3‑53  Transmit General Facility Message Dialog Box Description 

	Label
	Component
	Purpose

	Origin
	Text Box
	LOCID of the originating (sending) facility.  Defaults to Responsible FSS selected at login.  (Read Only)

	Transmit Time
	Text Box
	Enter the transmit time.  Use either 4 or 6 digit time:  [dd]hhmm.  Defaults to current time.

	Message Priority
	Drop-down List Box
	Select ICAO message priority:  SS, DD, FF, GG.  Defaults to “FF”.

	Facility Addresses
	Text Box
	Enter the addresses of the facilities to receive the message with a space separating each address [3, 4, or 8 alphanumeric character address with a maximum of 16 addresses].  An “*” may be entered immediately preceding a facility address indicating that an acknowledgement is required.  Example:  *MIA or *KMIAYFYX.

	General Facility message
	Text Box
	Enter the message to be sent. Individual message line length limited to 69 characters.  Maximum length of the text is 20 lines.

	Transmit
	Button
	Transmits the General Facility message to the listed addresses.  Any message longer than 20 lines will be automatically broken into multiple messages.


NOTE:
Flight plan data can be copied into the General Facility Message field from the Flight Workspace.

To Send a General Facility Message:

1. <Click> the Transmit Data menu.

2. <Select> the General Facility Message menu option to display the Transmit General Facility Message dialog box.

3. Enter the Transmit Time in the appropriate text box.

4. <Select> the priority value from the Message Priority drop-down list box.

5. Enter one or more Facility Addresses (separated by a space) into the text box.

6. Enter the General Facility Message to be sent into the text box.

7. <Click> the Transmit button.  All completed fields are validated and the General Facility Message is sent to the designated addresses (facilities).

3.6.6  XE "Search and Rescue" \r "D2HBSAR106" SAR (Transmit Data Menu)

The Transmit SAR menu option displays the dialog box for generating and transmitting Search and Rescue XE "Search and Rescue"  messages to the appropriate facilities.  The SAR Search menu option allows the user to initiate a search of the history database for information.

[image: image116.png]‘Weather Dbservation (Expanded).. CtikSHits0)

Weather Dbservaton (Folded)..  F7
PIREP (Expanded) 5
PIREP (Folded). 5
‘WMSCR Request/Repl CulsShitsP
NOTAM, CulsShitsN

8

Transmit SAR... Cul+ShitiZ
5AR Seach. _CulsShitsH

Intemal Facilty Message. Culishitel





Figure 3‑84  Transmit Data/Search and Rescue Menu Options

3.6.6.1 Transmit SAR  (Transmit Data/SAR)

The Transmit SAR menu option displays the Transmit Search and Rescue dialog box.  When the specialist transmits the Search and Rescue Report, an entry is added to the SAR List.  
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Figure 3‑85  Transmit Search and Rescue Dialog Box

Table 3‑54  Transmit Search and Rescue XE "Search and Rescue"  Dialog Box Description 

	Label
	Component
	Purpose

	Origin
	Text Box
	LOCID for the originating (sending) facility.  Defaults to Responsible FSS selected at login.  (Read Only)

	Transmit Time
	Text Box
	Enter the transmit time.  Use either 4 or 6 digit time:  [dd]hhmm.  Defaults to current time.

	SAR Type
	Drop-down List Box
	Displays the selected (highlighted) SAR type. Select the SAR type from the pull-down list box.  The selection defaults the priority of the message, indicated by the Message Priority Drop-down list box.

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be alphabetic.

	Message Priority
	Drop-down List Box
	Select ICAO message priority: SS, DD, FF, GG.

	Facility Addresses
	Text Box
	Enter the addresses of the facilities to receive the message with a space separating each address [3, 4, or 8 alphanumeric character address with a maximum of 16 addresses].  An “*” may be entered immediately preceding a facility address indicating that an acknowledgement is required.  An "*" is automatically inserted for INREQ SAR types when transmitted.

	SAR Report
	Text Box
	Enter the SAR message to be sent.

	Transmit
	Button
	Transmits the SAR report to the listed addresses.


To Transmit a Search and Rescue Report:

1. <Click> the Transmit Data XE "Transmit Data" \r "D2HBTransmit_Dat113"  menu.

2. <Select> the SAR menu option.

3. <Select> the Transmit SAR menu option to display the Transmit Search and Rescue dialog box.

4. <Click> a SAR Type from the drop-down list box.  The SAR Type is displayed as selected.

5. Enter the Transmit Time using either 4 or 6 digit time: [dd]hhmm.

6. Enter the Aircraft ID into the appropriate field.

7. Enter one or more Facility Addresses (separated by a space) into the text box.  

8. Enter the SAR Report (message) to be sent into the text box.

9. <Click> the Transmit button.  All completed fields are validated and the SAR Report is sent to the designated addresses (facilities).

3.6.6.2 SAR Search  (Transmit Data/SAR)

The  SAR Search menu option displays the SAR Search dialog box.  The specialist may perform a search of the history database for information on an aircraft.  When the specialist initiates a new search, the results appear in the Transmit Search and Rescue dialog box.
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Figure 3‑86  SAR XE "Search and Rescue"  Search Dialog Box

Table 3‑55  SAR Search Dialog Box Description 

	Label
	Component
	Purpose

	Start Time 

(for Date Range)
	Text Box
	Enter the start time for the time span of data to be reconstructed.  MM DD YYYY HHMM.  Defaults to current time minus 24 hours. 

	Stop Time  (for Date Range)
	Text Box
	Enter the stop time for the time span of data to be reconstructed.  MM DD YYYY HHMM.  Defaults to current time. 

	Aircraft ID
	Text Box
	Enter the Aircraft Identification, 2-7 alphanumeric characters.  The first character must be alphabetic.

	Origin
	Text Box
	Enter the LOCID for the originating (sending) facility.  Defaults to Responsible FSS selected at login.

	Priority
	Drop-down List Box
	Select message priority: SS, DD, FF, GG.

	SAR Type
	Drop-down List Box
	Displays the selected (highlighted) SAR type. Select the SAR type from the drop-down list box.  The selection defaults the priority of the message, indicated by the Priority Drop-down list box.

	Text
	Text Box
	The SAR text formatted from the previous entries.

	New Search
	Button
	Initiates a search of the history database. 

	Delete Entry
	Button
	Deletes entry from SAR list.  Only available when expanding a SAR message from the SAR List.


To Perform a SAR Search:

1. <Click> the Transmit Data menu.

2. <Select> the SAR menu option 

3. <Select> the SAR Search menu option to display the SAR Search dialog box.

4. Enter the Aircraft ID and appropriate information into the individual fields.

5. <Click> the New Search button to initiate a new search request.

6. The results from the new search are displayed in a Transmit Search and Rescue XE "Search and Rescue"  dialog box.  Edit the text and Transmit to all appropriate facilities.

3.6.7  XE "Facility Message:General" \r "D2HBFacility_Mes112" Internal Facility Message (Transmit Data)

An Internal Facility Message is a textual message that can be sent to one or more users or functional positions XE "Functional Position"  at an AFSS. XE "AFSS"   The Internal Facility Message menu option displays the Transmit Internal Facility Message dialog box.   Up to five Transmit Internal Facility Message dialog boxes may be open concurrently.
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Figure 3‑87  Transmit Internal Facility Message Dialog Box

Table 3‑56  Transmit Internal Facility Message Dialog Box Description

	Label
	Component
	Purpose

	Sender
	Text Box
	User ID of the message originator.  (Read Only) 

	Transmit Time(s)
	Text Box
	Enter the transmit time.  Use 6 digit time:  ddhhmm.  Defaults to current time. [User may enter up to 5 Transmit Times separated by commas]

	Subject
	Text Box
	Enter the subject of the message [1-69 characters].

	Address Type
	Group Label
	Select type of address(es) to be entered in the Addresses field.  Defaults to All Functional Positions.  

	Users
	Radio Button
	Enables the selection of User(s) from the Select Addresses list box.

	All Users
	Radio Button
	Selects All Users.  The Addresses field becomes Read Only.

	Functional Positions
	Radio Button
	Enables the selection of Functional Position(s) from the Select Addresses list box.

	All Functional Positions
	Radio Button
	Selects All Functional Positions.  The Addresses field becomes Read Only.

	Select Addresses
	List Box
	Select the address to be added to the Addresses text box.  This list box will be empty for  All Users and All Functional Positions Address Types.   The selected address can be copied to the Addresses text box by double-clicking the address or using the Add button.

	Add
	Button
	Copies the selected address in the Select Addresses list box to the Addresses text box.   This button is disabled for All Users and All Functional Positions Address Types.

	Remove All
	Button
	Clears the Addresses text box.

	Addresses
	Text Box
	Enter one or more addresses, separated by a comma, to receive the message.  The type of address entered, user or functional position, is dependent upon the Address Type selection. 

1-20 Users or 1-10 Functional Positions.  Becomes Read Only if All Users button or All Functional Positions button is selected.

If All Users is selected, the message will be queued for users currently not logged in.

If All Functional Positions is selected, the message is sent to all functional positions currently logged in (not queued).

	Internal Facility message
	Text Box
	Enter the message to be sent.  Individual message length is limited to 69 characters per line, and approximately 20 lines per message (depending on characters per line).

	Transmit
	Button
	Transmits the Internal Facility message to the listed addresses.  


To Send an Internal Facility Message:

1. <Click> the Transmit Data menu.

2. <Select> the Internal Facility Message menu option to display the Transmit Internal Facility Message dialog box. 

3. Enter the Transmit Time in the appropriate text box, if additional transmit times are desired.  This field defaults to the current time, but additional transmit times may be entered.

4. Enter the Subject of the message in the appropriate text box.

5. <Select> the Address Type of addresses to be entered in the Addresses text box.

6. Add one or more Addresses into the Addresses text box.

7. Enter the Internal Facility Message to be sent into the appropriate text box.

8. <Click> the Transmit button.  All completed fields are validated and the Internal Facility Message is sent to the designated addresses (users or functional positions).  

NOTE:
Either the Subject or Internal Facility Message text box must contain data for the message to be transmitted.

NOTE:
Addresses can be entered via the keyboard  (separated by a comma) or via the Select Addresses list box.

THIS PAGE INTENTIONALLY LEFT BLANK
3.7 List

There are three separate flight plan XE "Flight Plan:Filing" 

 XE "Flight Plan:Display"  lists.  All flight plans appear on at least one of the following three lists at all times, depending on the current state of the flight plan:

- Inbound

- Proposed

- Suspense

All proposed flight plans filed appear on the proposed list of the originating facility until they are activated, canceled or automatically transmitted (depending on the flight plan type and flight rules).  Upon activation, VFR flight plans originating inside the departure facility’s Flight Plan Area are transmitted to the tie-in station.  Proposed IFR flight plans and VFR flight plans originating outside the departure facility's Flight Plan Area are automatically transmitted to a departure facility at a site-defined time period prior to the departure time.  Immediately after a flight plan is transferred, but before acknowledgment from the destination address or addresses has been received, the flight plan will appear on the Suspense List.  When a flight plan is received by a tie-in station, it will appear on the destination’s Inbound List.  The flight plan will remain on the Inbound List until the flight plan is closed.  Once the flight plan is closed, it no longer appears on any of the three flight plan lists, however, it can be viewed in the history logs.

All of the lists are updated automatically to contain the latest data.  Using the Functional Assignments XE "Assignments" 

 XE "Functional Assignment"  menu option, users may select to be notified visually when certain alarm conditions occur on these lists.  When visual notification is enabled, users may choose to enable audible notification of alarms as well.  This selection is made through the User Parameters XE "User Parameters"  menu option.

The user can highlight the icon for a list entry and <Select> the Retrieve Flight Plan button or <Double-Click> the entry to view the associated flight plan.  The user may modify or delete an entry from the list by modifying or deleting the associated flight plan.
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Figure 3‑88  List Menu

To Display the List Menu:

1. <Click> the List menu.

3.7.1 Inbound (List Menu)

The Inbound List XE "Inbound List"  menu option provides the capability to view all flight plans currently residing on a destination’s Inbound List that are not yet closed.  The Inbound menu option displays the Inbound List dialog box from which inbound flight plans can be Retrieved, Canceled or Closed.

Each entry within the list has an icon associated with it.  The coloration of the icons defines the level of concern for each entry.  The level of concern is determined using the ETA of the flight plan and the Inbound Overdue Timer facility parameter.  See the Facility Parameters (Status Menu/Parameters) section for a description of this parameter.  

The title bar of the Inbound List turns the color of the entry within the list, which holds the highest level of concern.

Table 3‑57  Inbound List Icon Definitions 

	Color
	Component
	Purpose

	Green
	Icon
	Flight plan is not late, or late by less than half the value of the Inbound Overdue Timer. (OK state)

	Yellow
	Icon
	Flight plan is late by at least half the value of the Inbound Overdue Timer. (Warning state)

	Red 
	Icon
	Flight plan is late by the full value of the Inbound Overdue Timer. (Overdue state)


NOTE:
An “!” next to the icon indicates that the flight plan contains remarks.

An alarm will be generated whenever a flight plan on the Inbound List becomes overdue (red icon).  An alarm will also be generated when a flight plan with remarks or a flight plan with a military destination is added to the list.   See the Main Window/Alarm Bar section for more information on list alarms.  

By default, the Inbound List is sorted by ETA from earliest to latest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑89  Inbound List Dialog Box

NOTE:
The Inbound List will display only the first 260 characters of the Remarks.  If there are more than 260  characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text. 

Table 3‑58  Inbound List Dialog Box Description

	Label
	Component
	Purpose

	Inbound List
	Scroll list
	Displays a summary list entry and icon for each flight plan on the Inbound List.

	Responsible FSS Filter
	Static text
	The Responsible FSS Filter that is being used to filter the list.  If it is set to “ALL”, then all entries are displayed on the list.  Otherwise, only entries whose Resp FSS field matches an Ident in the Responsible FSS Filter are displayed.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.  If two or more entries on the Inbound list have the same Aircraft ID, a number in parentheses will follow the Aircraft ID.  The value indicates the number of entries on the list that have the same Aircraft ID. 

	Flight Rules
	Column
	Flight rules of the flight plan.

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military 

ICAO:  V-VFR, I-IFR, Z-VFR/IFR, Y-IFR/VFR

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETA
	Column
	Estimated time of arrival; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight. 

	Resp. FSS
	Column
	Flight Service Station responsible for the flight plan. 

	Flight Plan Type
	Column
	Type of flight plan.  Domestic or ICAO.

	Origin
	Column
	Address of the facility responsible for the flight plan.

	Amend Time
	Button
	Displays a dialog box that allows the user to modify the ETA; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Retrieve Flight Plan
	Button
	Opens the selected (highlighted) flight plan from the Inbound List and displays it within the appropriate ICAO or Domestic Flight Plan window.  If there is more than one flight plan currently in the system with the same Aircraft ID, the Current Flight Plans window will be displayed with all of the matching flight plans.  The flight plan that was selected on the Inbound List will be highlighted in the Current Flight Plans window.  The user may press the ‘Enter’ key to retrieve the selected flight plan into the appropriate ICAO or Domestic Flight Plan window.

	Cancel Flight Plan
	Button
	Cancels the selected (highlighted) flight plan and removes the flight plan from the Inbound List and adds it to the History File.  Also displays a dialog box that allows the user to add a remark for history recording.

	Close Flight Plan
	Button
	Closes the selected (highlighted) flight plan and removes the flight plan from the Inbound List and adds it to the History File.  Also displays a dialog box that allows the user to add a remark for history recording.

	Transfer Flight Plan
	Button
	Transfers the selected flight plan(s) to the designated sparing facility.

	Add Flight Plan
	Button
	Accesses the Add Inbound Entry dialog box to manually add a flight plan to the Inbound List.


NOTE:
See the Facility Responsibility (Status Menu) section for instructions on how to set the Responsible FSS Filter.

To Open a Flight Plan XE "FlightPlan:Retrieve"  from the Inbound List:

1. <Click> the List menu.

2. <Select> the Inbound menu option to display the Inbound List window containing a (summary) list entry and icon for each flight plan on the Inbound List.

3. <Select> the desired Inbound flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Retrieve Flight Plan button.  The selected flight plan is displayed within the respective Flight Plan dialog box, ICAO or Domestic.

To Amend the ETA of a Flight Plan on the Inbound List:

1. <Click> the List menu.

2. <Select> the Inbound menu option to display the Inbound List window containing a (summary) list entry and icon for each flight plan on the site Inbound List.

3. <Select> the desired Inbound flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Amend Time button to display the Amend Time dialog box that allows the user to modify the ETA of a flight plan on the Inbound List

5. Enter the desired Estimated Time of Arrival in the Amend ETA text box.
6. <Click> the OK button.
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Figure 3‑90  Amend Time Dialog Box

To Cancel or Close a Flight Plan from the Inbound List:

1. <Click> the List menu.

2. <Select> the Inbound menu option to display the Inbound List dialog box containing a (summary) list entry and icon for each flight plan on the Inbound List.

3. <Select> the desired Inbound flight plan list entry.  The selected flight plan is highlighted.

4. <Click> either the Cancel Flight Plan or Close Flight Plan button to display a dialog box that allows the user to add a remark for history recording.

5. Enter any pertinent information desired for history recording in the Remarks text box.  The selected flight plan XE "Flight Plan:Filing"  is canceled or closed accordingly and removed from the Inbound List and added to the History File.
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Figure 3‑91  Close Flight Plan Dialog Box

To Add a Flight Plan (Inbound Entry) to the Inbound List:

1. <Click> the Add Flight Plan button on the Inbound List window.

2. Enter appropriate information in the text boxes.  Required fields are Flight Plan Type, Flight Rules, Aircraft ID, Destination, and ETA.

3. <Click> OK and the flight plan is added to the Inbound List.
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Figure 3‑92  Add (Flight Plan) Inbound Entry Dialog Box

Table 3‑59  Add Inbound Entry Dialog Box Description 

	Label
	Component
	Purpose

	Flight Plan Type
	Drop Down List Box
	Choose the Flight Plan Type: Domestic or ICAO.

	Flight Rules
	Drop Down List Box
	Choose the Flight Rules.  

Domestic:  VFR, IFR, DVFR, MIL VFR, MIL IFR, STEREO CVL, STEREO MIL, MIL IFR STOPOVER, MIL VFR STOPOVER, DVFR STOPOVER

ICAO:  VFR, IFR, VFR/IFR, IFR/VFR

	Aircraft ID
	Text Box
	Enter the 2 to 7 alphanumeric character Aircraft Identification.  The first character must be alphabetic.

	Aircraft Type
	Text Box
	Enter the aircraft type.  Domestic: 2 to 9 alphanumeric with an optional prefix and/or suffix separated by ‘/’.  ICAO: 2 to 4 alphanumeric.

	Departure
	Text Box
	Enter the departure location.  Domestic: 1 to 12 alphanumeric and ‘/’ characters.  ICAO: 4 character LOCID, or "ZZZZ".

	Destination
	Text Box
	Enter the destination location.  Domestic: 1 to 12 alphanumeric and ‘/’ characters.  ICAO: 4 character LOCID, or "ZZZZ".

	Remarks
	Text Box
	Enter any desired remarks: 0 to 325 characters. 

	Origin
	Text Box
	Enter the origin of the flight plan:  3 to 8 alphanumeric characters.  Defaults to the Responsible FSS selected at login.

	ETA
	Text Box
	Enter the Estimated Time of Arrival:  [dd]hhmm : dd=01-31, hh=00-23, mm=00-59.  

	OK
	Button
	Closes the dialog and accepts all changes. 


To Transfer XE "Transfer" \r "D2HBTransfer120"  One or More Flight Plans from the Inbound List:

1. <Click> the List menu.

2. <Select> the Inbound menu option to display the Inbound List window containing a (summary) list entry and icon for each flight plan on the site Inbound List.

3. <Select> the desired Inbound flight plan list entry or entries.  To select multiple entries, hold down the Ctrl key and <Click> each entry.  To select a continuous range of entries, <Click> the first entry in the range.  Then hold down the Shift key and <Click> the last entry in the range.  The selected flight plans are highlighted.

4. <Click> the Transfer Flight Plans button to display the Transfer Flight Plans dialog box.
5. Enter the 8 character address of the facility to which the flight plan(s) should be transferred.
6. <Click> OK and the selected flight plan(s) are queued for transmission.  
NOTE:
The selected flight plan messages will remain on the Inbound List until received and acknowledged by the receiving facility.  The receiving facility must be in the correct state to receive the message.
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Figure 3‑93  Transfer Flight Plans Dialog Box

3.7.2 Proposed (List Menu)

The Proposed List XE "Proposed List" \r "D2HBProposed_Lis121"  Menu option provides the capability to view all flight plans currently filed but not yet activated for the originating facility as well as those filed flight plans not yet sent to other facilities.  The Proposed menu option displays the Proposed List window from which the proposed flight plans can be Retrieved, Activated or Canceled. 

Flight plan entries on the Proposed List that are late by the Proposed Flight Plan Drop Interval will automatically drop off the Proposed List.  For a description of the Proposed Flight Plan Drop Interval see the Facility Parameters (Status Menu/ Parameters) section.
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Figure 3‑94  Proposed List Dialog Box

No alarms are generated for flight plans on the Proposed List. See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Proposed List is sorted by ETD from earliest to latest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.

NOTE:
An “!” next to the icon indicates that the flight plan contains remarks.

NOTE:
The Proposed List will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text.

Table 3‑60  Proposed List Dialog Box Description

	Label
	Component
	Purpose

	Proposed List
	Scroll list
	Displays a summary list entry and icon for each flight plan on the Proposed List.

	Responsible FSS Filter
	Static text
	The Responsible FSS Filter that is being used to filter the list.  If it is set to “ALL”, then all entries are displayed on the list.  Otherwise, only entries whose Resp FSS field matches an Ident in the Responsible FSS Filter are displayed.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.  If two or more entries on the Proposed list have the same Aircraft ID, a number in parentheses will follow the Aircraft ID.  The value indicates the number of entries on the list that have the same Aircraft ID. 

	Flight Rules
	Column
	Flight rules of the flight plan.

Domestic: V – VFR,     MV - Military VFR,     I – IFR,       MI - Military IFR,    DV – DVFR,       SC – Stereo Civil,       SM – Stereo Military     

ICAO:  V – VFR, I – IFR, Z – VFR/IFR, Y – IFR/VFR

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan is filed.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	ETD
	Column
	Estimated time of departure; ddhhmm : dd = 01-31, hh = 00-23, mm = 00-59

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	VFR Output Routing
	Column
	8 character Flight Service Station address indicating the tie in facility.

	IFR Output Routing
	Column
	8 character ARTCC address indication the tie-in facility.

	Closure Points
	Column
	3-8 A/N character addresses (maximum 16 addresses).

	Resp. FSS
	Column
	Flight Service Station responsible for the flight plan.

	Flight Plan Type
	Column
	Type of flight plan.  Domestic or ICAO.

	Origin
	Column
	Address of the facility responsible for the flight plan.

	Transfer Flight Plans
	Button
	Transfers the selected flight plan(s) to the designated sparing facility.

	Amend Time
	Button
	Displays a dialog box that allows the user to modify the ETD; [dd]hhmm : dd = 01-31, hh = 00-23, mm = 00-59.

	Retrieve Flight Plan
	Button
	Opens the selected (highlighted) flight plan from the Proposed List and displays it within the appropriate ICAO or Domestic Flight Plan window.  If there is more than one flight plan currently in the system with the same Aircraft ID, the Current Flight Plans window will be displayed with all of the matching flight plans.  The flight plan that was selected on the Proposed List will be highlighted in the Current Flight Plans window.  The user may press the ‘Enter’ key to retrieve the selected flight plan into the appropriate ICAO or Domestic Flight Plan window.

	Activate Flight Plan
	Button
	Activates the selected flight plan and removes the flight plan from the Proposed List and adds it to the Suspense List to await acknowledgment from the tie-in station.

	Cancel Flight Plan
	Button
	Cancels the selected (highlighted) flight plan and removes the flight plan from the Proposed List and adds it to the History File.  Also, displays a dialog box that allows the user to add a remark for history recording.


NOTE:
See the Facility Responsibility (Status Menu) section for instructions on how to set the Responsible FSS Filter.

To Open a Flight Plan XE "FlightPlan:Retrieve"  from the Proposed List:

1. <Click> the List menu.

2. <Select> the Proposed menu option to display the Proposed List dialog box containing a (summary) list entry and icon for each flight plan on the Proposed List.

3. <Select> the desired Proposed flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Retrieve Flight Plan button.  The selected flight plan is displayed within the appropriate ICAO or Domestic Flight Plan window.

To Amend the ETD of a Flight Plan on the Proposed List

1. <Click> the List menu.

2. <Select> the Proposed menu option to display the Proposed List window containing a (summary) list entry and icon for each flight plan on the Proposed List.

3. <Select> the desired Proposed flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Amend Time button to display the Amend Time dialog box that allows the user to modify the ETD of a flight plan on the Proposed List

5. Enter the desired Estimated Time of Departure in the Amend ETD text box.
6. <Click> the OK button.
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Figure 3‑95  Amend Time Dialog Box

To Activate a VFR Flight Plan from the Proposed List:

1. <Click> the List menu.

2. <Select> the Proposed menu option to display the Proposed List window containing a (summary) list entry and icon for each flight plan on the Proposed List.

3. <Select> the desired Proposed flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Activate Flight Plan button to display the Activate Flight Plan dialog box.

5. Enter the desired flight plan XE "FlightPlan:Retrieve"  activation time in the Time Activated text box.

NOTE:
The activation time may be in the past by no more than the value of the ETD Delay facility parameter.  See the Facility Parameters (Status Menu/Parameters) section for a description of this parameter.  The activation time may be up to 12 hours in the future.

6. Enter any pertinent information desired for history recording in the Remarks text box.

7. <Click> the OK button.  The selected flight plan is activated and removed from the Proposed List and added to the Suspense List XE "Suspense List" \r "D2HBSuspense_Lis124"  to await acknowledgment from the tie-in station.
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Figure 3‑96  Activate Flight Plan Dialog Box

To Cancel a Flight Plan from the Proposed List:

1. <Click> the List menu.

2. <Select> the Proposed menu option to display the Proposed List dialog box containing a (summary) list entry and icon for each flight plan on the Proposed List.

3. <Select> the desired Proposed flight plan list entry.  The selected flight plan is highlighted.

4. <Click> the Cancel Flight Plan button to display a dialog box that allows the user to add a remark for history recording.

5. Enter any pertinent information desired for history recording in the Remarks text box.  The selected flight plan is canceled accordingly, removed from the Proposed List and added to the History File.
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Figure 3‑97  Cancel Flight Plan Dialog Box

To Transfer XE "Transfer"  One or More Flight Plans from the Proposed List:

1. <Click> the List menu.

2. <Select> the Proposed menu option to display the Proposed List window containing a (summary) list entry and icon for each flight plan on the site Proposed List.

3. <Select> the desired Proposed flight plan list entry or entries.  To select multiple entries, hold down the Ctrl key and <Click> each entry.  To select a continuous range of entries, <Click> the first entry in the range.  Then hold down the Shift key and <Click> the last entry in the range.  The selected flight plans are highlighted.

4. <Click> the Transfer Flight Plans button to display the Transfer Flight Plans dialog box.

5. Enter the 8 character address of the facility to which the flight plan(s) should be transferred.

6. <Click> OK and the selected flight plan(s) are queued for transmission.  

NOTE:
The selected flight plan messages will remain on the Proposed list until received and acknowledged by the receiving facility.  The receiving facility must be in the correct state to receive the message.
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Figure 3‑98  Transfer Flight Plans Dialog Box

3.7.3 Suspense (List Menu)

The Suspense List menu option provides the capability to view all data transmitted to an external facility, requiring acknowledgment, that has not yet been acknowledged by the tie-in station.  Data that may appear on the Suspense List include flight plans, General Facility messages, Search and Rescue XE "Search and Rescue"  messages, NOTAMS, XE "NOTAM"  WMSCR XE "WMSCR"  requests, weather observations and PIREPS.  The Suspense List contains an entry for each message that is awaiting acknowledgment (roger) from a destination and lists all of the destination addresses for that message.  Within the Address Status list box, each address has a visual indicator associated with it indicating an address status as listed in the Suspense List Legend.  When the last address for an entry is acknowledged, the message is removed from the Suspense List.
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Figure 3‑99  Suspense List Legend

Table 3‑61  Suspense List Legend Definitions

	Label
	Component
	Purpose

	Green “NA”
	Icon
	No Action Required – The message was transmitted to this address.  No acknowledgement or further action is required from this address.

	Green checkmark
	Icon
	Acknowledged – The message was transmitted to this address.  An acknowledgement has been received from this address.

	Green ellipses, “…”
	Icon
	Not Yet Sent – The message has not yet been transmitted to this address.

	Yellow hour glass
	Icon
	Acknowledgement Required – The message was transmitted to this address and is awaiting an acknowledgement.

	Yellow star
	Icon
	Retransmitted – The message was transmitted to this address, but no acknowledgement was received.  The message was automatically retransmitted to this address.

	Yellow “M” with star
	Icon
	Retransmitted Manually – The message was transmitted to this address, but no acknowledgement was received.  A user manually retransmitted the message to this address, using the ReTransmit button.

	Red “X”
	Icon
	Rejected or Error – The message was transmitted to this address, but a reject message, error, or negative acknowledgement was received.

	Red “!”
	Icon
	Unable to Send – The system is not able to transmit the message to this address.


Each entry within the list has an icon associated with it.  The coloration of the icons defines the level of concern for each entry.  The level of concern is determined using the Transmit Time and a site definable parameter.  The specific site parameter that is used depends on the type of message being sent.  These parameters include the Air Traffic Control Response Time, Flight Service Station Response Time, DVFR Flight Plan Response Time, VFR Closure Time, and Default Message Response Time.  See the Facility Parameters (Status Menu/Parameters) section for a description of these parameters.

The title bar of the Suspense List turns the color of the entry within the list, which holds the highest priority.

If a message is not acknowledged within a time period equal to half the value of the relevant site parameter, it is automatically retransmitted and the address status is changed to Retransmitted.  When an error or reject is received from the ARTCC for a flight plan, the address status will indicate Rejected or Error.  The flight plan may be amended and resent to the responsible facility(s).  From the Suspense List dialog box, messages can be retransmitted (ReTransmit) or manually acknowledged (Ack).

Table 3‑62  Suspense List Icon Definitions

	Color
	Component
	Purpose

	Green
	Icon
	Response is not late or is late by less than half the value of the relevant parameter. (OK state)

	Yellow
	Icon
	Response is late by at least half the value of the relevant parameter. (Warning state)

	Red 
	Icon
	Response is late by the full value of the relevant parameter. (Overdue state)


An alarm will be generated whenever a message on the Suspense List becomes overdue (red icon).  An alarm will also be generated when OASIS is unable to transmit a message to one of the addresses in the message.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Suspense List is sorted by Transmit Time from earliest to latest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑100  Suspense List Dialog Box

Table 3‑63  Suspense List Dialog Box Description

	Label
	Component
	Purpose

	Suspense List
	Scroll list
	Displays a summary list entry and icon for each message on the Suspense List.

	Address Status List
	Scroll list
	Provides a visual (response) status for each address of the selected Suspense List entry indicating: No Action Required, Acknowledgement Required, Acknowledged, Retransmitted, Rejected or Error, Retransmitted Manually, Not Yet Sent, Unable to Send.

	Responsible FSS Filter
	Static text
	The Responsible FSS Filter that is being used to filter the list.  If it is set to “ALL”, then all entries are displayed on the list.  Otherwise, only entries whose Resp FSS field matches an Ident in the Responsible FSS Filter are displayed.

	Message ID
	Column
	ID of the transmitted message.  Same ID that will be returned in the roger message.  Used to match transmitted messages waiting for acknowledgement with roger messages.

	Message Type
	Column
	Identifies the type of general transaction message.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.  If two or more entries on the Suspense list have the same Aircraft ID, a number in parentheses will follow the Aircraft ID.  The value indicates the number of entries on the list that have the same Aircraft ID. 

	Resp. FSS
	Column
	Flight Service Station responsible for the flight plan.

	Origin
	Column
	Address of the facility responsible for the flight plan.

	Transmit Time
	Column
	Time the message was transmitted from the facility.  

	Address 1-16
	Columns
	Addresses of the station(s) receiving the message.

	ReTransmit
	Button
	Retransmits the message to the selected (highlighted) address.  The selected address must indicate Not Yet Sent, Acknowledgement Required, Retransmitted, Retransmitted Manually, Rejected or Error, or Unable to Send.

	Ack (Acknowledge)
	Button
	Manually acknowledges the message for the selected (highlighted) address.  The selected address must indicate Not Yet Sent, Acknowledgement Required, Retransmitted, Retransmitted Manually, Rejected or Error, or Unable to Send.

	Transfer Flight Plans
	Button
	Transfers the selected flight plan message(s) to the designated sparing facility. Only flight plan messages may be transferred.

	Retrieve Flight Plan
	Button
	Retrieves the selected flight plan if the Suspense List entry corresponds to a flight plan.  The selected flight plan is displayed within the appropriate ICAO or Domestic Flight Plan window.  If there is more than one flight plan currently in the system with the same Aircraft ID, the Current Flight Plans window will be displayed with all of the matching flight plans.

	General Facility Msg
	Button
	Displays the dialog box for recording and transmitting General Facility messages.

	Expand Entry
	Button
	Locks specific list item for edit or delete if it is a General Facility, NOTAM, Weather Observation, PIREP, WMSCR Request/Reply, or SAR message and the message has not yet been transmitted to any address.  Otherwise, the entry is expanded in a read-only format. When an entry is locked, no other user is allowed to view the expanded entry. Only one entry may be expanded at a time.

	Legend
	Group Label
	Defines the legend symbols.


NOTE:
See the Facility Responsibility (Status Menu) section for instructions on how to set the Responsible FSS Filter.

To Retransmit a Flight Plan Message to a Specified Address:

1. <Click> the List menu.

2. <Select> the Suspense menu option to display the Suspense List dialog box containing a (summary) list entry and icon for each message on the Suspense List.

3. <Select> the desired entry on the Suspense List.  The selected entry is highlighted.

4. <Select> an unacknowledged address from the Address Status scroll list. The selected address must indicate Not Yet Sent, Acknowledgement Required, Retransmitted, Retransmitted Manually, Rejected or Error, or Unable to Send.

5. <Click> the ReTransmit button.  The message is retransmitted to the selected address.

To Manually Acknowledge a Flight Plan Message for a Specified Address:

1. <Click> the List menu.

2. <Select> the Suspense menu option to display the Suspense List dialog box containing a (summary) list entry and icon for each message on the Suspense List.

3. <Select> the desired entry on the Suspense List.  The selected entry is highlighted.

4. <Select> an unacknowledged address from the Address Status scroll list.  The selected address must indicate Not Yet Sent, Acknowledgement Required, Retransmitted, Retransmitted Manually, Rejected or Error, or Unable to Send.

5. <Click> the Ack button.  The flight plan message is manually acknowledged for the selected address and the visual indicator will change to a check mark indicating that the message has been acknowledged.

To Retrieve a Flight Plan:

1. <Select> the Suspense list entry that corresponds with the Flight Plan you want to retrieve.

2. <Click> the Retrieve Flight Plan button on the Suspense List dialog box to display the Flight Plan in the flight plan mask.

To Edit a Selected Suspense List Entry:

1. <Select> the Suspense List entry you want to expand.

2. <Click> the Expand Entry button on the Suspense List dialog box to display the expanded Suspense List Entry Message.

OR

3. <Double-Click> on the selected Suspense List entry to display the expanded Suspense List Entry Message.

4. Make any desired edits in the Suspense List Entry text box.  If the entry is a General Facility, NOTAM, Weather Observation, PIREP, WMSCR Request/Reply, or SAR message and the message has not been transmitted to any address, then the item’s text will be editable.  Otherwise, the entry will be opened in a read-only format.

5. <Click> the Edit Entry button. The edited message will be transmitted immediately if the transmit time has passed or will be placed on the Suspense List and transmitted at the scheduled time.

NOTE: The message text field is the only field available for editing. In addition, no automatic formatting or validation will be performed on the edited message text.
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Figure 3‑101  Suspense List Entry – Expanded Dialog Box

Table 3‑64  Suspense List Entry -  Dialog Box Description

	Label
	Component
	Purpose

	Message Type
	Text Box
	Identifies the type of general transaction message.

	Transmit Time
	Text Box
	Lists the Transmit Time.

	Message Header
	Text Box
	Displays the expanded Suspense Message Header

	Message Text
	Text Box
	Displays the expanded Message Text.

	Print Entry
	Button
	Print out the selected message text

	Edit Entry
	Button
	Edits the Suspense List Entry.

	Delete Entry
	Button
	Deletes the Suspense List Entry.


To Delete a Selected Suspense List Entry:

1. <Select> the Suspense List entry you want to expand.

2. <Click> the Expand Entry button on the Suspense List dialog box to display the expanded Suspense List Entry Message.

OR

3. <Double-Click> on the selected Suspense List entry to display the expanded Suspense List Entry Message.

4. <Click> the Delete Entry button. The message will be deleted from the site’s Suspense List.

NOTE: When a NOTAM or PIREP message is deleted from the Suspense List, the NOTAM or PIREP tally is not modified.

To Transfer XE "Transfer" \r "D2HBTransfer131"  One or More Flight Plan Messages from the Suspense List:

1. <Click> the List menu.

2. <Select> the Suspense menu option to display the Suspense List window containing a (summary) list entry and icon for each flight plan on the site Suspense List.

3. <Select> the desired Suspense flight plan list entry or entries.  To select multiple entries, hold down the Ctrl key and <Click> each entry.  To select a continuous range of entries, <Click> the first entry in the range.  Then hold down the Shift key and <Click> the last entry in the range.  The selected messages are highlighted.

4. <Click> the Transfer Flight Plans button to display the Transfer Flight Plans dialog box.
5. Enter the 8 character address of the facility to which the flight plan message(s) should be transferred.
6. <Click> OK and the selected flight plan message(s) are queued for transmission. If one of the selected messages is not a flight plan message and cannot be transferred, a message dialog box will indicate this.

NOTE:
The selected flight plan messages will remain on the Suspense list until received and acknowledged by the receiving facility.  The receiving facility must be in the correct state to receive the message.
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Figure 3‑102  Transfer Flight Plans Dialog Box

3.7.4  XE "Facility Message:General" \r "D2HBFacility_Mes134" Facility Message (List Menu)

The Facility Message List contains four types of data: General Facility messages, Invalid Flight messages, Cancel/Close/Change ETA messages, and Sequence XE "Sequence:Define"  Definitions.  All four types of data are displayed within the same window.  This is a list of facility messages for the AFSS XE "AFSS"  that require special handling.

An alarm will be generated whenever a new message of any type is added to the Facility Message List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Facility Message List is sorted by Receipt Time from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑103  Facility Message List Dialog Box

Table 3‑65  Facility Message List Dialog Box Description

	Label
	Component
	Purpose

	Facility Message list
	Scroll List
	List facility messages for this AFSS that require special handling.

	Responsible FSS Filter
	Static text
	The Responsible FSS Filter that is being used to filter the list.  If it is set to “ALL”, then all entries are displayed on the list.  Otherwise, only entries whose Resp FSS field matches an Ident in the Responsible FSS Filter are displayed.

	Origin
	Column
	Facility that originated the message.

	Resp. FSS
	Column
	Flight Service Station responsible for the message.

	Receipt Time
	Column
	Time the message was received at this facility.

	Priority
	Column
	Message Priority: SS, DD, FF, GG.

	Description
	Column
	Description or summary of the message.

	Text
	Column
	Text of the message.

	Control Character Legend
	Group Label
	Defines the symbols used in the text messages.

	Icon Legend
	Group Label
	Defines the Icons used on the Facility Message list.

	Expand Entry
	Button
	Locks specific list item for edit or delete and opens the Edit Facility Message dialog box. When an entry is locked, no other user is allowed to view the expanded entry.  Only one entry may be expanded at a time.


NOTE:
See the Facility Responsibility (Status Menu) section for instructions on how to set the Responsible FSS Filter.
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Figure 3‑104  Facility Message List - Icon Legend

Table 3‑66  Facility Message List Icon Definition

	Icon
	Component
	Purpose

	 GF
	Icon
	General Facility – A General Facility message was received from an external facility.

	Bi-Plane with red “ban” symbol 
	Icon
	Invalid Flight Plan – A flight plan message was received which was invalid.

	Red “X” on top of a Bi-Plane 
	Icon
	Cancel/Closed/Changed ETA Matched – A flight plan Cancellation, Closure, or Change ETA message was received which matched an active flight plan.

	Red “X!” on top of a Bi-Plane 
	Icon
	Cancel/Closed/Changed ETA Unmatched – A flight plan Cancellation, Closure, or Change ETA message was received which did not match an active flight plan.

	“vs” above an eye
	Icon
	Saved Sequence Definition (Def.) – A Sequence Definition was received from an external facility and was stored successfully.

	“vs” above an eye with red “ban” symbol
	Icon
	Unsaved Sequence Def. – A Sequence Definition was received from an external facility and was not stored successfully due to a duplicate name or the maximum number of stored Sequence Definitions was reached.  An Unsaved Sequence Definition may be saved from the Facility Message list by cutting and pasting it into an Edit Sequence Definition window.  See the Sequence Definition section for further information.


To Edit a Facility Message:

1. <Click> the List menu.

2. <Select> the Facility Message menu option to display the Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <select> the message and <Click> the Expand Entry button to display the Edit Facility Message dialog box.

4. Make any desired edits in the Facility Message Text box.

5. <Click> the Edit Entry button.  The message will undergo validation as if it was just received from an external facility and will be processed accordingly.
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Figure 3‑105  Edit Facility Message Dialog Box

Table 3‑67  Edit Facility Message Dialog Box Description

	Label
	Component
	Purpose

	Description
	Text Box
	Message description text from the Facility Message list.

	Facility Message Text
	Text Box
	Editable message text from the Facility Message list.

	Create Flight Plan
	Button
	Used only for General Facility messages.   If the General Facility message (GFM) contains a flight plan formatted using 2 character identifiers, the GFM is parsed and the flight information is displayed in the Flight Plan dialog box.  Refer to the Flight Plan Identifiers Appendix for the valid two- character identifiers.

	General Facility Msg
	Button
	Creates a General Facility message.

	Print Entry
	Button
	Prints the current message.

	Edit Entry
	Button
	Edits the message text for a specific list entry.

	Delete Entry
	Button
	Deletes the current message from the Facility Message list.


NOTE:
Be careful not to delete any control characters.

To Transmit a General Facility Message:

1. <Click> the List menu.

2. <Select> the Facility Message menu option to display the Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <select> the message and <Click> the Expand Entry button to display the Edit Facility Message dialog box.

4. <Click> the General Facility Message button to display the Transmit General Facility Message dialog box.

5. Follow the steps outlined in the General Facility Message (Transmit Data XE "Transmit Data"  Menu) section to fill in the fields on the Transmit General Facility Message dialog box and transmit the message.

To Delete a General Facility Message:

1. <Click> the List menu.

2. <Select> the Facility Message menu option to display the Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <select> the message and <Click> the Expand Entry button to display the Edit Facility Message dialog box.

4. <Click> the Delete Entry button to delete the selected message from the Facility Message List.  The entry will be deleted from the site’s Facility Message List.

To Create a Flight Plan XE "Flight Plan:Create"  from a General Facility Message:

1. <Click> the List menu.

2. <Select> the Facility Message menu option to display the Facility Message List dialog box.

3. <Double-Click> on the desired General Facility Message from the list or <select> the message and <Click> the Expand Entry button to display the Edit Facility Message dialog box.

4. <Click> the Create Flight Plan button to display the ICAO/Domestic Flight Plan dialog box.  Data in the Facility Message text box will be parsed for flight plan fields, identified with two-character identifiers.  Any data that is found will be validated.  If any of the data is not in a valid format, an error message will be displayed in a message dialog box.  Correct the invalid data and press the Create Flight Plan button again.

5. The ICAO/Domestic Flight Plan window will be displayed with the flight plan data from the General Facility Message.  See the Create (Flight Plan Menu) section for further instructions.

NOTE:
For more information, refer to the Appendix of Flight Plan Field Identifiers.

3.7.5  XE "Search and Rescue" \r "D2HBSAR137" SAR (List Menu)

The SAR List menu option displays SAR messages. The specialist may expand a message to view the entry, perform a new search, or delete the entry.  An alarm will be generated whenever a new message is added to the SAR List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the SAR List is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑106  SAR List Dialog Box

NOTE: 
The carriage return linefeed sequences are denoted by a “¶” on the list.

Table 3‑68 SAR List Dialog Box Description

	Label
	Component
	Purpose

	SAR List
	Scroll List
	List of SAR messages transmitted or received by this AFSS.

	Responsible FSS Filter
	Static text
	The Responsible FSS Filter that is being used to filter the list.  If it is set to “ALL”, then all entries are displayed on the list.  Otherwise, only entries whose Resp. FSS field matches an Ident in the Responsible FSS Filter are displayed.

	SAR Type
	Column
	The type of SAR message: QALQ, INREQ, ALNOT, ALERFA, INCERFA, DETRESFA, or any of the corresponding Cancel types.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Origin
	Column
	Facility that originated the message.

	Receipt Time
	Column
	Time the message was received at this facility.

	Text
	Column
	Text of the message.

	Resp. FSS
	Column
	Flight Service Station responsible for the message.

	Expand
	Button
	Locks the item and opens the SAR Search dialog box. When an entry is locked, no other user is allowed to view the expanded entry.  Only one entry may be expanded at a time.


NOTE:  
See the Facility Responsibility (Status Menu) section for instructions on how to set the Responsible FSS Filter.

To Perform a New SAR Search:

1. <Click> the List menu.

2. <Select> the SAR menu option to display the SAR List dialog box.

3. <Double-Click> on the desired message from the list or <select> the message and <Click> the Expand button to display the Search and Rescue XE "Search and Rescue"  Information Request dialog box.

4. Make any desired edits in the Text box.

5. <Click> the New Search button.
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Figure 3‑107  SAR Search Dialog Box for Non-Cancelled SAR Type

Table 3‑69  SAR Search Dialog Box Description

	Label
	Component
	Purpose

	Start Time (for Date Range)
	Text Box
	Enter the start time for the time span of data to be reconstructed (mm/dd/yyyy hhmm).  Not available for SAR cancellations.

	Stop Time  (for Date Range)
	Text Box
	Enter the stop time for the time span of data to be reconstructed (mm/dd/yyyy hhmm).  Not available for SAR cancellations

	Aircraft ID
	Text Box
	Displays the Aircraft Identification from the SAR message on the SAR List 2-7 alphanumeric characters.  The first character must be alphabetic.

	Origin
	Text Box
	Displays the LOCID of the originating (sending) facility.

	Priority
	Drop-down List box
	Displays the message priority of the SAR message: SS, DD, FF, GG.

	SAR Type
	Drop-down List box
	Displays the type of SAR message.

	Text
	Text Box
	SAR message text. (read-only)

	New Search
	Button
	Initiates a search of the history database.  The results of the search are automatically displayed in a Transmit Search and Rescue dialog box to be transmitted to the originating facility.  Only available for non-cancelled SAR types.

	Delete Entry
	Button
	Deletes the entry from the SAR List.


To Delete a SAR Message:

1. <Click> the List menu.

2. <Select> the SAR menu option to display the SAR List dialog box.

3. <Double-Click> on the desired message from the list or <select> the message and <Click> the Expand  button to display the SAR Search dialog box.

4. <Click> the Delete Entry button.

3.7.6  XE "Weather Data" \r "D2HBWeather_Data140" Weather Data (List Menu)

The Weather Data option from the List menu displays invalid weather and NOTAM XE "NOTAM" 

 XE "NOTAM"  messages.  These messages can then be edited by the specialist.

An alarm will be generated whenever a new message is added to the Weather Data List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Weather Data List is sorted by Receipt Time from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑108  Weather Data List Dialog Box

NOTE:
The  “=” denotes a record separator in the weather message on the list. The carriage return linefeed sequences are denoted by a “¶” on the list.

Table 3‑70  Weather Data List Dialog Box Description

	Label
	Component
	Purpose

	Weather Data List
	Scroll List
	List of invalid Weather Data messages for that AFSS.

	WMO Hdr 
	Column
	Header of the message

	Receipt Time 
	Column
	Time the message was received at this facility.

	Description 
	Column
	Description or summary of the message.

	Text 
	Column
	Text of the message.

	Expand Entry
	Button
	Selects the specific weather message and expands the message in the Edit Weather Data dialog.  When an entry is expanded it is locked and no other user is allowed to view the expanded entry.  Only one entry may be expanded at a time.


To View the Weather Data List:

1. <Click> the List menu.

2. <Select> the Weather Data menu option to display the Weather Data List dialog box.

To Edit Weather Data:

1. <Click> the List menu.

2. <Select> the Weather Data menu option to display the Weather Data List dialog box.

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Edit Weather Data dialog box.

4. Make any desired edits to the message in the appropriate text boxes.

5. <Click> the Edit Entry button.  The message will undergo validation as if the message was just received from an external facility and will be processed accordingly.
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Figure 3‑109  Edit Weather Data Dialog Box

NOTE:
The  “=” indicates a record separator in the weather data message.

Table 3‑71  Edit Weather Data Dialog Box Description

	Label
	Component
	Purpose

	WMO Hdr
	Text Box
	Displays WMO header for list entry.

	Store as ICAO WX
	Check Box
	Indicates that this entry should be stored as an ICAO product.

	Description 
	Text Box
	Indicates what is wrong with the Weather Message.

	Text
	Text Box
	Editable text message for Weather Data list entry

	Print Entry 
	Button
	Prints the expanded weather data message.

	Edit Entry
	Button
	Edits the message text for a specific list entry.

	Delete Entry
	Button
	Deletes the currently selected list entry from the Weather Data List. 


To Delete Weather Data:

1. <Click> the List menu.

2. <Select> the Weather Data menu option to display the Weather Data List dialog box.

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Edit Weather Data dialog box.

4. <Click> the Delete Entry button to delete the selected message from the Weather Data List.  The entry will be deleted from the site’s Weather Data List.

3.7.7 Law Enforcement (List Menu)

The Law Enforcement menu option displays the Law Enforcement List dialog box.  These messages flag stolen aircraft.  Upon receiving  a Law Enforcement message, the facility’s history data will automatically be reviewed to determine the contact status of the aircraft.  Every flight transaction will be checked against the contact history for matches.  Invalid messages are added to the Facility Message XE "Facility Message:General"  List.  The specialist must correct the message or contact EPIC for retransmission.

Each entry within the list has an icon associated with it.  The coloration of the icons defines the level of concern of each entry.  The level of concern is based on whether the facility has had contact with the aircraft.

The title bar of the Law Enforcement List turns the color of the entry within the list, which holds the highest level of concern.

Table 3‑72  Law Enforcement Icon Definition

	Color
	Component
	Purpose

	Green
	Icon
	Signifies the Aircraft ID was not found in the database.

	Yellow
	Icon
	Signifies the Aircraft ID was found in the database and has been reset.

	Red
	Icon
	Signifies the Aircraft ID was found in the database and remains active.


An alarm will be generated whenever a match occurs for an entry on the Law Enforcement List (red icon).  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Law Enforcement List is sorted alphabetically by Aircraft ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑110  Law Enforcement List Dialog Box

Table 3‑73  Law Enforcement List Dialog Box Description

	Label
	Component
	Purpose

	Law Enforcement List
	Scroll List
	Display a summary list entry and icon for each message on the Law Enforcement List.

	Aircraft ID 
	Column
	Displays the Aircraft Identification.  2-7 A/N characters.

	Law Enforcement Message 
	Column
	Contents of the message. 

	Reset Entry
	Button
	Resets the selected law enforcement message from the scroll list. 

	Delete Entry
	Button
	Deletes the selected law enforcement message from the scroll list.


To Expand a Law Enforcement List Entry:

1. <Click> the List Menu.

2. <Select> the Law Enforcement menu option to display the Law Enforcement List dialog box.  

3. <Select> the Law Enforcement List entry to expand.  The expanded view of the message will be displayed below the scroll list.

To Reset a Law Enforcement Message List Entry:

1. <Click> the List Menu.

2. <Select> the Law Enforcement menu option to display the Law Enforcement List dialog box.

3. <Select> the desired message to be reset.  The selected message is highlighted.

4. <Click> the Reset Entry button to reset the selected message from the Law Enforcement List.

NOTE:
Only messages that have an active match (red icon) can be reset.

To Delete a Law Enforcement Message List Entry:

1. <Click> the List Menu.

2. <Select> the Law Enforcement menu option to display the Law Enforcement List dialog box.  

3. <Select> the desired message to be deleted.  The selected message is highlighted.

4. <Click> the Delete Entry button to delete the selected message from the Law Enforcement List.

3.7.8 Contact (List Menu)

The Contact menu option displays the Contact List dialog box.  This list displays the most recent Inflight, Flight Watch or both types of  contacts that have been logged at the facility.  The option to display Inflight, Flight Watch or both types of contacts can be modified by changing the contact configuration value.  For information about how to change this value see the section on User Parameters. XE "User Parameters" 
The  Contact List provides the capability to Create or Retrieve a flight plan XE "Flight Plan:Create" 

 XE "FlightPlan:Retrieve"  corresponding to a contact on the list (See Briefing Log Section).

No alarms are generated for flight plans on the  Contact List. See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Contact List is sorted by Time Stamp from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑111  Contact List Dialog Box

NOTE:
The Contact List will display only the first 260 characters of the Remarks.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item can be expanded to view the remaining text.

NOTE:
The Max. Number of Entries tells the user how many entries will be displayed on the Contact List.  The most recent entries will be displayed.  For information about how to change this value see the section on User Parameters.  

Table 3‑74 Contact List Dialog Box Description

	Label
	Component
	Purpose

	Contact List
	Scroll list
	Displays a summary list entry for each Inflight and Flight Watch briefing log performed.

	Aircraft ID
	Column
	Aircraft Identification.  2-7 A/N characters.

	Time Stamp
	Column
	Displays the time of action.

	User ID
	Column
	Displays User ID.

	Aircraft Type
	Column
	Aircraft type designator.  Domestic - 2-9 A/N and slash characters.  ICAO - 2-4 A/N characters.

	Flight Rules
	Column
	Flight rules of the flight plan.

Domestic:  V-VFR, I-IFR, DV-DVFR, MV-Military VFR, MI-Military IFR, SC-Stereo Civil, SM-Stereo Military, MIS-Military IFR Stopover, MVS-Military VFR Stopover, DVS-DVFR Stopover.  

	Flight Plan Type
	Column
	Displays the type of weather briefing, Domestic or ICAO.  

	Log Type
	Column
	Displays the type of contact that was logged.

	Type of Service
	Column
	Displays the combinations of type of service logged:

Single Item, PWB, Multi Leg, Airport Advisory, Radio Contact, Aircraft Contact.

	Multi Legs
	Column
	Displays the number of Multi Legs: 0 through 10

	Type of Flight
	Column
	General Aviation, Military, Air Carrier or Air Taxi

	Departure
	Column
	Name or identifier of the departure airport or point over which the flight plan was filed for or activated.

	Destination
	Column
	Destination airport or point over which the flight plan is to be canceled.

	Remarks
	Column
	Information necessary for ATC purposes or to assist search operations plus any other data appropriate to the flight.

	Frequency
	Column
	Radio frequency (0 to 7 alphanumerics, slashes, and/or periods).

	Create Flight Plan
	Button
	Provides the option to create a flight plan from information contained in a historical flight plan entry in the dialog box.

	Retrieve Flight Plan
	Button
	Opens the selected flight plan.


To Retrieve a Flight Plan from the Contact List:

1. <Click> the List Menu.

2. <Select> the Contact menu option to display the Contact List dialog box.

3. <Select> the Contact List entry to retrieve.

4. <Click> the Retrieve Flight Plan button.  The selected Flight Plan is displayed within the appropriate ICAO or Domestic Flight Plan dialog box.

To Create a Flight Plan from the Contact List:

1. <Click> the List Menu.

2. <Select> the Contact menu option to display the Contact List dialog box.

3. <Select> the Contact List entry to retrieve.

4. <Click> the Create Flight Plan button.  The new Flight Plan is displayed within the appropriate ICAO or Domestic Flight Plan dialog box using the information from the Contact List.

3.7.9  XE "Facility Message:General" \r "D2HBFacility_Mes150" Internal Facility Message (List Menu)

The Internal Facility Message List contains messages received from another user within the same AFSS, XE "AFSS"  including remote workstations.  The list can contain two types of messages: unread messages which are noted by a closed envelope icon in the Sender column, and read messages which are noted by an opened envelope icon in the Sender column.  The Internal Facility Message List will be opened in an iconified state upon login if the user has one or more unopened messages in the list.

An alarm will be generated whenever a new Internal Facility Message is added to the Internal Facility Message List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Internal Facility Message List is sorted by Receipt Time from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑112   Internal Facility Message List Dialog Box 

Table 3‑75 Internal Facility Message List Dialog Box Description

	Label
	Component
	Purpose

	Internal Facility List
	Scroll list
	Lists Internal Facility messages for the logged in user.

	Sender
	Column
	Displays the user ID of the sender of the message.

	Receipt Time
	Column
	Displays the receipt time of the message.

	Subject
	Column
	Displays the subject of the message.

	Expand Entry
	Button
	Opens the Internal Facility message list entry.  Only one entry may be expanded at a time.


NOTE:  
The list can contain up to twenty messages.  The oldest message will be overwritten if a new message is received.  If messages are not overwritten they will remain on the list unless manually deleted.

To Expand an Internal Facility Message:

1. <Click> the List menu.

2. <Select> the Internal Facility Message menu option to display the Internal Facility Message List dialog box. 

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Internal Facility Message Entry dialog box.
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Figure 3‑113   Internal Facility Message Entry Dialog Box

Table 3‑76  Internal Facility Message Entry Dialog Box Description

	Label
	Component
	Purpose

	Sender
	Text Box
	Displays the user ID of the sender of the message.  (Read Only)

	Receipt Time
	Text Box
	Displays the receipt time of the message.  (Read Only)

	Subject
	Text Box
	Displays the subject of the message.  (Read Only)

	Internal Facility message Text
	Text Box
	Message text.  (Read Only)

	Reply
	Button
	Creates an Internal Facility message and populates the Addresses field with the sender’s ID and the Subject field with the original message subject.  [The Address Type field is set to Users.]

	Forward
	Button
	Creates an Internal Facility message and populates the Subject field with the original message subject and the Internal Facility message text field with the original message text.  [The Address Type field is set to Users.]

	General Facility Msg
	Button
	Creates a General Facility message and populates the General Facility message field with the original message text.

	Print Entry
	Button
	Prints the current message.

	Delete Entry
	Button
	Deletes the current message from the Internal Facility message list.


To Reply to an Internal Facility Message:

1. <Click> the List menu.

2. <Select> the Internal Facility Message menu option to display the Internal Facility Message List dialog box.

3. <Double-click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Internal Facility Message Entry dialog box.

4. <Click> the Reply button to display the Transmit Internal Facility Message dialog box.   The Addresses field will be populated with the sender’s ID and the Subject field with the original message subject.   The Address Type field is set to Users.

5. Follow the steps outlined in the Internal Facility Message (Transmit Data XE "Transmit Data" \r "D2HBTransmit_Dat155"  Menu) section to fill in the remaining fields on the Transmit Internal Facility Message dialog box and transmit the message.

To Forward  an Internal Facility Message:

1. <Click> the List menu.

2. <Select> the Internal Facility Message menu option to display the Internal Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Internal Facility Message Entry dialog box.

4. <Click> the Forward button to display the Transmit Internal Facility Message dialog box.   The Subject field will be populated with the original message subject and the Internal Facility Message field with the original message text.  The Address Type field is set to Users.

5. Follow the steps outlined in the Internal Facility Message (Transmit Data Menu) section to fill in the remaining fields on the Transmit Internal Facility Message dialog box and transmit the message.

To Transmit a General Facility Message:

1. <Click> the List menu.

2. <Select> the Internal Facility Message menu option to display the Internal Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Internal Facility Message Entry dialog box.

4. <Click> the General Facility Message button to display the Transmit General Facility Message dialog box.  The General Facility Message field will be populated with the original message text.

5. Follow the steps outlined in the General Facility Message (Transmit Data Menu) section to fill in the fields on the Transmit General Facility Message dialog box and transmit the message.

To Delete an Internal Facility Message:

1. <Click> the List menu.

2. <Select> the Internal Facility Message menu option to display the Internal Facility Message List dialog box.

3. <Double-Click> on the desired message from the list or <Select> the message and <Click> the Expand Entry button to display the Internal Facility Message Entry dialog box.

4. <Click> the Delete Entry button to delete the selected message from the Internal Facility Message List.  The entry will be deleted from the Internal Facility Message List.  

3.7.10  XE "WMSCR" \r "D2HBWMSCR151" WMSCR Updates (List Menu)

The WMSCR Updates menu option provides the capability to view the WMSCR messages that have been requested via the WMSCR Transmit Request.  The WMSCR Request/Reply Updates List dialog box provides the capability to expand an entry from the list in order to view the entire contents of the message or delete entries from the list.

An alarm will be generated whenever a new message is added to the WMSCR Updates List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the WMSCR Updates List is sorted by Time from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑114  WMSCR Request/Reply Updates List Dialog Box

NOTE:
The WMSCR Request/Reply List will display only the first 260 characters of the Message Text.  If there are more than 260 characters, 256 characters followed by a "..." will appear.   The item should be expanded to see the remaining text.

NOTE:
The  “=” denotes a record separator in the WMSCR message on the list and in the expanded text box.  The carriage return linefeed sequences are denoted by a “¶” on the list.

Table 3‑77  WMSCR Request/Reply Updates List Dialog Box Description

	Label
	Component
	Purpose

	WMSCR Request/

Reply Updates List
	Scroll List
	List of Request/Reply messages received from WMSCR.

	Type 
	Column
	The Request/Reply type of the message

	Time 
	Column
	The time the message was received at the facility.

	Store 
	Column
	Store the report when received.

	Site 
	Column
	Yes=Displayed to entire facility.  No=Displayed to current user only.

	More 
	Column
	More of the Message Text available with Expand Entry.

	Message Text 
	Column
	Text of the message.

	Expanded Entry Text 
	Text Box
	Displays the expanded text of the WMSCR message from the scroll list

	Delete Entry
	Button
	Deletes the selected entries from the scroll list.

	Delete All
	Button
	Deletes all messages from the scroll list.

	Expand Entry
	Button
	Expands the list item into the Expanded Entry text box.


To Expand a WMSCR Request/Reply Updates List Entry:

1. <Click> the List Menu.

2. <Select> the WMSCR Updates menu option to display the WMSCR Request/Reply Updates List dialog box.  

3. <Select> the entry to be expanded.

4. <Click> the Expand Entry button to expand the entry.

NOTE:
If the More column is set to Yes for an entry, all of the message text will be displayed when the entry is expanded.

To Delete a WMSCR Request/Reply Updates Entry:

1. <Click> the List Menu.

2. <Select> the WMSCR Updates menu option to display the WMSCR Request/Reply Updates List dialog box.  

3. <Select> the desired entry. 

4. <Click> the Delete Entry button.  The selected entry is deleted.

3.8  XE "Reports" Reports

The Reports menu provides the capability to reconstruct historical information back approximately 15 days and generate Local Activity Reports for a site or user.
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Figure 3‑115  Reports Menu

To Display the Reports Menu:

1. <Click> the Reports menu.

3.8.1  XE "Event Reconstruction" Event Reconstruction (Reports Menu)

The Event Reconstruction menu option provides the capability to reconstruct historical data including: Flight Data Transmitted and Received, Weather Data XE "Weather Data"  Transmitted and Received, and user transactions, (User Request, User Response, User Request/Response).  Data is available for approximately 15 days.  Flight Data Transmitted indicates flight data (Service B data) transmitted from the local facility to an external facility, such as an IFR flight plan XE "Flight Plan:Filing"  to an ARTCC.  Flight Data Received indicates any flight data (Service B data) received into the local system from an external system, e.g., flight plan received from another AFSS. XE "AFSS"   Weather Data Transmitted indicates weather data transmitted from the local facility to WMSCR, such as a PIREP. XE "PIREP"   Weather Data Received indicates weather data received from WMSCR.  A User Request is a transaction that a user performs, e.g., filing a flight plan.  A User Response indicates the result of the request, such as flight plan filed.  The Event Reconstruction menu option displays the Event Reconstruction Request dialog box to specify the type and time parameters for a report.  The Event Reconstruction Report may be printed or saved as a file.
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Figure 3‑116  Event Reconstruction Request Dialog Box

Table 3‑78  Event Reconstruction Request Dialog Box Description

	Label
	Component
	Purpose

	History Type
	Drop-down List Box
	Select the type of history data to be retrieved.  History Types include Flight Data Transmitted, Flight Data Received, Weather Data Transmitted, Weather Data Received, User Request/Response, User Request, and User Response.

	Start Time (for Date Range)
	Text Box
	Enter the start time for the time span of data to be reconstructed (mm/dd/yyyy hhmm time).

	Stop Time  (for Date Range)
	Text Box
	Enter the stop time for the time span of data to be reconstructed (mm/dd/yyyy hhmm time).

	Aircraft ID 
	Text Box
	Optional history filter. Aircraft Identification.  2-7 A/N characters, first must be alphabetic.  Available for Flight Data and User transactions only.  For Flight Data transactions, in order for a particular message to be included in the report, the value entered must be a substring of the Aircraft ID in that message.  For User transactions, in order for a particular message to be included in the report, the value entered must exactly match the Aircraft ID in that message.

	User ID 
	Text Box
	Optional history filter.  1-15 alphanumeric characters.  Available for User transactions only.  In order for a particular message to be included in the report, the value entered must exactly match the User ID in that message.

	Workstation ID 
	Text Box
	Optional history filter.  1 to 8 characters.  Available for User transactions only.  In order for a particular message to be included in the report, the value entered must be a substring of the Workstation ID in that message.  

	Search String 
	Text Box
	Optional history filter.  Up to 30 characters.  Available for Flight Data and Weather Data transactions only. In order for a particular message to be included in the report, the string entered must appear as a substring of the text in that message.  The search is case sensitive.

	Pilot Data 
	Text Box
	Optional history filter.  2 to 30 characters. Available for User transactions only.  In order for a particular message to be included in the report, the value entered must be a substring of the Pilot Data in that message.

	Report Filters
	Group Label
	Displays either the Message Types or Weather Reports dialog boxes.

	Message Type
	Button
	Available for User transactions.  Displays the Message Types dialog box.

	Weather Rpts
	Button
	Available for Weather Data Transmitted and Received.  Displays the Report Types dialog box.

	OK
	Button
	Requests an Event Reconstruction Report based on the information entered.  Up to 1500 records may be retrieved.


Message Types XE "Message Type"  Dialog Box

The Message Types dialog box is used for the reconstruction of user transactions.  Refer to the Appendix of Message Types for a list of the user actions that correspond to each message.

[image: image149.png]I” 0B Lockip.

I™ Decode.

I~ Ercode

I FaciiyLog

I Focily Responsiity
I FightData

I FightPlan

I™ Furcional Posiion
I Hitoy

I st

™ LocalAciviy Rt

Other
I~ et Notcaton.

™ Auto Updste

I Log Contact Bieing

I LogFight Walch Bieing
I LoginfiohtBieing

™ Log Prfigh Bifg

I LogiLogelf

I~ PrefenedRase.

™ SAR Seach

™ Trensri Il Facity
™ TrensrikNADIN

T Trensrt WXINOTAM
™ View Sequence.

I WMSCR Expanded Data
I™ WMSCR Transmit.

A1 Reguests

™ KeyData Update
I™ WMSCR Update

Resporse Messapes:
I Ao Updste 56l

I~ Bieing

I Change Password
I” 0B Lockup

I Decode

I~ Encode

I Focity Log

I~ Focily Responsbity
I FightData

I FightPlan

I Functona Poston
I Hitoy

I Lt

™ LocalActiviy Rt

sotn | o]

I Log Contact Bieing

I Log Fight Watch Bieing
I Loginfigh Being

I Log Preloh Bieing

I Logn/Logall.

I Prefened oute

I 4R Search

™ Treneni It Faciy
I Trensmit NADIN

™ Tansmit WXINDTAM
I ViewSequence.

™ \WMSCR Expanded Data
I~ \WMSCR Tt

A Regponses|

Concel Heb





Figure 3‑117  Message Types Dialog Box

Table 3‑79  Message Types Dialog Box Description

	Label
	Component
	Purpose

	Request Messages
	Group Label


	Check Boxes allow user to select Request Message type(s) for queries.  (See below)

	All Requests
	Button
	Select to run reports for all request types.

	Response Messages
	Group Label


	Check Boxes allow user to select Response Message type(s) for queries.  (See below)

	All Responses
	Button
	Select to run reports for all response types.

	Auto Update Sel
	Check Box
	Select to include Auto Update Selection messages in report.

	Briefing
	Check Box
	Select to include Briefing messages in report.

	Change Password
	Check Box
	Select to include Change Password messages in report.

	DB Lookup
	Check Box
	Select to include Database Lookup messages in report.

	Decode
	Check Box
	Select to include Decode messages in report.

	Encode
	Check Box
	Select to include Encode messages in report.

	Facility Log
	Check Box
	Select to include Facility Log Data messages in report.

	Facility Responsibility
	Check Box
	Select to include Facility Responsibility messages in report.

	Flight Data
	Check Box
	Select to include Flight Data messages in report.

	Flight Plan
	Check Box
	Select to include Flight Plan messages in report.

	Functional Position
	Check Box
	Select to include Functional Position messages in report.

	History
	Check Box
	Select to include History messages in report.

	List
	Check Box
	Select to include List messages in report.

	Local Activity Rpt
	Check Box
	Select to include Local Activity Report messages in report.

	Log Contact Briefing
	Check Box
	Select to include Log Contact Briefing messages in report.

	Log Flight Watch Briefing
	Check Box
	Select to include Log Flight Watch Briefing messages in report.

	Log Inflight Briefing
	Check Box
	Select to include Log Inflight Briefing messages in report.

	Log Preflight Briefing
	Check Box
	Select to include Log Preflight Briefing messages in report.

	Login/Logoff
	Check Box
	Select to include Login/Logoff messages in report.

	Preferred Route
	Check Box
	Select to include Preferred Route messages in report.

	SAR Search
	Check Box
	Select to include SAR Search messages in report.

	Transmit Internal Facility 
	Check Box
	Select to include Transmit Internal Facility messages in report.

	Transmit NADIN
	Check Box
	Select to include Transmit NADIN messages in report.

	Transmit WX/NOTAM
	Check Box
	Select to include Transmit WX/NOTAM messages in report.

	WMSCR Expanded Data
	Check Box
	Select to include WMSCR Expanded Data messages in report.

	WMSCR Transmit
	Check Box
	Select to include WMSCR Transmit messages in report.

	View Sequence
	Check Box
	Select to include View Sequence messages in report.

	Other
	Group Label
	Allows selection of additional message types.

	Alert Notification
	Check Box
	Select to include Alert Notification messages in report.

	Auto Update
	Check Box
	Select to include Auto Update messages in report.

	Key Data Update
	Check Box
	Select to include Key Data Update messages in report.

	WMSCR Update
	Check Box
	Select to include WMSCR Update messages in report.

	Select All
	Button
	Check here to generate report on all message types.


Report Types Dialog Box

The Report Types dialog box is used for reconstruction of Weather Data XE "Weather Data"  Transmitted and Weather Data Received.
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Figure 3‑118  Report Types Dialog Box

Table 3‑80  Report Types Dialog Box Definitions

	Label
	Component
	Purpose

	Current Reports
	Group Label
	Defines current weather products.

	
	METAR
	Selects Aviation Routine Weather Reports.

	
	TW
	Selects Trend Weather Report (last three hours of METARs).

	
	SD
	Selects Radar Weather Reports.

	
	UA
	Selects Pilot Reports.

	
	NO
	Selects NOTAMs.

	
	FDC
	Selects FDC NOTAMs.

	Warnings
	Group Label
	Defines weather-warning products.

	
	WA
	Selects AIRMET Reports.

	
	WH
	Selects Hurricane Advisories.

	
	WS 
	Selects SIGMET Reports. 

	
	WST
	Selects Convective SIGMET Reports.

	
	WW 
	Selects Severe Weather Watch Bulletins (WWs) and Alert Messages (AWWs).

	Forecasts
	Group Label
	Defines weather forecast products.

	
	FA
	Selects Area Forecast Reports.

	
	FD
	Selects Winds and Temperatures Aloft Reports.

	
	TAF
	Selects Terminal Aviation Forecast Reports.

	Aeronautical
	Group Label
	Not available.

	
	ATCSCC
	Not available.

	
	SUA
	Not available.

	Active SUA
	Group Label
	Not available.

	
	IR
	Not available.

	
	MOA
	Not available.

	
	VR
	Not available.

	Other
	Group Label
	Defines other weather products.

	
	AC
	Selects Convective Outlook Reports.

	
	CWA
	Selects Center Weather Advisory Reports.

	
	SYNS
	Selects TWEB Synopsis Products.

	
	TWEB
	Selects Transcribed Weather Broadcasts.

	International Weather
	ICAOWX
	Selects International Weather Reports.

	Select All
	Button
	Selects all of the currently available listed reports.


To Display an Event Reconstruction Report:

1. <Click> the Reports menu.

2. <Select> the Event Reconstruction menu option to display the Event Reconstruction Request dialog box.

3. <Select> the desired History Type from the drop-down list box.  The selected type of history data is displayed within the list box.

4. Enter the Start Time and Stop Time for the time frame of history data to be reconstructed.  Time frame limits are restricted on different types of history data to limit the volume of data that can be returned.

5. Enter a Search String, Aircraft ID, User ID, Pilot Data and/or Workstation ID as necessary, to filter the report (Optional).

NOTE:
If the User ID or Workstation ID filter is used, messages that apply only to that user or workstation will be displayed.  If either of these filters is used, messages in the Other category of the Message Types XE "Message Type"  dialog box will not be included in the report.  

6. <Click> on either the Message Type or Weather Rpts button to access the corresponding dialog boxes.

7. <Click> the OK button.  All retrieved data is displayed in the Event Reconstruction Report dialog box.
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Figure 3‑119  Event Reconstruction Report Dialog Box

Table 3‑81  Event Reconstruction Report Dialog Box Description

	Label
	Component
	Purpose

	Filter Criteria
	Group Label
	Static Text displays the parameters entered in the Event Reconstruction Request dialog box, including the History Type, Start Time, Stop Time, Aircraft ID, User ID, Workstation ID, Search String, and Pilot Data.  Also displays the message types selected from the Message Types dialog box or the weather report types selected from the Report Types dialog box.

	Summary Data List
	List Box
	Displays summary information about each history entry.

	History Type
	Column
	Type of history: Flight Data Received, Flight Data Transmitted, Weather Data Received, Weather Data Transmitted, User Request, or User Response.

	User ID
	Column
	User ID of the user that made the request or received the response.  Displayed only for User Transactions.

	Workstation ID
	Column
	Workstation the user was logged into when the request or response was made.  Displayed only for User Transactions.

	Message Type
	Column
	Type of user transaction.  Displayed only for User Transactions.

	Time Stamp
	Column
	Time the message was generated.

	Summary Data
	Column
	Brief summary of the history entry.

	Expanded Data Text Box
	Text Box
	Displays expanded data for one or more history entries when the Expanded Data button is pressed.

	Expanded Data
	Button
	Retrieves expanded data for the selected history entries.

	New Request
	Button
	Closes the Event Reconstruction Report dialog box and opens the Event Reconstruction Request dialog box to allow a new report to be generated. 

	Save As…
	Button
	Displays the Event Reconstruction Report Save As dialog box to allow the report to be saved to disk.  The saved report includes the contents of the Expanded Data Text Box, as well as the Filter Criteria and all the information that appears on the first page of a printed report.  This ability is only available on the Extended Capabilities Workstation (ECWS).


To Display Expanded Data for One or More History Entries:

1. <Select> the desired history entry or entries.  To select multiple entries, hold down the Ctrl key while clicking each entry.  To select a continuous range of entries, click the first entry in the range.  Then hold down the Shift key while clicking the last entry in the range.  The selected entries are highlighted.

2. <Click> the Expanded Data button to retrieve detailed data for the highlighted entries.

NOTE:
Special sections in the expanded data of an Event Reconstruction Report are labeled “Internal Info.”  These sections contain diagnostic information for the OASIS system.  This information is not entered or viewed by the specialist, but can be used to diagnose internal system problems.  When an Event Reconstruction Report containing expanded data is printed, the following disclaimer is printed on the first page of the report: "Sections labeled "Internal Info" and enclosed in brackets contain diagnostic information for the OASIS system.  These sections do not constitute part of the Event Reconstruction Report."

NOTE:  The first page of a printed Event Reconstruction Report also contains a signature section that may be used to certify the contents of the report.

To Save an Event Reconstruction Report:

1. <Select> the desired history entry or entries.  To select multiple entries, hold down the Ctrl key while clicking each entry.  To select a continuous range of entries, click the first entry in the range.  Then hold down the Shift key while clicking the last entry in the range.  The selected entries are highlighted.

2. <Click> the Expanded Data button to retrieve detailed data for the highlighted entries.

3. <Click> the Save As… button.  The Event Reconstruction Report Save As dialog box is displayed.

4. <Select> the desired directory from the Save in drop-down list box and enter the filename in the File name text box.

5. <Click> the Save button.  The file is saved in the selected directory and the dialog box is closed.

NOTE:
This ability is only available on the Extended Capabilities Workstation (ECWS).

NOTE:
The saved Event Reconstruction Report may be viewed in WordPad or Microsoft Word.  If the report is printed using WordPad, it may be necessary to first decrease the left and right margins using the Page Setup dialog box within WordPad.
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Figure 3‑120  Event Reconstruction Report Save As Dialog Box

Table 3‑82  Event Reconstruction Report Save As Dialog Box Description

	Label
	Component
	Purpose

	Save in
	Drop-down List Box
	Select the desired directory.

	File Listing
	Display Box
	Lists the folders and files under the specified directory.

	File name
	Text Box
	Enter the desired file name to be saved.

	Save as type
	Drop-down List Box
	Select the desired file type/extension.

	Save
	Button
	Saves the new file name in the selected directory.


3.8.2  XE "Reports" \r "D2HBReports161" Local Activity (TALLY)  (Reports Menu)

The Local Activity (Tally) menu option displays the Local Activity Report Request dialog box and provides the capability to request Facility, User, DUAT, XE "DUAT" \r "D2HBDUAT159"  Workstation Position Log and User Position Log reports.  The Facility option returns a report for local AFSS XE "AFSS"  site activity.  The User option returns a report on user activity for the local AFSS site.  The DUAT option returns a report on activity for an AFSS configured as a DUAT site.  These reports include information on the tally of Preflight, Inflight and Flight Watch briefing log data and Domestic or ICAO flight plan actions.

The remaining options in the Local Activity  (TALLY) Report Type include the Workstation Position Log and User Position Log report types.  The Workstation Position Log option returns a report on all of the workstations at the AFSS site.  The User Position Log option returns a report on all users at the AFSS site.  The position log tally reports are based on login and logoff information.

When a report is generated and there is no corresponding logoff for a login then the time between the login and the end of the report period will be displayed for the total time.  It will be indicated on the report that a logoff wasn't detected by placing a ">" after the logoff text (i.e. LOGOFF >).  When a report is generated and there is no corresponding login for a logoff then the time from the beginning of the report period to the logoff will be displayed for the total time.  It will be indicated on the report that a login wasn't detected by placing a "<" before the login text on the report (i.e. < LOGIN).

In addition, the term "Not Available" will sometimes be listed where the functional position XE "Functional Position"  would be shown.  This is indicated on the report when a functional position was not chosen.  One instance when this could occur is when a user logs in and then logs back out without ever selecting a functional position.

All report types can be generated to cover daily, weekly, and activity occurring between a specified date/time range.  The date/time range is limited to up to 15 days in the past for the Workstation Position Log and User Position Log reports.  The Facility, User, and DUAT report types also allow a monthly time period to be requested.  Each of the above reports will be returned in a WordPad window that may be edited and saved as a file.
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Figure 3‑121  Local Activity Report Request  - Dialog Box 

Table 3‑83  Local Activity Report Request Dialog Box Description

	Label
	Component
	Purpose

	Report Type
	Drop-down List Box
	Lists the available report types:  Facility, User, DUAT, Workstation Position Log, and User Position Log.

	Time Period
	Drop-down List Box
	Select the desired time period for request:  Daily, Weekly, Monthly, and Date Range

	Report Start Time
	Text Boxes
	Enter the start time for the time span of data to be reported.

	Report Stop Time 
	Text Boxes
	Enter the stop time for the time span of data to be reported (mm/dd/yyyy hhmm). Available only when using Date Range from the Time Period drop-down list box. 

	User ID
	Text Box
	Narrows the report to a specified user.  Available only when Report Type is User.

	OK
	Button
	Generates the Local Activity Tally Report and displays the Local Activity File Save As dialog box.


NOTE:
The Monthly time period is only available for the Facility, User and DUAT report types.

To Display a Local Activity Report:

1. <Click> the Reports menu.

2. <Select> the Local Activity (TALLY) menu option to display the Local Activity Report Request dialog box.

3. <Select> the desired report type from the Report Type drop-down list box.

4. <Select> the desired time period to run the report from the Time Period drop-down list box.

5. Enter the Report Start Time and Report Stop Time in the appropriate text boxes as necessary, to determine the time frame of the report.

6. Enter a User ID when the User report type is requested.

7. <Click> the OK button.  The Local Activity File Save As dialog box is displayed.

8. <Select> the desired directory from the Save in drop-down list box and enter the filename in the File name text box.

9. <Click> the Save button.  The file is saved in the selected directory and the dialog box is closed.
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Figure 3‑122  Local Activity File Save As Dialog Box

Table 3‑84  Local Activity File Save As Dialog Box Description

	Label
	Component
	Purpose

	Save in
	Drop-down List Box
	Select the desired directory.

	File Listing
	Display Box
	Lists the folders and files under the specified directory.

	File name
	Text Box
	Enter the desired file name to be saved.

	Save as type
	Drop-down List Box
	Select the desired file type/extension.

	Save
	Button
	Saves the new file name in the selected directory.


THIS PAGE INTENTIONALLY LEFT BLANK
3.9 Status

The Status Menu allows the user to view or modify Functional or User Assignments, XE "Assignments" \r "D2HBAssignments167"  Facility Parameters, User Parameters, XE "User Parameters"  ARTCC Parameters, Interface Status List, Alerts List and the Event Log. XE "Event Log" \r "D2HBEvent_Log168" 
The Status Menu also utilizes Hummingbird Exceed software to provide access to the following two functions:

-
The System Monitor XE "System Monitor"  utilizes Open View software to monitor and analyze the operational status of the site.

-
The neX-REAP XE "neX-REAP"  menu option provides access to the Weather Graphics Server XE "Weather Graphics Server"  running neX-REAP software for the selection and configuration of downloadable weather products.
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Figure 3‑123  Status Menu

To Display the Status Menu:

1. <Click> the Status menu.

3.9.1 Assignments (Status Menu)

The Status Menu allows the user to view or modify functional and user assignments.
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Figure 3‑124  Assignments Menu Options

3.9.1.1  XE "Functional Assignment" \r "D2HBFunctional_A166" Functional Assignments (Status Menu/Assignments)

Functional Assignments are categorized by the type of work being performed.  The WINGS operational capabilities (window and menu options) are activated and deactivated based on the functional assignment granted to a user during login.  The user has access to only the system capabilities associated with that functional assignment for the duration of the login session.

Typically, the Supervisor is responsible for determining which users have access to what functional assignments and when.  The flexibility exists in the WINGS software to allow supervisory personnel varying degrees of control over user access and functional assignments.  At any one time, a user may be granted access to one or more functional assignments.  

Table 3‑85  WINGS Functional Positions XE "Functional Position" \r "D2HBFunctional_P167" 
	Functional Position
	Description

	Supervisor
	Used for monitoring other users.

	Administrator
	Used to control user access to the system and monitor other users.

	Maintenance
	Used for maintaining the system and checking the Event Log.

	Training
	Used for training.

	Remote
	Used for remote workstations.

	Other
	Used for miscellaneous purposes.

	Preflight
	Used for Preflight Specialists.

	Inflight
	Used for Inflight Specialists.

	EFAS
	Used for Flight Watch Specialists.

	SPECIALIST
	Used for other Specialist Positions.


NOTE:
Positions can be added and deleted by the Facility as needed.  The capabilities of the existing positions can be modified.
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Figure 3‑125  Functional Assignments Dialog Box

Table 3‑86  Functional Assignments Dialog Box Description

	Label
	Component
	Purpose

	Functional Assignments/ Capabilities
	Table
	Lists all available operational capabilities from top to bottom and all available functional positions from left to right.  A corresponding checkmark indicates that the capability is enabled for a functional position.  The absence of a checkmark indicates that a capability is disabled for the corresponding functional position.

	Checkmarks
	Visual Indicator
	Utilize the checkmarks to configure the capabilities of each Functional Assignment for the site.

	X mark
	Visual Indicator
	Indicates that a position is selected for deletion.

	Add Position
	Button
	Adds a new functional position.

	Delete Position
	Button
	Deletes a position after it has been selected with mouse.

	OK
	Button
	Accepts any changes to the Functional Assignments, configures the operational capabilities for that user accordingly and removes the Functional Assignments window.


To Display/Modify Functional Assignments:

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the Functional menu option to display the Functional Assignments window.

4. <Click> within the table boxes to enable or disable the various assignments to the users.

5. <Click> the OK button to accept the changes.  The Functional Assignments window is closed.

OR

6. <Click> the Cancel button to close the window without saving any changes.

NOTE:
The blue checkmarks indicate that permission is granted for the assigned positions.

NOTE:
Any changes made to a Functional Assignment will not affect users currently logged in to the system.  Changing a Functional Assignment only affects users logging in after the Functional Assignment is modified.

To Delete a Functional Position

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the Functional menu option to display the Functional Assignments window.

4. <Click> next to the name of the functional position to be deleted.  

5. <Click> the Delete Position button.  A Confirmation Message Box will appear.

6. <Click> the OK button to confirm that the functional position should be deleted.

To Add a Functional Position

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the Functional menu option to display the Functional Assignments dialog box.

4. <Click> the Add Position button.  A dialog box will appear asking for the name and capabilities of the new functional position.

5. <Type> the desired name of the position.

6. <Select> the initial set of capabilities for the position.

7. <Click> the OK button to create the position.
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Figure 3‑126  Add Functional Position Dialog Box

Table 3‑87  Add Functional Position Dialog Box Description

	Label
	Component
	Purpose

	Functional Position Name
	Text Box
	Enter the name of the functional position.  1 to 15 alphanumeric characters and spaces.

	Initial Capabilities
	Drop-down List Box
	Select the initial capabilities of the new position.  Available options are none, all, or the same capabilities as an existing position.

	OK
	Button
	Closes the dialog box and adds the new functional position.


3.9.1.2 User (Status Menu/Assignments)

The User Assignments dialog box displays the functional assignments that a user is approved to log in as and also the functional assignments that a user is currently assigned.  The User Assignments dialog box is sorted alphabetically by User ID.

A checkmark represents the user’s approved assignment(s) and a monitor represents a user’s currently held assignments(s) for the present login session.  A lock indicates that a user was locked out of the system because of a security violation (user attempted to login to the system unsuccessfully a site definable number of times).  A supervisor may unlock a user.  While a user is locked out, they may not login to the system.  Typically this dialog box is used by a supervisor or administrator position.
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Figure 3‑127  User Assignments Dialog Box

Table 3‑88  User Assignments Dialog Box Description

	Label
	Component
	Purpose

	User (login) Names
	List Entry
	Provides a List Entry for all the approved users at a site.

	User Assignments
	Table
	Lists all the available Functional Assignments.  A corresponding checkmark indicates that a user is approved for the Functional Assignment.  A corresponding monitor indicates that a user is currently assigned a Functional Position for the login session.  

	Checkmarks
	Visual Indicator
	Indicates the Functional Assignment(s) that a user is approved to perform.  

	Monitors
	Visual Indicator
	Indicates the Functional Assignment(s) that a user is currently assigned (for the current session).  A number next to a monitor indicates the number of times a user is logged into that position in the system.

	Lock
	Visual Indicator
	Indicates that the user has been locked out of the system because of a security violation.

	Key
	Visual Indicator
	Indicates that the user has been selected to be unlocked.   This indicator appears after clicking on the Lock Indicator.  

	Unlock User
	Button
	Unlocks a user after the user has been locked out because of security violations.

	Add User
	Button
	Adds a user.

	Delete User
	Button
	Deletes a user after user has been selected with a mouse.

	OK
	Button
	Accepts any changes to the User Assignments, configures the operational capabilities for that user accordingly for future login sessions and removes the User Assignment window.
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Figure 3‑128  User Assignments Window – Legend

To Display/Modify User Assignments:

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the User menu option to display the User Assignments window.

4. <Click> within the table boxes to enable or disable the various assignments to the users.

5. <Click> the OK button to accept the changes.  The User Assignments window is closed.

OR

6. <Click> the Cancel button to close the window without saving any changes.

NOTE:
Green checkmarks indicate which assignments are available to the user.  If multiple positions are assigned to a user, at login the user must select which position to use at that time.  A monitor graphic indicates which position is currently in use.

NOTE:
Any changes made to User Assignments will not affect users currently logged in to the system.  Changing User Assignments only affects future login sessions.

To Delete a User

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the User menu option to display the User Assignments window.

4. <Click> next to the ID of the User to be deleted.  

5. <Click> the Delete User button.  A Confirmation Message Box will appear.

6. <Click> the OK button to confirm that the User should be deleted.

To Add a User

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the User menu option to display the User Assignments dialog box.

4. <Click> the Add User button.  A dialog box will appear asking for the User ID.

5. <Type> the desired User ID and password. XE "Password" 
6. <Click> the OK button to create the new user.

NOTE:
The newly created user will not have any functional positions assigned to it.  Modify the table to add the functional positions that the new user should have.

To Unlock a Locked Out User

1. <Click> the Status menu.

2. <Select> the Assignments menu option to display the assignment menu options.

3. <Select> the User menu option to display the User Assignments dialog box.

4. Find the user that is locked out in the first column.  A Lock Indicator will appear next to the User ID.

5. <Click> on the Lock Indicator.  A Key Indicator will appear.

6. <Click> the Unlock User button.

3.9.2 Parameters  (Status Menu)

The Parameters menu option displays the available menu options, which provide the capability to set parameters for Facilities, Users, and ARTCCs.
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Figure 3‑129  Status Menu/Parameters Menu Options

3.9.2.1 Facility Parameters (Status Menu/Parameters)

The Facility Parameters menu option displays the Facility Parameters dialog box and provides the capability to view the parameter values that are unique to a specific facility.  Typically, the parameter values are set or modified by a user with supervisory capabilities.

By default, the Facility Parameters dialog box is sorted alphabetically by Ident.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑130  Facility Parameters Dialog Box

Table 3‑89  Facility Parameters Dialog  Box Description

	Label
	Component
	Purpose

	Facility Parameters
	Scroll List
	Displays a list of facility parameters and their value.

	Modify
	Button
	Brings up the selected item in the Facility Parameters Update dialog box.


To View the Facility Parameters:

1. <Click> the Status menu.

2. <Select> the Parameters menu option to display the available parameters.

3. <Select> the Facility menu option to display the Facility Parameters dialog box.
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Figure 3‑131  Facility Parameters Update Dialog Box

Table 3‑90  Facility Parameters Update Dialog Box Description

	Label
	Component
	Purpose

	Ident
	Edit Box
	Displays the identity of the facility parameter. 

	Value
	Edit Box
	Changes the value of the selected parameter.

	Units
	Edit Box
	Displays the Units value for the parameter.

	Maximum
	Edit Box
	Displays the maximum allowed value for the parameter.

	Minimum
	Edit Box
	Displays the minimum allowed value for the parameter.

	Default 
	Edit Box
	Displays the default value for the specified parameter.

	Step
	Edit Box
	Displays the increment value for the specified parameter.

	Description 
	Edit Box
	Displays the description of the specified parameter.


To Modify Facility Parameters:

1. <Select> the desired Facility Parameter to modify in the scroll list and <click> the Modify button.

OR

2. <Double-click> the desired Facility Parameter from the scroll list to display the Facility Parameter Update dialog box.

3. Enter or modify the information in the appropriate text boxes.

4. <Click> the OK button.  The modified Facility Parameters are saved.

OR

5. <Click> the Cancel button to close the dialog box without saving any modifications.

Table 3‑91  Description of Facility Parameters

	Parameter
	Description
	Min
	Max
	Step
	Default

	ATCR
	“Air Traffic Control Response Time” – The timeout interval in minutes that the FDS XE "Flight Data Server" \r "D2HBFDS179"  system will wait to receive an acknowledgment from an ARTCC before considering the acknowledgment overdue.
	1
	120
	1
	10

	CBRA
	“C-Band Radius” – A radius in nautical miles that defines the areas of coverage for C-Band Radar reporting sites.
	5
	500
	1
	75

	CNS_ADDR
	“CNS Address” – An 8-character string that represents the Consolidated NOTAM System’s NADIN address. 
	8
	8
	
	KDZZNAXX

	CNS_PRI
	“CNS Priority” – The valid priority for NADIN messages sent to CNS.  Valid entries are SS, DD, FF, or GG. 
	NA
	NA
	
	GG

	DAICCADD
	“DAICC Address” – An 8-character string that represents the NADIN address for the Domestic Air Interdiction Coordination Center.  Note: This address should also be in the FDS system’s “NADIN Address Table” in order to determine the correct NADIN II address. 
	8
	8
	
	KRIVYYYX

	DAICCLIM
	“DAICC Queue Limit” – The maximum number of hours worth of messages that can be backlogged for transmission to DAICC.  When a new message is queued for transmission to DAICC, the system will check to see if there are already more than DAICCLIM hours of messages backlogged.  If there are, the oldest messages will be deleted.
	1
	24
	1
	24

	DAICCLST
	“DAICC List Polling Frequency” – The time interval in seconds that the system will check for new messages awaiting transmission to DAICC.  The DAICCLST should be several seconds shorter than the DAICIDLE in order to avoid dropping the connection to DAICC and then immediately reestablishing it.
	1
	60
	1
	20

	DAICCPOL
	“DAICC Polling Frequency” – The number of minutes between attempts to connect to DAICC after it is detected that DAICC is down.
	1
	120
	1
	5

	DAICIDLE
	“DAICC Inactivity Timer” – The number of seconds that the system’s connection to DAICC can be idle before that connection will be dropped.  The DAICIDLE should be several seconds longer than the DAICCLST in order to avoid dropping the connection to DAICC and then immediately reestablishing it.
	10
	120
	1
	30

	DB56
	“56-Day Database” – The current version of the 56-day static database update.  This is a 3-digit number from 1 to 999.  After version 999 the database version will rollover to 001.
	0
	999
	1
	0

	DEFR
	“Default Message Response Time” – The default timeout interval in minutes that the FDS system will wait to receive an acknowledgment before considering the acknowledgment overdue.
	1
	120
	1
	10

	DRSH
	“Difference between Route Segment Headings” – Defines the maximum angle (in degrees) between sequential route segments that the FDS system can combine into a single route segment.  (Every airway crossing or ARTCC boundary provides a 5-digit numbered fix.  These fixes, which are not visible on a chart, create numerous short route segments that are actually a portion of a longer straight route.  This parameter allows the FDS system to determine which route segments can be combined into a single, longer route segment for processing.  Combining into a longer route segment provides for better performance.  It is recommended that this number be left at the default 1-degree value.)
	1
	5
	1
	1

	DTCDUAT
	“DTC DUAT facility” – This parameter should be set to 1 only if this site is a DTC DUAT site.  Otherwise it should be set to 0.
	0
	1
	1
	0

	DUATLOGS
	“DUAT Login Attempts” – The maximum number of login attempts permitted in a single DUAT transaction.  After this number of failed login attempts, the DUAT system will terminate the DUAT transaction.
	1
	10
	1
	3

	DUATVER
	“DUAT Version” – The current version of the DUAT client server program on the flight data server.
	1
	999
	1
	0

	DVFRR
	“DVFR Flight Plan Response Time” – The maximum number of minutes that the FDS system will wait to receive a response to a DVFR flight plan proposal message.  After this time elapses the flight plan response will be considered overdue.
	5
	120
	1
	20

	ETADELAY
	"ETA Delay" - The amount of time in minutes that the ETA is allowed to be in the past.  This allows the system to recognize current flight plans that are received or amended a few minutes late.  For example, if ETADELAY is set to 30 minutes and a flight plan is amended for an 1100Z ETA at 1120Z, the system will recognize that it was intended for 1100Z today.  If any flight plan proposals are received more than the ETADELAY minutes after the ETA time value, the system will assume that the ETA is for tomorrow.
	0
	120
	1
	60

	ETDDELAY
	“ETD Delay” – The amount of time in minutes that the ETD is allowed to be in the past.  This allows the system to recognize current flight plans that are received a few minutes late.  For example, if ETDDELAY is set to 30 minutes and a flight plan proposed for 1100Z ETD is received at 1120Z, the system will recognize that it was intended for 1100Z today.  If any flight plan proposals are received more than the ETDDELAY minutes after the ETD time value, the system will assume that the proposal is for tomorrow.  This parameter determines how far in the past the activation time of a flight plan can be when activating a proposed flight plan.  This parameter is also used to determine if the ETD is today or tomorrow for a weather briefing. 
	0
	120
	1
	30

	FAATIME
	“FAA DUAT Transaction Time Limit” – The time limit in minutes representing the maximum length of a DUAT transaction.
	5
	120
	1
	15

	FACLIMIT
	“MAX size of facility table” – The number of slots allocated in memory by the FDS system for NOTAM storage. 
	0
	40000
	1000
	10000

	FDSLOGS
	“FDS Login Attempts” – The maximum number of sequential failed login attempts permitted in WINGS before a user is locked out.  
	1
	10
	1
	3

	FDSVER
	“FDS Version” – The current version of the WINGS client server program on the flight data server.
	1
	999
	1
	0

	FPBAKTIM
	“FP Backup Buffer Time” - The time in hours that flight plan data is buffered if both FIRE processes are unavailable. 
	1
	12
	1
	4

	FSSM
	“Flight Service Station Minimum Transmit Time” – The minimum time interval in minutes prior to ETD that proposed DUAT flight plans can be accepted.  This value is only used for the DUAT subsystem and does not limit the specialist.
	5
	360
	1
	30

	FSSR
	“Flight Service Station Response Time” – The timeout interval in minutes that the FDS system will wait to receive an acknowledgment from an FSS before considering the acknowledgment overdue.
	5
	120
	1
	30

	FSST
	“Flight Service Station Transmit Time” – A time interval in minutes prior to ETD that proposed flight plan messages are transmitted to the FSS.
	0
	480
	1
	60

	FWAC
	“Forecast Winds Aloft Corridor” – A distance in nautical miles, FWAC divided by 2 from an airport, weather reporting location, latitude/longitude, or route of flight defines an area for Forecast Winds and Temperature Aloft report retrieval.  This value is only used for the DUAT subsystem.
	25
	1000
	5
	200

	INBOVERT
	“Inbound Overdue Timer” – The timeout interval in minutes after the ETA of an inbound flight plan before the flight plan is considered overdue.
	1
	240
	1
	30

	LWXR
	“Local Weather Radius” – The radius from an airport, weather reporting location, or latitude/longitude defining an area for weather and NOTAM product retrieval for a standard, outlook, or abbreviated area briefing request.  This value is only used for the DUAT subsystem.
	5
	500
	5
	25

	METARTM
	“Metar Transmit Time” – The number of minutes before the top of the hour that the hourly METAR reports will be transmitted.
	0
	59
	1
	10

	NADINGW
	“Gateway Address” – The primary NADIN I gateway to use.  The numeric values of this parameter correspond to records stored in the “NADIN Address Table” on the Flight Data Server, as described below:

1 = NDN_ATL1

2 = NDN_ATL2

3 = NDN_ATL3

4 = NDN_SLC1

5 = NDN_SLC2

6 = NDN_SLC3
	1
	6
	1
	1

	NTM_MAX
	“NOTAM Cleanup Maximum Requests” – The maximum number of WMSCR Request Replies that can be generated when processing a NOTAM cleanup request from WINGS.  Once the system reaches this number of requests, no more will be generated until another NOTAM Cleanup Request is issued.  Subsequent NOTAM cleanup requests should not be issued until the outstanding requests have completed, otherwise, duplicate requests will be issued.  This parameter defaults to 1 in order to limit the number of requests sent to WMSCR at one time.  It cannot be increased.  Note: The NOTAM cleanup process will determine which NOTAMs have not been received in the most recent NOTAM summary.  The most recent NOTAM summary is determined by the NTM_T1, NTM_T2, NTM_T3, and NTM_T4 parameters.
	1
	1
	1
	1

	NTM_T1
	“NOTAM Summary Time #1” – The time represented as HHMM (UTC) that the first NOTAM summary is scheduled for distribution for the day.
	0
	2359
	1
	20

	NTM_T2
	“NOTAM Summary Time #2” – The time represented as HHMM (UTC) that the second NOTAM summary is scheduled for distribution for the day.
	0
	2359
	1
	620

	NTM_T3
	“NOTAM Summary Time #3” – The time represented as HHMM (UTC) that the third NOTAM summary is scheduled for distribution for the day
	0
	2359
	1
	1220

	NTM_T4
	“NOTAM Summary Time #4” – The time represented as HHMM (UTC) that the fourth NOTAM summary is scheduled for distribution for the day.
	0
	2359
	1
	1820

	NUMNADIN
	“Number of NADIN Circuits” – The OASIS system is designed to operate with either one or two physical NADIN circuits.  This parameter indicates to the FDS software whether there are one or two physical circuits.  The behavior of the NADIN interface is slightly modified to not generate spurious alerts when there is only one physical NADIN circuit.  Additionally, if only one NADIN circuit is installed, the system will provide alerts to indicate when the manual A-B switch must be operated to move the NADIN circuit to a different Windows NT Server port.
	1
	2
	1
	1

	NUMWGS
	“Number of WGS” – The number of Weather Graphics Servers installed at the facility.
	1
	2
	1
	1

	PFPDI
	“Proposed Flight Plan Drop Interval” – The timeout interval in minutes that the FDS system will retain a Proposed Flight Plan that has not been activated after its ETD.  After this time interval elapses, the FDS system will automatically “drop” the flight plan proposal.
	0
	600
	1
	120

	PSPT
	“Prestored flight Plan Proposal Time” – The number of minutes prior to ETD in a prestored flight plan before the flight plan will appear on the proposed list.  This time should be long enough so that the proposals will appear on the P-list prior to any possible early departures.
	5
	480
	1
	30

	RWXC
	“Route Weather Corridor” – The width of the area searched for weather and NOTAM products for a route briefing request.  The corridor is defined as any point within half the RWXC distance from the route of flight.  This value is only used for the DUAT subsystem.
	10
	1000
	10
	50

	SBRA
	“S-Band Radius” – A radius in nautical miles that defines the areas of coverage for S-Band or Doppler Radar reporting sites.
	5
	500
	1
	200

	SPAREFSS
	“Sparing AFSS” – The eight character address of the facility that spares for this facility. 
	8
	8
	
	KXXXYFYX

	SUAD
	“Special Use Airspace Distance” – The distance in nautical miles from an airport, weather reporting location, latitude/longitude, or route of flight to a Special Use Airspace area resulting in activation and/or published information retrieval.  This value is only used for the DUAT subsystem. 
	0
	100
	1
	5

	SUADELAY
	“Special Use Airspace Message Delay” – The amount of time in minutes before the receipt time to allow for late Military Training Route XE "Military Training Route"  and Special Use Airspace activation messages.  If SUADELAY is 30 minutes and an MTR XE "Military Training Route"  message is received at 1130Z that indicates that it begins at 1100Z, the message will be accepted as 1100Z today.  If the message indicated that it begins at 1059Z, it is beyond the 30-minute parameter and will be assumed to begin at 1100Z tomorrow.
	0
	120
	1
	30

	SUAX
	“Special Use Airspace Extra Time” – The amount of time in minutes before ETD and after ETA to determine if an SUA activation message conflicts with the time of flight.  For example if ETD is 1200Z and ETA is 1300Z and SUAX is 30 minutes, than an SUA activation message that indicates that it  is active until 1131Z or an SUA activation message that becomes active at 1329Z will be retrieved as active during the time of flight.
	0
	720
	1
	60

	TFRMPUSH
	“TFR refresh time” – The time interval in minutes that the FDS system will push the TFR data to the Weather Graphics Server when no changes have occurred to the data.
	1
	60
	1
	15

	TWXR
	“Terminal Weather Radius” – A radius distance in nautical miles defining the terminal area for the departure, destination, and alternate airports used for retrieving Terminal Aviation products such as METAR, TAF, and NOTAM.
	5
	100
	1
	5

	VFRC
	“VFR Closure Time” – Amount of time in minutes to wait for a response to a VFR closure message before the response is considered overdue.
	5
	120
	1
	10

	WMOMETAR
	“WMO Header for METAR Reports” – The site WMO header used for transmission of hourly METAR products to WMSCR 
	NA
	NA
	
	SAUS27 KSIS

	WMOSPECI
	“WMO Header for SPECI Reports” – The site WMO header used for transmission of SPECI products to WMSCR. 
	NA
	NA
	
	SPUS27 KSIS

	WMOUA
	“WMO Header for UA Reports” – The site WMO header used for transmission of PIREP products to WMSCR. 
	NA
	NA
	
	UAUS10 KSIS

	WMOUUA
	“WMO Header for UUA Reports” – The site WMO header used for transmission of urgent PIREP products to WMSCR. 
	NA
	NA
	
	UAUS01 KSIS

	WXUMAXCL
	“Weather Update Maximum Clients” – The maximum number of WINGS client identification numbers that can be broadcast in an Auto Weather Update message. If more than this number of WINGS clients have requested a particular weather product to be auto-updated, the FDS system will broadcast the update to the entire site
	10
	100
	1
	100


3.9.2.2 User (Status Menu/Parameters)

User parameters are briefing, alarm, and list parameters that may be configured uniquely for each user.  Each user has the ability to display and modify their own user parameters according to their preference through the User Parameters XE "User Parameters"  dialog box.
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Figure 3‑132  User Parameters Dialog Box

Table 3‑92  User Parameters Dialog Box Description

	Label
	Component
	Purpose

	Alarm Configuration
	Group Label
	Selection of Audible Alarm.

	Activate Audible Alarm
	Check Box
	Select the "Activate Audible Alarm" check box to activate audible alarms.  If selected, an audible signal will be given when an alarm occurs for a list.  In order to receive audible alarms for a list, the visual alarms for that list must be enabled through the Functional Assignments XE "Assignments"  table.  This parameter does not affect the audible alarm generated by the Interface Status List.  See the Interface Status List (Status Menu) section for a description of the audible alarm for that list

	Contact Configuration
	Group Label
	Selection of Max Number of entries, Inflight, Flight Watch, or both.

	Max. Number of Entries
	Spin Box
	Indicate the maximum number of Contact entries to display (1-40). Default is 40.

	Inflight
	Radio Button
	Select this option to display only Inflight Contacts on the Contact List.

	Flight Watch
	Radio Button
	Select this option to display only Flight Watch Contacts on the Contact List.

	Both
	Radio Button
	Select this option to display Inflight and Flight Watch Contacts on the Contact List.  This is the default option.

	Briefing Configuration
	Group Label
	Select corridor, radius, and time interval attributes for briefing.

	Route Corridor
	Spin Box
	The Route Corridor width for a Weather Briefing.  10 - 100 nautical miles.  Default is 50.   This value will be used by default for all briefings, but can be modified for any specific briefing by changing the value in the briefing request dialog box. 

	Area Radius
	Spin Box
	The Area Radius for a Weather Briefing.  10 – 300 nautical miles. Default is 50.  This value will be used by default for all briefings, but can be modified for any specific briefing by changing the value in the briefing request dialog box.

	Winds Aloft Corridor
	Spin Box
	The Winds Aloft Corridor for the altitude range of the flight corridor for a Weather Briefing.  100 – 600 nautical miles.  Default is 200.  This value will be used by default for all briefings, but can be modified for any specific briefing by changing the value in the briefing request dialog box.

	SPECI Time Interval
	Spin Box
	The time period SPECI reports are retrieved on Trend Weather Briefings.  60 – 180 minutes.  Default is 180.  This value will be used by default for all briefings, but can be modified for any specific briefing by changing the value in the briefing request dialog box.

	SUA Radius
	Spin Box
	The Special Use Airspace (SUA) Radius for a Weather Briefing.  5 – 50 nautical miles.  Default is 10.  This value will be used by default for all briefings, but can be modified for any specific briefing by changing the value in the briefing request dialog box.

	OK
	Button
	Accepts and activates the new User Parameter settings.


To Display/Modify User Parameters:

1. <Click> the Status Menu.

2. <Select> the Parameters menu option to display the Parameters menu options.

3. <Select> the User menu option to display the User Parameters dialog box populated with the current user defined parameters.

4. Enter or modify the required information within the appropriate text boxes.

5. <Click> the appropriate check box to enable or disable any desired values.

6. <Click> the OK button.  The modified User Parameters are saved to the local database.

OR

7. <Click> the Cancel button to close the dialog box without saving any changes.

NOTE: 
If the Contact Configuration is changed and the Contact List is open, the list will be updated to reflect the new contact configuration.

NOTE:
Use the Tab key or Shift + Tab simultaneously to navigate forward and backward through the fields and text boxes.  Utilize fly-over help if the content or format of a field or text box is not understood.  Fly-over help is also available for some function buttons.

3.9.2.3 ARTCC Parameters (Status Menu/Parameters)

The ARTCC parameter menu option displays the ARTCC Parameters dialog box and provides the capability to view the parameters that are unique to a specified ARTCC.  Typically, these parameters are set or modified by a user with supervisory capabilities.  Only the Xmit Time field may be modified.

By default, the ARTCC Parameters dialog box is sorted alphabetically by ID.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑133  ARTCC Parameters Dialog Box

Table 3‑93  ARTCC Parameters Dialog Box Description

	Label
	Component
	Purpose

	ARTCC Sites
	Scroll List
	Displays list of ARTCC sites.

	Modify
	Button
	Displays the ARTCC Parameters Update dialog box.


To Modify ARTCC Parameters:

1. <Click> the Status menu.

2. <Select> the Parameters menu option to display the available parameters.

3. <Select> the ARTCC menu option to display the ARTCC Parameters dialog box.

4. <Select> the desired ARTCC to modify in the scroll list and <Click> the Modify button.

OR

5. <Double-Click> the desired ARTCC from the scroll list to display the ARTCC Parameters Update dialog box.

6. Modify the Xmit Time and <Click> the OK button.  The modified ARTCC Parameters are saved. 

OR

7. <Click> the Cancel button to return to the ARTCC Parameters dialog box.
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Figure 3‑134  ARTCC Parameters Update Dialog Box

Table 3‑94  ARTCC Parameters Update Dialog Box Description

	Label
	Component
	Purpose 

	ID
	Text Box
	Identification of the site (3 – 4 alphanumeric characters). 

	Computer ID
	Text Box
	Identification of the computer.  

	Name
	Text Box
	City name. 

	Addresses
	Group Label
	Text boxes for machine adresses.

	Auto
	Text Box
	Automatic machine address. 

	Manual
	Text Box
	Manual machine address. 

	Response
	Text Box
	Response machine address. 

	X25
	Text Box
	X25 machine address. 

	Phones
	Group Label
	Text boxes for phone number entries.

	1
	Text Box
	Phone number at the facility. 

	2
	Text Box
	Phone number at the facility. 

	Xmit Time
	Text Box
	Number of minutes prior to the ETD of a Proposed IFR flight plan to transmit the IFR flight plan to the ARTCC (0 – 480 minutes). 

	OK
	Button
	Close the dialog and accept changes made. 


3.9.3 Facility Responsibility (Status Menu)

Sparing allows a local site to receive or send Lists from/to another OASIS facility.  The Facility Responsibility Status menu option displays the Facility Responsibility Table and provides the capability to view the parameters for the spared facilities.  Entries can be Added, Edited, or Deleted from the table by a user with supervisory capabilities.  For detailed procedures, refer to the System Operations Manual (SOM). 

By default, the Facility Responsibility Table is sorted alphabetically by Ident.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.  The local site is always listed first, regardless of how the rest of the table is sorted.

The Facility Responsibility Table also allows the Responsible FSS Filter to be changed.  The filter can be set to ALL, or to any facilities listed in the Facility Responsibility Table, by checking the box beside the Ident.

NOTE:
If an Incoming Service B message is addressed to a facility that has not been listed as an "Active" sparing state, (i.e., Local Site is not currently sparing for the facility), the Service B message will appear on the receiving AFSS XE "AFSS"  Facility Message XE "Facility Message:General"  List with the description "Not addressed to this facility".
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Figure 3‑135  Facility Responsibility Table

Table 3‑95  Facility Responsibility Table Description 

	Label
	Component
	Purpose

	Responsible FSS Filter
	Group Label
	Groups the controls used to set the Responsible FSS Filter.  Either Display All Entries or at least one facility must be checked to save the Responsible FSS Filter.

	Display All Entries
	Check Box
	Sets the Responsible FSS Filter to ALL.  When checked, the individual facilities are all checked, and cannot be changed until this box is unchecked.  Additionally, the Select All and Clear All buttons will be disabled.

	
	Check Box
	When checked, the facility is included in the Responsible FSS Filter.  At least one facility must be included in the Responsible FSS Filter if Display All Entries is not selected.

	Ident 
	Column
	Facility Identification. 

	Address 
	Column
	Address of the site. 

	Sparing State 
	Column
	Sparing state of the site.

	Facility Type 
	Column
	The facility type.

	Remarks 
	Column
	Remarks of the site.

	Select All
	Button
	Checks all entries in the scroll list.  This button is disabled if Display All Entries is checked.

	Clear All
	Button
	Unchecks all entries in the scroll list.  This button is disabled if Display All Entries is checked.

	Edit Entry
	Button
	Edit the selected site.

	Add Entry
	Button
	Add a new site.

	Delete Entry
	Button
	Deletes the selected site.

	OK
	Button
	Closes the window and saves any changes to the Responsible FSS Filter.  If Display All Entries is not selected, at least one facility must be checked.


NOTE:
If the Responsible FSS Filter was changed and either the Inbound List, Proposed List, Suspense List, Facility Message List, or SAR List is open, the open list(s) will be updated to reflect the new filter.  Any entries on these lists that were alarming (highlighted in blue) will no longer be alarming.  If the alarm bar indicator for any of these lists was activated (colored red), it will be reset.  Changes to the Responsible FSS Filter apply only to the current user session.  

3.9.4 Interface Status List (Status Menu)

The Interface Status List menu option provides the capability to monitor the OASIS interfaces to various external systems and internal subsystems.  The Interface Status List displays the status of the OASIS external interfaces to CNS, DAICC, NADIN, XE "NADIN"  and WMSCR. XE "WMSCR" \r "D2HBWMSCR186"   It also monitors the condition of numerous internal pieces of the system, including the DUAT XE "DUAT"  subsystem, NT Server 1 (NT1),  NT Server 2 (NT2), the FIRE processes on NT-1 and NT-2, and any component failures reported by OpenView.

Each entry within the list has an icon associated with it.  The coloration of the icons defines the level of concern for each entry.  The level of concern is based on the current status of the interface. 

The title bar of the Interface Status List  turns the color of the entry within the list which holds the highest level of concern.

Table 3‑96  Interface Status List Icon Definitions

	Color
	Component
	Purpose

	Green
	Icon
	Interface is functioning normally. (OK state)

	Yellow
	Icon
	Interface is functioning in a degraded state. (Warning state)

	Red 
	Icon
	Interface is severely degraded or non-functional. (Critical state)


An alarm will be generated whenever an entry on the Interface Status List becomes non-functional (red icon).  If any entry on the Interface Status List is alarming, an audible signal will be heard and will repeat at a fixed interval.  This audible alarm will stop when all alarming entries on the list have been acknowledged or have returned to a non-alarming state.  The audible alarm for the Interface Status List is enabled for any user who has the functional capability to receive alarms on the list.   It is not controlled by the Activate Audible Alarm setting in the User Parameters window, which enables or disables the audible alarm for all other lists.  All alarming entries must be acknowledged before the Interface Status List can be closed.  See the Main Window/Alarm Bar section for more information on list alarms.  

By default, the Interface Status List is sorted alphabetically by Interface Name.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.  
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Figure 3‑136  Interface Status List Dialog Box

Table 3‑97  Interface Status List Dialog Box Description

	Label
	Component
	Purpose

	Interface Status List
	Scroll list
	Displays a summary list entry and icon for each interface on the Interface Status List.

	Interface Name
	Column
	Name of the internal or external interface being monitored.

	Time
	Column
	Time the data in the Information column was last updated.

	Information
	Column
	Current status of the interface.

	Edit Box
	Text Box
	Provides more detailed information on the selected interface.


To Display the Status of the OASIS Interfaces:

1. <Click> the Status menu.

2. <Select> the Interface Status List menu option to display the Interface Status List dialog box.

3. <Select> the desired interface from the scroll list. 

3.9.5 Alerts (Status Menu)

The Alerts menu option displays the Alerts List that allows users to view, expand, and delete Informational, ATCSCC and Operational Concern Alerts.  An Informational Alert is given to inform the user of a situation that requires no action on the part of the user.  An Operational Concern Alert informs the user of a situation that could affect the operation of the facility and may require user action, e.g. a critical error processing WMSCR data.  An ATCSCC Alert informs the user of an ATCSCC message that was just received into the system.  Each type of alert has a unique icon associated with it.  The types of alerts that a specialist sees on the Alerts List can be configured through the Functional Assignments XE "Assignments" 

 XE "Functional Assignment"  menu option.

An alarm will be generated whenever a new ATCSCC, Operational Concern, or Informational Alert is added to the Alerts List.  See the Main Window/Alarm Bar section for more information on list alarms.

By default, the Alerts List is sorted by Time from most recent to oldest.  Click on any column header to re-sort the list by that column.  Click the column header again to toggle the sort order between ascending and descending.
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Figure 3‑137  Alerts List Dialog Box

NOTE:
The Alerts List data will display only the first 260 characters of the Message Text.  If there are more than 260 characters, 256 characters followed by a "..." will appear.  The item should be expanded to see the remaining text. 

NOTE: 
The carriage return linefeed sequences are denoted by a “¶” on the list.

Table 3‑98  Alerts List Dialog Box Description 

	Label
	Component
	Purpose

	Alert List
	Scroll list
	Displays a summary list entry and icon for each Alert Message on the Alerts List.

	Type
	Column
	Category of the alert – ATCSCC, Operational Concern, or Informational.

	Time
	Column
	Time the alert was generated.

	Message Text
	Column
	Text of the alert.

	Edit Box
	Text Box
	Provides more detailed information on the selected Alert Message.

	Legend
	Legend Display
	Defines the legend symbols. 

	Delete Entry
	Button
	Deletes the selected Alert Message. 

	Delete All
	Button
	Deletes all entries from the Alerts List.


To Display an Alert Message List Entry:

1. <Click> the Status menu.

2. <Select> the Alerts menu option to display the Alerts List dialog box for viewing Alert Messages.

3. <Select> the desired Alert Message from the scroll list.  

4. <Click> the Close button to close the dialog box.

To Delete an Alert Message List Entry:

1. <Click> the Status menu.

2. <Select> the Alerts menu option to display the Alerts List dialog box for viewing Alert Messages.

3. <Select> the desired Alert Message from the scroll list.  The selected Alert Message is highlighted.

4. <Click> the Delete Entry button to remove the Alert Message from the Alert List.

OR

5. <Click> the Delete All button to remove all of the alert messages from the Alert List dialog box.

OR

6. <Click> the Close button to close the dialog box.  All of the current entries will not be displayed next time the Alerts list is opened.

3.9.6  XE "System Monitor" System Monitor (Status Menu)

NOTE:
The System Monitor menu option is used to actively monitor the operational status of the system within a facility.  The System Monitor menu option opens the System Monitor Window, which provides an X-Terminal emulator (Hummingbird Exceed) that is used to display the HP Open View software.  For specific instruction on running HP Open View, refer to the OASIS System Operations Manual.
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Figure 3‑138  System Monitor Window

To Display the X-Terminal Emulator (Exceed Window):

1. <Click> the Status menu.

2. <Select> the System Monitor menu option to display the X-Terminal emulator (Exceed Window) for running the HP Open View application.  HP Open View enables the user to actively monitor the operational status of the local system (site).

3. <Select> Close within the Exceed window to return to the WINGS application.

3.9.7  XE "Event Log" Event Log (Status Menu)

The Event Log menu option provides the capability to view historical data on System, Security, or Application events.  The Event Log menu option opens the Event Viewer window, which is typically used for software maintenance by a user with maintenance capabilities. 

NOTE:
The follow message will appear to the user when the Wings application has logged an event in the event log - “The Wings application has logged an event in the event log.  Please have the System Administrator check the event log for this workstation.”
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Figure 3‑139  Event Viewer Window

To View the Event Log:

1. <Click> the Status menu.

2. <Select> the Event Log menu option to display the Event Viewer window.

3. <Select> the log to display.

4. Utilize the menus within the Event Viewer window to change the appearance of the Event Log entries if necessary.

5. <Click> the Exit menu option from the File menu to close the Event Viewer window.

NOTE:
The Event Log is typically used for software maintenance by a user with maintenance capabilities.

3.9.8  XE "neX-REAP" neX-REAP (Status Menu)

NOTE:
The neX-REAP application provides computer-based weather information processing and display.  The primary purpose of neX-REAP is to improve the timeliness and quality of weather information by collecting and processing weather data.  The neX-REAP application output includes graphic and text weather assessments and forecasts.  

The major operational functions of neX-REAP are:

-
Weather Assessment

-
Warning and Advisory Product Preparation and Distribution

-
Meteorologist Briefing XE "Briefing" 
-
Product/Procedure Archival

To Access the neX-REAP Software:

1. <Click> the Status menu.

2. <Select> the neX-REAP menu option to load the software.
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Figure 3‑140  neX-REAP Application

3.10 
View

The View menu is available after a successful login and selection of a functional position. XE "Functional Position"   The View menu consists of the Toolbar XE "Toolbar"  and Status Bar XE "Status Bar" \r "D2HBStatus_Bar200"  menu options.
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Figure 3‑141  View Menu

To Display the View Menu:

1. <Click> the View menu.

3.10.1 Toolbar (View Menu)

The Toolbar menu option provides the capability to display or hide the toolbar.  The toolbar is a panel that contains a set of buttons designed to provide quick and easy access to specific menu options.

To Display the Toolbar:

1. <Click> the View menu.

2. <Select> the Toolbar menu option until the check mark to the left of the Toolbar menu item is displayed indicating the on state.

NOTE:
The default value of the Toolbar option is “On” (as indicated by the presence of the check mark to the left of the Toolbar menu option).

To Hide the Toolbar:

1. <Click> the View menu.

2. <Select> the Toolbar menu option until the check mark to the left of the Toolbar menu item is not displayed indicating the off state.  The Toolbar is removed from the display.

3.10.2 Status Bar (View Menu) 

The Status Bar is a special area at the bottom of the Main Window that displays information about the current state of the WINGS application.

To Display the Status Bar:

1. <Click> the View menu.

2. <Select> the Status menu option until the check mark to the left of the Status Bar menu item is displayed.  The Status Bar is displayed.

NOTE:
The default value of the Status Bar option is set to “On” (as indicated by the check mark to the left of the Status Bar menu option). 

To Hide the Status Bar:

1. <Click> the View menu.

2. <Select> the Status menu option until the check mark to the left of the Status Bar menu item is not displayed.  The Status Bar is removed from the display.

3.11 
Window

The Window menu provides the capability to adjust the method in which open windows are displayed.  As more windows are opened and resized, the windows can overlap and eventually obscure or hide another one.  The window options provide various methods of arranging windows so that they are at least partially visible.  The Window menu includes the following options: Cascade, XE "Cascade" \r "D2HBCascade196"  Tile, XE "Tile" \r "D2HBTile202"  Arrange Icons, XE "Arrange Icons"  and a Numbered Window List (a list of any open windows).
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Figure 3‑142  Window Menu

To Display the Window Menu:

1. <Click> the Window menu.

3.11.1 Cascade

The Cascade menu option arranges any currently open windows in overlapping style, like offset index cards.  The Cascade option displays open windows from the upper, left corner of the display screen to the lower, right corner of the display screen.  Each window overlays one another with just the title bar and left edge of the window showing.
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Figure 3‑143  Cascade Option of the Window Menu

To Display the Open Windows in Cascade Arrangement:

1. Open and arrange any combination of two or more current products.

2. <Click> the Window menu.

3. <Select> the Cascade menu option.  The current open windows are displayed in a cascading arrangement.

3.11.2 Tile

The Tile menu option arranges any open windows in a tiled style, with each window displayed in its own space.
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Figure 3‑144 Tile Option of the Window Menu

To Display the Open Windows in Tile Arrangement:

1. Open and arrange any combination of two or more current windows or dialog boxes.

2. <Click> the Window menu.

3. <Select> the Tile menu option.  The current open windows and/or dialog boxes are displayed in tile arrangement.

3.11.3  XE "Arrange Icons" \r "D2HBArrange_Icon198" Arrange Icons

The Arrange Icons menu option arranges icons in a tiled style across the application main window.

To Display the Icons in an Arrangement:

1. Open any combination of two or more windows.

2. <Click> the Minimize button on each window that is to be displayed as a window icon.

3. Move the icons around on the Client Area

4. <Click> the Window menu.

5. <Select> the Arrange Icons menu option.  The icons are displayed in a tile arrangement.

NOTE:
The Icons command is not applicable for maximized or adjusted windows.  Use the Cascade XE "Cascade"  or Tile XE "Tile"  command to arrange these windows.

3.11.4 Numbered Window List

The Numbered Window List is located below the Window menu option.  All the opened product windows are listed.  This list is often used to bring a hidden window to the front.  Selecting the name of a window brings it to the front.
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Figure 3‑145 Numbered Window List

To Display the Numbered Window List:

1. Open and arrange any combination of two or more products.

2. <Click> the Window menu.

3. <Select> a product from the Numbered Window List.  The selected window is brought to the front of the display and the border is highlighted to show that it is the active window.  Also, the selected list item is indicated by a check mark to the left of the menu item.

THIS PAGE INTENTIONALLY LEFT BLANK
3.12 
Help

The Help menu provides Help information about the WINGS application.  The Help menu includes the following options: Help Topics, XE "Help Topics" \r "D2HBHelp_Topics205"   Decode LOCIDs, XE "LOCID" \r "D2HBLOCID199"  Decode Abbreviations, Encode LOCID, and About WINGS. XE "About WINGS" 
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Figure 3‑146  Help Menu

To Display the Help Menu:

1. <Click> the Help  menu.

3.12.1 Help Topics (Help Menu) 

The Help Topics menu option provides an outline of covered topics and quick access to each topic using the Contents, Index and Find options.  Refer to the Help Topics Appendix for detailed information on the help features.

3.12.2 Decode LOCIDs (Help Menu)

The Decode LOCIDs option provides expanded LOCID information such as location and latitude or longitude.
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Figure 3‑147  Decode LOCIDs Request Dialog Box

Table 3‑99  Decode LOCIDs Request Dialog Box Description 

	Label
	Component
	Purpose

	LOCIDs to Decode
	Text Box
	Enter up to ten LOCIDs to decode separated by a space. Each LOCID can be 1 to 5 characters.  A ? may be used in either the second or third position for a wildcard character.

	Decode
	Button
	Displays the Decode LOCIDs Response dialog box, giving detailed information on the LOCID.  


To Decode a LOCID:

1. <Click> the Help menu.

2. <Select> the Decode LOCIDs menu option to display the Decode LOCIDs Request dialog box.

3. Enter one to ten LOCIDs in the LOCIDs to Decode text box.

4. Click the Decode button.  The Decode LOCIDs Response dialog box is displayed providing detailed information about the specified LOCIDs.
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Figure 3‑148  Decode LOCIDs Response Dialog Box

Table 3‑3‑100  Decode LOCIDs Response Dialog Box Description

	Label
	Component
	Purpose

	LOCID
	List Box
	Domestic and ICAO LOCID.

	Facility Type
	Text Box
	Type of facility.

	Bounding ARTCC
	Text Box
	Bounding ARTCC for the facility. 

	Controlling ARTCC
	Text Box
	Controlling ARTCC of the facility.

	Airport Use
	Text Box
	Airport use of the facility: Public, Private or blank if no data is available.

	NOTAM Responsibility
	Text Box
	Site that is responsible for sending NOTAMs for this facility.

	Tie-In FSS
	Text Box
	Flight Service Station that is responsible for this facility.

	Tie-In Baseops
	Text Box
	Military base that is responsible for this facility.

	Customs Availability
	Text Box
	The Customs Availability of the facility: Port of Entry, Landing Rights or blank if no data is available.

	Facility Name
	Text Box
	Name of the facility.

	City
	Text Box
	City in which the facility resides.

	State
	Text Box
	State in which the facility resides.

	Latitude
	Text Box
	Latitude of the facility.

	Longitude
	Text Box
	Longitude of the facility.

	Magnetic Variation
	Text Box
	Magnetic variation of the facility in degrees.

	Elevation
	Text Box
	Elevation of the facility in feet above sea level.

	Channel
	Text Box
	Channel in MHz of the NAVAID facility.

	Frequency
	Text Box
	Frequency in kHz of the NAVAID facility.

	WX Reports
	Text Box
	WX Reports that are reported from the facility.

	Decode
	Button
	Displays the Decode LOCIDs Request dialog box.


3.12.3 Decode Abbreviations (Help Menu)

The Decode Abbreviations menu option displays the Decode Abbreviations Request dialog box which provides the capability to lookup a specified acronym or abbreviation.
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Figure 3‑149  Decode Abbreviations Request Dialog Box

Table 3‑101  Decode Abbreviations Request Dialog Box Description 

	Label
	Component
	Purpose

	Abbreviations to Decode
	Text Box
	Enter up to seven abbreviations separated by a space (1 to 7 characters).

	Decode
	Button
	Displays the Decode Abbreviations Response dialog box defining the abbreviations and specifying which type it is.


To Decode an Abbreviation:

1. <Click> the Help menu.

2. <Select> the Decode Abbreviations menu option.  The Decode Abbreviations Request dialog box is displayed.

3. Enter one to seven Abbreviations in the Abbreviations to Decode text box.

4. Click the Decode button.  The Decode Abbreviations Response dialog box is displayed defining the abbreviation and abbreviation type.

5. <Click> the Decode button to return to the Decode Abbreviations Request dialog box.
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Figure 3‑150  Decode Abbreviations Response Dialog Box

3.12.4 Decode SUAs (Help Menu)

The Decode SUAs menu option displays the Decode SUAs Request dialog box, which provides the capability to retrieve both published and unpublished information on military training routes and special use airspace.
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Figure 3‑151  Decode SUAs Request Dialog Box

Table 3‑102  Decode SUAs Request Dialog Box Description

	Label
	Component
	Purpose

	SUAs to Decode
	Text Box
	Enter any combination of IRs, VRs, and MOAs (including restricted areas, prohibited areas, alert areas, and warning areas), separated by spaces.  Enter no more than 100 characters.  Enter “IR” or “VR” before each IR or VR identifier.  Enter “MOA” after each MOA name.  The “MOA” is not necessary if entering only a single MOA name.

	Decode
	Button
	Displays the Decode SUAs Response dialog box with published and unpublished information on each SUA.


To Decode an SUA:

1.
<Click> the Help menu.

2.
<Select> the Decode SUAs menu option.  The Decode SUAs Request dialog box is displayed.

3.
Enter one or more IRs, VRs, or MOAs in the SUAs to Decode text box.

4.
Click the Decode button.  The Decode SUAs Response dialog box is displayed with published and unpublished information on each SUA.

5.
<Click> the Decode button to return to the Decode SUAs Request dialog box.
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Figure 3‑152  Decode SUAs Response Dialog Box

Table 3‑103  Decode SUAs Response Dialog Box Description

	Label
	Component
	Purpose

	SUA
	Scroll List
	Displays a list of the decoded SUAs.

	Unpublished/Published SUA Data
	Text Box
	Displays the published and unpublished information for the SUA currently selected in the SUA scroll list.

	Decode
	Button
	Displays the Decode SUAs Request dialog box.


3.12.5 Encode LOCID (Help Menu)

The Encode LOCID option provides the ability to find a location identifier corresponding to the name of a place.  The user can specify values for location name alone, or for location name and state.
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Figure 3‑153  Encode LOCID Request Dialog Box

NOTE:
Partial spelling of the location name will yield results.

Table 3‑104  Encode LOCID Request Dialog Box Description 

	Label
	Component
	Purpose

	Location Name
	Text Box
	Enter location name to encode (1 to 42 characters).

	State
	Text Box
	Enter location’s state (2 alphabetic characters).

	Encode 
	Button
	Click to process the encoding request.


To Encode a LOCID:

1. <Click> the Help menu.

2. <Select> the Encode LOCID menu option to display the Encode LOCID Request dialog box.

3. Enter the LOCID in the Location Name text box.

4. Enter the state where the LOCID is located in the State text box.

5. <Click> the Encode button.  The Encode LOCID Response dialog box is displayed providing detailed information about the specified LOCID as well as the capability to decode.

[image: image186.png]2% Encode LOCID Response

Locin

AipottNeme - [VELBOLRNE INTERNATIONAL/VOR

Ciy [MELBOURNE State [FL
L wiloe WX

Decode Ecode | Cose | Hep |





Figure 3‑154  Encode LOCID Response Dialog Box

3.12.6  XE "About WINGS" About WINGS (Help Menu)

The About WINGS menu option displays the current WINGS application version.

To Display the About WINGS Menu:

1. <Click> the Help menu.

2. <Select> the About WINGS menu option to display the About WINGS dialog box.

3.13  Network Safety Features

During operations, WINGS relies upon network communications to function properly.  In the event of a network communication failure, WINGS has two safety features to protect the system’s integrity.  The first feature, the "Reattach" feature, detects the problem and attempts to reestablish the lost connection.  If the connection could not be reestablished, the second feature allows the user to safely recover their work from WINGS.  This second feature is called the “Offline” feature.  These two features in WINGS provide a means to recover from the network communication failure.

3.13.1 Reattach Feature

The Reattach Message Box alerts the user about a network communication failure.
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Figure 3‑155  Reattach Message Box

The user should press the <Retry> button to reestablish communications.  If the reattach is successful, all open list windows should be closed and re-opened to ensure that the data they contain is up to date.
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Figure 3‑156  Successful Reattach Message Box 

Sometimes WINGS fails to reestablish communications during a reattach attempt.  The user can retry by pressing the <Retry> button or cancel the attempt by pressing the <Cancel> button.
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Figure 3‑157  Failed Attempt Message Box 

Under extreme conditions where WINGS can not reestablish network communications, it will display the following message box.  This box is displayed to alert the user that the problem with the network communications has not allowed WINGS to reestablish the connection with the Flight Data server.  When the reattach is unsuccessful or the user cancels the attempt, WINGS will operate under the OFFLINE state.
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Figure 3‑158  Unsuccessful Reattach Message Box 

3.13.2 Offline Feature

When WINGS enters the OFFLINE state, a message box tells the user that it is no longer connected to the FDS. XE "Flight Data Server" \r "D2HBFDS210"  Since WINGS is not connected and network communications are unavailable; no messages or data requests can be sent to the Flight Data Server. XE "Flight Data Server"   The WINGS Window remains active at this point.
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Figure 3‑159  Offline Message Box 

The status bar also shows the user ID with “(OFFLINE)” next to it so that it is obvious that a network communication failure has occurred and that no communications between WINGS and the Flight Data Server are available at the present time.
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Figure 3‑160  Offline Indicator 

Since WINGS has no communications with the FDS, the user should not attempt to open any windows that are not already open.  The user also should not attempt to enter or transmit any more data.  If the user tries to do so, the following message box appears.
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Figure 3‑161  Unable-to-Send Message Box 

The "OFFLINE" state is intended to serve as a temporary way of salvaging WINGS information that was being entered at the time of the network communication failure. Upon transferring of WINGS information to some other medium it is advisable to log off of WINGS until network communications are restored.

THIS PAGE INTENTIONALLY LEFT BLANK
3-26  SYMBOL 183 \f "Symbol"  Weather Information and Navigational Graphics System (WINGS)
WINGS System Users Guide
WINGS System Users Guide
Weather Information and Navigational Graphics System (WINGS)  SYMBOL 183 \f "Symbol"  3-15

